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Copyright Notice 
©Delta Electronics, Inc. All rights reserved. 

All information contained in this user manual is the exclusive property of Delta 

Electronics Inc. (hereinafter referred to as "Delta") and is protected by copyright law 

and all other laws. Delta retains the exclusive rights of this user manual in 

accordance with the copyright law and all other laws. No parts in this manual may be 

reproduced, transmitted, transcribed, translated or used in any other ways without 

the prior consent of Delta. 

 

Limitation of Liability 

The contents of this user manual are only for the use of the DIAStudio manufactured 

by Delta. Except as defined in special mandatory laws, Delta provides this user 

manual “as is” and does not offer any kind of warranty through this user manual for 

using the product, either express or implied, including but not limited to the following: 

(i) this product will meet your needs or expectations; 

(ii) the information contained in the product is current and correct;  

(iii) the product does not infringe any rights of any other person. Use the product at 

your own risk. 

In no event shall Delta, its subsidiaries, affiliates, managers, employees, agents, 

partners and licensors be liable for any direct, indirect, incidental, special, derivative 

or consequential damages (including but not limited to the damages for loss of 

profits, goodwill, use or other intangible losses) unless the laws contain special 

mandatory provisions to the contrary. 

Delta reserves the right to make changes to the user manual and the products 

described in the user manual without prior notice and afterwards.
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DIAScreen Overview 
The DIAScreen application is an intuitive visualization software, which can configure 

the Delta DOP series, TP series, and AX series controller soft-HMIs. 
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DIAScreen Features 

DIAScreen has the following features: 

• Tag sharing with the variables of DIADesigner and DIADesigner-AX 

• Convenient User Interface, and rich 3D image library 

• Smoother display for Meter and other elements 

• Enhanced software download speed 

• Clear output results 

• Various control elements and functions, such as Recipe and Macros 

• Support multi-language, such as English, Traditional Chinese and Simplified 

Chinese 

• Provide passwords and permission levels to enhanced security. 

 

Supported Devices 

DIAScreen version 1.6.0 supports the following devices. 

Type Product Series 

Controller soft-HMI AX series 

Touch type high color HMI  DOP-100 series 

IoT type high color HMI DOP-300 series 

Handheld high color HMI DOP-H Series (Handheld) 

Motion Controller DXMC series 

Motion Control development platform IMP series 

Text Panel (TP) HMI TP series 

Note: 

• Support AX / IMP series soft-HMI planning functions. Refer to AX series 

products manual and IMP manual for detail. 
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• Support DOP-100, DOP-300 and DOP-H series soft-HMI planning functions. 

Refer to HMI product manual for detail. 

• Support DXMC series HMI planning functions. Refer to DXMC-P product 

manual. 

• Supports TP series HMI planning functions. Refer to TP series operation 

manual. 

• To avoid network attacks, the HMI must be connected and run within a firewall to 

slave devices or upper systems. 

• If the environmental equipment uses flow control, it will affect the human-

machine operating performance. 
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Installation 
This section introduces how to download, install and uninstall DIAScreen in 

DIAInstaller. 
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System Requirements 

To install and run DIAScreen, your computer should meet the following minimum 

hardware and software requirements. 

Item System Requirements 

Operating System Windows 10/11 (32-bit and 64-bit) 

CPU Intel Core i5 M520 2.4 GHz (min.) 

Memory Recommend to use 4 GB or above 

Hard Disk Drive 15 GB free for DIAScreen 

Monitor Resolution: 1024 x 768 Pixels, 1920 x 1080 Pixels 

Keyboard/Mouse General keyboard mouse or Windows-compatible device 

Printer Printer that can be driven by Windows system (if you need to 
print project content) 

PC Interface Ethernet, USB, Serial port (depends on product interface) 

Software 
Need to install Microsoft .Net Framework 4.6.2 
Need to install WinPcap V4.1.3* 
Need to install NDIS V5.0 

*Note: The upload and download function of the DOP-300 series HMI can transmit 

data through ZeroIP (zero address network) without network configuration and IP 

addresses. You must install and use the WinPcap package to realize this ZeroIP 

technology. 

WinPcap download link: winpcap.org/install/bin/WinPcap_4_1_3.exe 

  

http://www.winpcap.org/install/bin/WinPcap_4_1_3.exe
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Install DIAScreen 

DIAInstaller is used to easily download, install, uninstall, and update all DIAStudio 

software. You can download DIAInstaller from diastudio.deltaww.com. For more 

information about DIAInstaller, see DIAInstaller Download and Installation Manual. 

Prerequisites 

• DIAInstaller is installed. 

To install DIAScreen 

1. Open DIAInstaller. 

2. Click  at the upper-right corner to sign in. 

3. Go to All Apps and find DIAScreen. 

4. In Available Versions, select a version. 

5. Click  and then select Install. 

6. Select components to install. You can select the full components or customize 

the components to install. 

7. In the DIAScreen dialog, follow the on-screen instructions to complete the 

installation. 

8. Open DIAScreen and update the firmware version. For the firmware update 

method, see Update Manager. 

https://diastudio.deltaww.com/
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Uninstall DIAScreen 

Use the following steps to uninstall DIAScreen in DIAInstaller. 

Prerequisites 

• Back up the picture bank or component library created by users. 

 Picture bank file path: C:\ProgramData\Delta Industrial 
Automation\HMI\Common\Pic 

 Element bank file path: C:\ProgramData\Delta Industrial 

Automation\HMI\DIAScreen 1.4\ScrEditApp\Library 

Note: In the folder, click View and select the Hidden Items checkbox to view the 

ProgramData folder. 
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To uninstall DIAScreen 

1. In DIAInstaller, go to Installed, and select Uninstall. 

2. Follow the on-screen instructions to uninstall. 

3. A message dialog appears, asking whether to delete the user configuration. 

Click No to keep the user configuration. 

 

4. After uninstalling and reinstalling DIAScreen, overwrite the picture bank or 

element bank file to be restored to the above file path. 

 

Update DIAScreen 

Use the following steps to update DIAScreen. 

To update DIAScreen 

1. In DIAInstaller, go to Updates. 

2. Find DIAScreen. 

3. In Available Versions, select a version. 

4. Do one of the following: 

• Select Update and then follow the on-screen instructions to complete the 

update. 

• Click  and select Download to download the installation file to the local 

path, and then select Show in folder to find the .exe file to install. 
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Update Manager 

DIAScreen only has built-in firmware files for DOP-100 Series models, and you can 

download, install, and update the firmware for each series through Update 
Manager to edit the HMI screen of other models. 

The following table lists the functions in the Update Manager dialog and their 

descriptions. 
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Function Description 

 

Click to download the firmware or picture bank installation package. 

 

Click to Install the downloaded firmware or picture bank installation 
package. 

 

Click to uninstall the installed firmware or picture bank. 

 

Click to open the downloads folder. 

 

Click to check for updates. 

 

Use the following steps to download and install the HMI firmware. 

To download and install the HMI firmware 

1. On the home page of DIAScreen, click Update Manager. 

2. In the Update Manager dialog, select the desired HMI firmware installation 

package, and then click . 

Once the download is complete, a message dialog appears, asking whether to 

install the installation package. Do one of the following: 

• Click Yes to install automatically. 

• Click No to install manually, and then click . 

After the installation is complete, you can view the installed firmware version in 

Installed version. 
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Getting Started with DIAScreen 
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Sample Project 

To help users quickly set up projects, DIAScreen provides the following four sample 

projects: 

• Full-featured Application 

• Industry Applications 

• CODESYS Communication Application 

• Small kit Application 

 

The following table lists the functions demonstrated by each project and how they 

operate. 

• Full-featured Application 

Project Description 

Alarm Function 
Configure discrete alarms, trigger alarms through 
value changes or button clicks on the screen, and 
display alarm information on the alarm element. 

Full_Element_Demo 

Configure various elements on the screen, and apply 
different styles. After loading the project into the HMI, 
switch between different pages to view the operating 
effects of each element. 
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Project Description 

Temperature_Control_ 
Demo 

DOP series HMI connects AS controller to perform 
temperature control operations. Follow these steps 
to connect to the simulator. 
1. Open sample project in DIAScreen. 
2. Open the controller project in DIADesigner. 

Project Path:  
C:\ProgramData\Delta Industrial 
Automation\HMI\DIAScreen (version) 
\ScrEditApp\Example\1\ Example3_ 
Temperature_Control_Demo\Temperature_Con
trol_Demo.diade 

3. Create an AS300 simulator in COMMGR and 
start it. 

 
4. In DIADesigner, select AS PLC Simulator in 

Communication Setting, and click Connect. 

 
5. Perform Project Download and then perform 

Online. 
6. Open the sample project in DIAScreen and go to 

General > Device Communication. In 
Ethernet1 page of the Device Communication 
dialog, select AS PLC in For COMMGR. 
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Project Description 

 
7. Perform Off-line Simulation in DIAScreen. 
8. Perform temperature control operations through 

HMI simulator. 

History Function 

Presents historical data of various data types through 
the Historical Trend Graph element, and different 
styles of historical trend graphs are also configured to 
facilitate quick understanding of the functions 
provided by the history buffer. 

 

• Industry Applications 

Project Description 

Labeling machine Demonstrates the operating interface used for HMI 
monitoring equipment status in different industries. 
You can refer to the page configuration, copy the 
screen and apply it to their own designed projects. 

Extrusion rubber plate 
machine 

Electrical industry 
 

• CODESYS Communication Application 

Project Description 

CODESYS_Data_ 
Exchange 

Demonstrates data exchange between AX-8's Soft-
HMI and CODESYS controller. Follow these steps to 
configure the project. 
1. Use Update Manager to download and install 

AX-8 series package in DIAScreen. 
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Project Description 

 
2. Open sample project in DIAScreen and then 

download the project directly to the AX-8 device. 
3. Open the controller project in DIADesigner-AX, 

and then download the controller project to the 
AX-8 device.  
Project Path: C:\ProgramData\Delta 
Industrial Automation\HMI\DIAScreen 
(version)\ScrEditApp\Example\3 
\Example1_CODESYS_Data_Exchange_Demo 
\CODESYS_Data_Exchange_Demo.project 

4. Open HMIManager on the AX-8 device to monitor 
the CODESYS controller through the HMI. 

 

• Small kit Application 

This category of projects provides a variety of template styles. You can directly 

copy the template screens into the development project to achieve rapid project 

configuration. 

Follow these steps to copy a template. 

To copy a template 

1. Open the sample project. Select the screen in Screen Management Window 

pane. Right-click the selected screen, and select Copy (or use the shortcut 

key Ctrl + C). 
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2. Open another DIAScreen project and paste the screen directly in Screen 
Management Window pane (or use the shortcut key Ctrl + V) to configure 

the template screen in the development project. 

Project Description 

StartUp This project provides a variety of Startup interface 
template styles. 

Template This project provides a variety of Operating Interface 
template styles. 
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Create Screen Data File 

 

Create Screen Data File / Create Auto Update Data File 

After storing the files compiled by the project in an external storage device (USB or 

SD card) and insert it into the HMI, you can update the HMI screen through Screen 
Data file and Auto Update Data File. 

The following table lists the settings in the Setting dialog and their descriptions. 

Setting Description 

Enable Protection Enable password protection. When updating the screen on the 
HMI, you need to enter this copy password. 

Output Folder Select the folder path to save the download screen executable 
file. 

MAC Settings 

Enter the MAC of the HMI to update screen data. In the 

Configuration dialog, click  and enter the MAC code of 
the HMI to be bound, the file can only perform screen updates 
on the specified HMI; if the MAC code is not set, the HMI 
model is not restricted. 
Note: You can obtain the MAC code from System Menu > 
System Setting > Network on the HMI. 

 
 

Follow the steps to create the screen data file and auto update data file. 
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DIASceen Operation 

1. In the main menu, click Create Screen Data File > Create Screen Data File / 

Create Auto Update Data File. 

2. In the Setting dialog, make the related settings, and then click OK. 

The Screen Data File / Auto Update File are generated. 

 

Note: 

• If there are multiple data files in the HMI-000 folder, the software will number 

them sequentially from 000, for example, 000, 001, 002 and so on. 

• After executing Create Auto Update Data File, the HMI only recognizes the 

folder name HMI_AutoUP. If you repeatedly execute this function, the 

contents of this folder will be overwritten. 

If the project model is the DXMC series, after creating the project and setting the 

storage path and compiling, the software will automatically create a folder with 

the same name as the project under the project path and store the current screen 

data update file in the folder. You can directly import this update file into DXMC 
Model Software-DMARS (DELTA Motion And Robot Software) to update HMI 

screen. 
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HMI Operation 

• Create Screen Data File 

After inserting the storage device into the HMI, go to System Setting > File 
Manager > File Copy on the HMI, and copy the screen data file in the storage 

device to the HMI. 

• Create Auto Update Data File 

1. Inserting the external storage device into the HMI. 

When the HMI detects an external storage device with an auto update file 

(HMI_AutoUP), a message displays and ask you whether to execute the auto 

update. 

2. Click Yes, the firmware and screen will be updated automatically. 

Note: If the folder HMI_AutoUP is stored in both USB and SD card, when 

updating the firmware and screen files, the HMI will first update the USB. 

Open Screen Data File 

The generated Screen Data File / Auto Update File can also be edited in the 

software by Open Screen Data File function. 
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Create Download Screen Executable 

You can update the HMI screen or firmware to the HMI through Screen Download 
Executable File without installing the DIAScreen software. 

The following table lists the settings in the Create Download Screen Exe. File 
dialog and their descriptions. 

Settings Description 

Executable file 
name Set the name of the generated executable file. 

Output folder Select the folder path to save the download screen 
executable. 

MAC settings 

Enter the MAC of the HMI to update screen data. In the 

Configuration dialog, click  and enter the MAC code of 
the HMI to be bound, the file can only perform screen 
download on the specified HMI; if the MAC code is not set, the 
HMI model is not restricted. 
Note: You can obtain the MAC code from System Menu > 
System Setting > Network on the HMI. 

 
 

Follow the steps to create download screen executable. 

To create download screen executable 

1. In the main menu, click Create Screen Data File > Create Download Screen 
Executable. 

2. In the Create Download Screen Exe. File dialog, make the related settings.  
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3. In the output folder, execute the executable file (the default file name is 

DownloadScreen.exe). 

4. In the pup-up dialog, do one of the following: 

 

• Selecting All data will automatically check the HMI firmware version. If the 

version matches the version that can be executed by the executable, the 

firmware update will be executed and the screen data will be downloaded to 

the HMI. 

• Selecting Only upgrade firmware will update the HMI firmware update 

directly. 

Note: Before executing Create Download Screen Executable, set the HMI screen 

upload / download mode first. Go to General > Environment on the toolbar to set. 
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Create Screen Auto Execution File 

You can execute auto operation of the HMI screen on the computer through Screen 
Auto Executable without installing the DIAScreen software. 

The following table lists the settings in the Create screen executable file dialog and 

their descriptions. 

Settings Description 

Executable file 
name Set the name of the generated executable file. 

Output folder Select the folder path to save the download screen executable. 
 

Follow the steps to create screen auto executable. 

To create screen auto executable 

1. In the main menu, click Create Screen Data File > Create Screen Auto 
Execution File. 

2. In the Create screen executable file dialog, make the related settings. 

3. In the output folder, execute the executable file (the default file name is 

HMIEmulator.exe). 

4. In the COM Port Setting dialog, set the communication port of the executable 

file. 

 

Note: If communicating via network, you can ignore this dialog. Click Cancel to 

communicate with the IP set in the project.  



 

Create Screen Data File 
 

 

23 DIAScreen V1.6.0 

The execution screen is as follows. 
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Duplicate 
The duplicate feature allows you to perform duplication of an element, and then 

automatically increments or decrements the address according to your needs. 

To duplicate 

Do one of the following methods to perform duplication of an element: 

• Right-click on the element and select Duplicate. 

• Select the element and click General > Duplicate in the menu bar. 

The following table lists the settings in the Duplicate dialog and their descriptions. 

 

 Copies 

Setting Description 

Columns Select or enter the number of horizontal (X) and vertical (Y) to 
get the total number of X*Y elements. You can also select / 
unselect the checkbox to single-select columns or rows 
according to your needs. Rows 
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 Spacing (Pixels) 

Setting Description 

Horizontal Select or enter the spacing between each element. Once the 
duplication is complete, spacing generates automatically 
according to the settings. Vertical 

 

 Name Address Direction 

Setting Description 

Horizontal 
Direction 

Set the duplicate direction of addresses. The duplicated 
element address increments (positive) or decrements (negative) 
according to the offset and gets duplicated horizontally or 
vertically. 

Horizontal Vertical 

  
 

Vertical 
Direction 

 

 Offset And Array index 

Setting Description 

Offset 

Select or enter the amount that addresses increment or 
decrement automatically. 
• If elements are set as Word units, the increments or 

decrements are calculated in Word units. 
• If elements are set as Bit units, the increments or 

decrements are calculated in bit units. 
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Setting Description 

Array Index 

Select the array index location. The default value is default. 
• Select Default, and the address is offset in the element unit. 

 
• Select 1–4 for the Tag address. The array indexes are 

arranged from right to left. 

 
Note: You can specify the offset of the array index. Currently 
available for CODESYS Tag only. 

 

 Enable Automatic Text Numbering 

Setting Description 

Starting number Select or enter the starting value of the number displayed on the 
element. 

Text format Enter the text format of the number displayed on the element. 
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Configuration 
Go to General > Configuration to configure the operation settings for the HMI screen. 

The functions of each parameter are described as follows. 

 

Main 

 

 Project and Basic Settings 
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Function Description 

Name 

Set the name of project. The project name on the Project tree will 
be changed synchronously. 

 
HMI Type Display the currently edited HMI model. 

Clock Macro 
Delay Time 

Set the interval time after each execution of Clock and Macro. The 
range value is 50–65535, and the default value is 100. 

Clock Macro 
Priority 

Set the priority of the Clock macro execution. The higher the 
priority, the more accurate the Clock Macro Delay Time. 

Background 
macro update 

cycle 

Set the number of lines executed per cycle of the background 
macro. The range value is 1–512, and the default value is 1. 

LUA Delay 
Time 

Set the interval time after each execution of LUA. The range value 
is 0–10, and the default value is 10. 

LUA priority Set the priority of LUA execution. The higher the priority, the more 
accurate the LUA Delay Time. 

Print priority Set the priority of print execution. 
 

 Project Description 
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Function Description 

Project 
Description 

Set the purpose of the HMI screen. After running DIAScreen, you 
can see the description of the project in Recent opened file. 

 
 

Non-volatile 

 

Function Description 
Non-volatile 
data storage 

Non-volatile data can be stored in Alarm, Recipe, and History 
Buffer. 
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Function Description 
Storage location depends on the devices supported by the model. 
The available options include HMI, USB Disk, USB Disk 2, and SD 
Card. 
The part of historical data will be determined if you have established 
a History Buffer. 

 

Write the 
cache size 

of the 
external 

Select the external storage devices (USB Disk and SD Card). 
The data written by the HMI to the external storage device will be 
temporarily placed in the cache area. However, this setting value 
depends on the amount of data in the cache area. If the amount of 
data does not reach this setting value, the data will not be written to 
the external storage device. This method can prevent the external 
storage device from being damaged due to continuous writing. 
Assuming that the amount of data to be accessed is less than the 
capacity of the buffer or there is unexpected power failure, it may 
result in partial data loss. In order to avoid this situation, you can 
forcibly trigger the bit5 of the general control flag of the control area 
at regular intervals to write data to external storage device to ensure 
the existence of data. 
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Security Level and Password 

 

 Security Management 

Function Description 

Highest 
security 

password 

Set the password with the highest security level of HMI, which means 
level 10. The default value is 12345678. 
• This password is used to control upload screen data and 

recipes, download screen data and recipes (you need to 
select the Check password when downloading program 
checkbox), password protection, system formatting, system 
file encryption and copy file functions (you need to select 
Limit the times of updating screens via USB drive 
checkbox). 

• The password text format is Hexadecimal unit from 0 to F. If 
you select the Complex password checkbox, the complex 
password must set more than (inclusive) 8 characters and 
contain an uppercase letter, a lowercase letter, a number, 
and a symbol (!, $, #, %). 

Default startup 
security level 

Set the default security level when the HMI is turned on. You can 
set the level from 0 to 10.  
Note: Level 10 is the highest security level. 
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Function Description 

Check 
password 

when 
downloading 

program 

If selected, when executing Download All Data and Download 
Recipe, the software asks you to enter the highest security 
password. 
The screen can be downloaded to the HMI normally only after the 
password is entered successfully. If the password is failed, a 
warning message appears to notify you that the password is 
incorrect and cannot be downloaded. 
Note: You need to download the project to the HMI first and 
execute Download All Data again after selecting this option. 

Screen upload 
prohibited 

If selected, when executing Upload All Data, a warning message 
appears to notify you that the data cannot be uploaded. You 
need to download the project to the HMI first and execute 
Upload All Data again after selecting this option. 

 

Prompt a 
reminder for 
insufficient 

security level 

If selected, if the user security level set in the element is higher 
than the default boot security level, the element on the HMI 

displays  that indicates that your current security level is not 
sufficient. 

Don’t show 
password input 
window when 
the security 

level is 
insufficient 

If selected, if your current security level is not sufficient, the 
password input window does not display. 

Restrict high 
account 
function 

If selected, no operations can be performed on low-level 
accounts. 

Complex 
password 

If selected, all passwords must be set more than (inclusive) 8 
characters and contain an uppercase letter, a lowercase letter, a 
number, and a symbol (!, $, #, %). 

Limit the times 
of updating 
screens via 
USB drive 

If selected, you can encrypt the screen data files and limit the 
number of times of copying files. 
This function is mainly used with the function of file encryption 
and copying of files. 
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 Login / logout 

Function Description 

Logout when 
time out 

If selected, the system will return to the default boot security level 
according to the set Minutes before reset to default boot 
permission when the HMI is in idle status. 

Account 
disabled after 

login failed  

If selected, the account will be disabled according to the set 
Number of consecutive failed retries when login fails 
consecutively. 

The first login 
of the 

component 
does not 
execute 

immediately 

If selected, if the current executed security level is not sufficient, 
click the element to log in and then click it again to execute the 
element action. 

Change 
password on 

first login 

If selected, the HMI forces you to change the password after 
logging in for the first time. 

 

 Password Keypad 

Function Description 

Password 
Keypad 

Select the keypad according to your needs. The default is Default 
Keypad. 
Note: If you select Simple Keypad, the Complex password 
setting is not available. 

 

 Account and Password 

Function Description 

Account and 
Password 

Set the security level and the account and password of HMI.  
The security level is divided into 0–9, each level can add multiple 
accounts for users to log in at the same time. 
The following describes the setting rules for the account and 
password: 
• Password must not be blank. 
• Within the same security level, the account names cannot be 

the same, but the passwords can be the same. The account 
names of different security levels can be the same. 

• The length of the account and password is limited to 24 
characters and is not case-sensitive. 

• User description can only be entered in English or numbers. 
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Function Description 
• Security levels are divided as follows: 
 Level 0: No protection function, anyone can operate. 
 Level 1–9: You need to enter the corresponding password 

or a higher security level to operate. 
 Level 10: The highest security password and the protection 

password after project storage. This password is also the 
password to be entered when executing Check password 
when downloading program and formatting the system 
file. 

Note: The account and password support 1,000 records, 
regardless of level. 
You can use the button element Password Table or select 
System Menu > System Settings > Password on the HMI to 
open the account and password table to change the password 
and account. 

 

Enable RFID 
login 

Click to enable RFID login, you can login your account or add 
new account and password through external device on the HMI. 
Note: The RFID field in software is read-only. You need to add 
an RFID code through the HMI and upload all the data before the 
RFID code can be displayed. 

 /  

Click to export the account and password table as a CSV file, 
which can be imported into software after editing. 
The exported CSV file is named accounts.csv and saved in the 
storage device. The account and password table can be imported 
into the HMI through the Import/Export Account element. 

User Login 
Screen 

Set the login screen for each user level. When the User Security 
Level setting of the element is not 0 and no custom login user 
screen is specified, the login screen specified here will be 
displayed. 



 

Configuration 
 

 

35 DIAScreen V1.6.0 

Function Description 

 
 

Global Keypad Settings 

You can set the keypad styles through Global Keypad Settings or element property 

dialog. The keypad types include Decimal, Hexadecimal, Binary and ASCII. Global 
Keypad Settings also provides multiple application methods to update the keypad 

styles of elements. 

Follow the steps to set the global keypad style through element property dialog. 

To set the global keypad style through element property dialog 

1. Create Numeric Entry or Character Entry elements on the editing screen, 

double-click the elements. 

2. In the element property dialog, click  in the Detail area in the Main tab. 

3. In the System Keypad Layout dialog, set the keypad style according to your 

needs. Or you can edit through General > Configuration > Global Keypad 
Settings. 

 
The following table lists the functions of the Global Keypad Settings page with their 

description. 
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 Decimal Keypad 

Function Description 

System Keypad 

This keypad is applied to the Numeric Keypad element when 
the place value is set to decimal. 

 

Custom Keypad 
Click  to select the custom screen. 
Go to General > New Screen > Keypad Screen to customize 
screen. 
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Function Description 

Apply Settings 

Set the keypad style applied method. 
• Not apply: Maintain the original style of the system keypad. 
• Apply to all: Replace the old keypad style with the new style. 
• Apply to new: Only applies to newly created keypads. 

 

 Binary Keypad 

Function Description 

System Keypad 

This keypad is applied to the Numeric Keypad element when 
the place value is set to binary. 

 

Custom Keypad 
Click  to select the custom screen. 
Go to General > New Screen > Keypad Screen to customize 
screen. 

Apply Settings 
Set the keypad style applied method. 
• Not apply: Maintain the original style of the system keypad. 
• Apply to all: Replace the old keypad style with the new style. 

 

 Hexadecimal Keypad 
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Function Description 

System Keypad 

This keypad is applied to the Numeric Keypad element when 
the place value is set to hexadecimal. 

 

Custom Keypad 
Click  to select the custom screen. 
Go to General > New Screen > Keypad Screen to customize 
screen. 

Apply Settings 
Set the keypad style applied method. 
• Not apply: Maintain the original style of the system keypad. 
• Apply to all: Replace the old keypad style with the new style. 

 

 ASCII Keypad 

Function Description 

System Keypad 

This keypad is applied to the Character Keypad element when 
the place value is set to ASCII. 
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Function Description 

Custom Keypad 
Click  to select the custom screen. 
Go to General > New Screen > Keypad Screen to customize 
screen. 

Apply Settings 

Set the keypad style applied method. 
• Not apply: Maintain the original style of the system keypad. 
• Apply to all: Replace the old keypad style with the new style. 
• Apply to new: Only applies to newly created keypads. 

 

System Setting 

 

Function Description 

Enable Touch 
Cursor 

If selected, when the HMI screen is pressed, the same mouse 
icon as the Windows operating system pointer appears. 
HMI supports wireless mouse with Unifying receiver. 



 

Configuration 
 

 

40 DIAScreen V1.6.0 

Function Description 

Display initial 
screen at startup 

If selected, the HMI displays the initial screen every time it is 
powered on. 

 

Auto detect 
baud rate 

If selected, a message displays on the HMI and asks whether 
to detect procedure. When the baud rate of the HMI is 
different from that of the controller, it will be automatically 
adjusted to the same. 

Keep user data 
If selected, the files generated through LUA do not delete 
while downloading the screen. It will only be deleted while 
formatting or restoring to factory settings. 

Pre-read invisible 
bit state value 

If selected, when the invisible address is set to the controller 
address, switching the screen can avoid the transient state of 
the element display, but it affects the screen display speed. 

Use terminator If selected, character display/input, historical data display, and 
historical data CSV storage are applied the end character '\0'. 

Watchdog If selected, the HMI automatically restarts when it crashes. 
Disable low 

battery message 
If selected, the HMI does not display the low battery message 
when it is initializing. 
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Function Description 

Retain historical 
data after screen 

update 

If selected, the historical data on the HMI is retained when 
downloading the screen. 
In order to retain and continue to use the historical data, the 
historical data will be compared with the history buffer settings 
before updating the HMI screen. The following are the 
comparison principles. 
• The process of database saving and the export of CSV 

files are not affected. 
• Historical elements may still display or behave normally. 
After changing Read Length, Sample Number, Stamp Time 
and Date, Non-volatile, Export CSV File (including Field 
Name), and Save As Single File / Multiple File, the historical 
data will not be retained even if this setting is selected. 

 
Keep the account 

and password 
table settings after 

the screen is 
downloaded 

If selected, the settings of the account and password table 
does not change while downloading the screen. 

Keep Installment 
payment settings 

after screen 
download 

If selected, the installment data on the HMI is retained while 
downloading the screen. 
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Function Description 

Close Title 
Display 

If selected, the HMI screen does not display the title bar. 

 
Note: This setting is only available for AX-8 Windows and 
IMP Series models. 

Minimize window 
to the system tray 

after startup 

If selected, the HMI screen minimizes to the system tray when 
it starts. 
Note: This setting is only available for AX-8 Windows and 
IMP Series models. 

Prompt before 
closing window 

If selected, a message displays when the HMI screen is 
closed, informing that the HMI application will be closed. 
Note: This setting is only available for AX-8 Windows and 
IMP Series models. 
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Function Description 

USB 
Upload/Download 

Select the USB upload / download mode. 
• Auto 
 If selected, after downloading the project, the HMI 

maintains the currently set mode to upload and 
download. 

 The factory default value of other HMIs is Auto (except 
for B05S100, B05S101, B07S201, and B07S211 
models). 

• Disk 
If selected, after downloading the project, the HMI uses 
this mode to upload and download (it is USBCommMode 
= 1.). You can view “DELTA” removable storage device in 
The PC. 

 
• CDC 

If selected, after downloading the project, the HMI uses 
this mode to upload and download (it is USBCommMode 
= 2). Right-click the blank space in The PC and go to 
Content > Device Manager. In the Device Manager 
dialog, check whether there is HMI device under Ports 
(COM & LPT). 

 

HMI priority action 

Select the HMI priority action. 
• None—The HMI does not take any actions first. 
• Touch—The HMI receives the touch action first, and then 

process the system operation. 

Network Default 
Gateway 

Select network default gateway. The options are displayed 
according to the number of network ports of models. If extra 
network accessories are attached on the HMI, you can select 
Wi-Fi or 4G. The default value is Auto. 
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Function Description 

Brightness Set the brightness of the HMI backlight. 

TP Delay 

Set the delay time for the HMI to process pressing the move 
messages. Drag the delay to the right to decrease, the speed 
becomes faster; drag the delay to the left to increase the 
speed, and the speed becomes slower. 

TP Force 

Set the force for pressing the HMI screen. Drag the force to 
the left to decrease, the HMI screen becomes easier to press; 
drag the force to the right to increase, and the HMI screen 
becomes difficult to press. 

Buzzer Set the buzzer volume of the HMI. Drag to the left to increase 
the volume, and drag to the right to decrease the volume. 

Boot Buzzer 
Volume 

Set the boot buzzer volume of the HMI. Drag to the left to 
increase the volume, and drag to the right to decrease the 
volume. 

Key sound 
Set the sound when the HMI is pressed. Drag to the left to 
increase the volume, and drag to the right to decrease the 
volume. 

Animation FPS Set the update speed of the animation element setting 
frequency. 
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Screensaver Setup 

 

Function Description 

Enable Screensaver 

If selected, you can set how long it takes to enter the 
screen saver screen without pressing the screen. The 
value range is 1–100, and the default value is 10. 
The screen saver can be configured by clicking  
of Screensaver Screen or in General > Screen saver 
Screen. 
Note: If Enable Screensaver is not selected, but the 
screen saver is configured, the screen saver will not 
be activated. 

Enable backlight saving 

If selected, you can set how long it takes to enable the 
backlight saving function without pressing the screen. 
• The value range is 1–10, and the default value is 

3. 
• The saving ratio range is 1–99, and the default 

value is 50. 
Screensaver trigger 

address 
Set Word trigger address, 0 is to turn off the screen 
saver, and 1 is to turn on the screen saver. 
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Function Description 

After exiting the 
screensaver 

• Return to original screen: If selected, after the 
screen saver is over, it jumps to the original screen 
before starting the screen saver. 

• Choose screen: If selected, you can specify the 
screen number, so that the designated screen will 
be displayed after the screen saver ends. 
Note: If you want to use the specified screen, 
create a screen saver screen first. 

 

The following figure displays the flow chart of the screen saver screen. 
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Others 

 

Function Description 

Show disk 
accessing error 

message 

Since alarms, history buffers and recipes can be set to save 
data as USB Disk or SD Card, if the external disk access fails, 
you can decide whether to display the warning message 
through this setting. 
The disk access failure means that when the non-volatile data 
location of history buffer is set to USB Disk, the HMI cannot 
detect the USB Disk after powering on, and cannot write data. If 
this option is not selected, when the above situation occurs, no 
error message appears. 

Insufficient 
storage hint 

screen 

Set how many MB of storage space is left to jump to the 
specified screen. The storage spaces can be specified to HMI, 
USB Disk, USB Disk 2, and SD. 

Video 

If Video Overlay is selected, the VGA or Camera element 
superimposes on the element, and the display can be triggered 
through the invisible address. 
This setting enables / disables according to different models. 
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Control Status Block 

The Control Status Block is used to execute or monitor the system operation and 

status. Select any of functions according to your needs, for example, in Control Block, 

you only need to select the Screen No. and Recipe Number, the control status 
block automatically configures the addresses continuously and only enables the Goto 
Screen and Recipe Group Control functions. 

If an additional function is selected, such as General Control, the memory addresses 

are arranged continuously from top to bottom. 

 

Function Description 

Auto Reset 
Flags 

If selected, the HMI automatically resets the flags. 
To reactivate some functions in the Control Block, first turn the 
corresponding flags OFF, and then turn it ON again. 

Data Format 
Set the Data Format of the control status block. 
The default value is Unsigned Decimal. 
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Control Block 

The Control Block is used to control the actions of the HMI, such as Goto screen, 

curve, recipe control, and user level. 

 

Function Description 

Use 
discontinuous 

address in 
Control Block 

If selected, the settings in the Control Block are available, and 
you can define the register addresses in the controller or the 
HMI internal memory. 

Sampling Cycle 
Set the interval time between the sampling actions. 
The value range is 100–1000, and the default value is 300. 

 

The following table lists the flags of screen no. register with its description. 

Screen No. Register 

b0~b15 – 
Screen No. 

• Write the specified screen number into this register, and the 
HMI switches to the specified screen. 

• If a Numeric Entry element is set to D0 and the input value 
is 1, the HMI switches to the first screen. 
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Screen No. Register 

 
 

The following table lists the flags of general control register with their description. 

General Control Register 

 

(1) b0 Communication enable / disable flag 
(2) b1 Backlight enable / disable flag 
(3) b2 Buzzer enable / disable flag 
(4) b3 Alarm buffer clear flag 
(5) b4 Alarm counter clear flag 
(6) b5 External storage device cache write flag 
(7) b6 Remote control lock 
(8) b7 Reserved 
(9) b8~b11 Set User Security Level 
(10) b12~b15 Reserved 
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General Control Register 

b0 – 
Communication 
enable / disable 

flag 

Enable / disable the HMI communication. 
• To use this flag, click General > Communication Settings, 

and then select Disconnect after communication 
interrupt checkbox and set the Retry times after 
disconnection. 

• When the HMI communicates with the controller, the HMI 
automatically stops the communication with the controller 
and turns the flag ON after the number of interruption times 
reaches the set retry times without the communication error 
message (this does not affect the communication between 
the HMI and other controllers). You can restore the 
communication by turning the flag OFF. 

 
Note: 
• This flag is only for restoring the communication when it is 

automatically stopped. It is not possible to directly stop the 
communication between the HMI and any controller by 
turning the flag ON. 

• The Auto Reset Flags function is not applicable to this flag. 

b1 – 
Backlight enable 

/ disable flag 

Enable / disable the HMI backlight. 
• Set to ON, the HMI backlight is enabled. 
• Set to OFF, the HMI backlight is disabled. 
Note: The Auto Reset Flags function is not applicable to this 
flag. 
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General Control Register 

b2 – 
Buzzer enable / 

disable flag 

Enable / disable the HMI buzzer. 
• Set to ON, the HMI buzzer is enabled. 
• Set to OFF, the HMI buzzer is disabled. 
Note: The Auto Reset Flags function is not applicable to this 
flag. 

b3 – 
Alarm buffer 

clear flag  

Clear the alarm buffer data of the HMI.  
Set to ON to clear the data in the alarm buffer. To reactivate this 
function, turn the flag OFF and then ON again. 

b4 – 
Alarm counter 

clear flag 

Clear the alarm frequency table data of the HMI. Set to ON to 
clear the data in the alarm frequency table. To reactivate this 
function, turn the flag OFF and then ON again. 

b5 – 
External storage 

device cache 
write flag 

Update the HMI cache data into an external storage device 
(USB Disk or SD Card) in real time. 
• If the alarm buffer, history buffer, or recipe function is 

activated, and the non-volatile storage location is set to USB 
Disk or SD, when the flag is set to ON, the HMI updates the 
data temporarily stored in the cache into an external storage 
device in real time. To reactivate this function, turn the flag 
OFF and then ON again. 

• The data written into USB or SD Card by the HMI is 
temporarily stored in the cache first. Before the cache data 
size reaches the set limit (as shown in the following figure), 
the data is not written into an external storage device. This 
is to prevent the external storage device from being 
damaged by frequent overwriting. However, if the data 
volume accessed is less than the buffer capacity or the 
power is cut off unexpectedly, part of the data may be lost. 
To keep the data, turn ON the flag in a cyclic pattern to write 
the data into the external storage device. 
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General Control Register 

 

b6 – 
Remote control 

lock  

Control whether the eRemote can be operated. 
• Set to ON, eRemote can only be monitored and cannot be 

operated. 
• Set to OFF, eRemote can be operated normally. 
Note: The Auto Reset Flags function is not applicable to this 
flag. 

b8~b11 – 
Set User  

Level 

You can set the current user level of the HMI. The HMI internal 
security levels are divided as follows: 
• Security level 0–7: Controlled by Bit 8, Bit 9, and Bit 10 

flags. Level 0 is the lowest security level 
• Highest security level: Controlled by Bit 11 flag. 

The following table lists the setting method or the security level. 

Security Level 
Flag Control 

Bit 10 Bit 9 Bit 8 
0 0 0 0 
1 0 0 1 
2 0 1 0 
3 0 1 1 
4 1 0 0 
5 1 0 1 
6 1 1 0 
7 1 1 1 

Note: If enable Advanced Level Access Control, the user 
level control here will be invalid. 
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The following table lists the flags of curve control register with their description. 

Curve Control Register 

 
(1) b0~b3 Curve sampling flags 1~4  
(2) b4~b7 Reserved 
(3) b8~b11 Curve clear flags 1~ 
(4) b12~15 Reserved 

b0~b3 – 
Curve sampling 

flags 
(1~4) 

Control the curve drawing action. 
• The curves include the Trend Graph and X-Y Chart. 
• If the flag is set to ON, the corresponding curve element 

samples and draws the curve. To reactivate this function, 
turn the flag OFF and then ON again. 

• The sampling flag 1 of the Trend Graph element 
corresponds to the curve clear flag 1; the sampling flag 2 
of the Trend Graph element corresponds to the curve 
clear flag 2, and so forth. 

 

b8~b11 – 
Curve clear flags 

(1~4) 

Control the curve clear action. 
If the flag is set to ON, the corresponding curve element clears 
the curve. To reactivate this function, turn the flag OFF and 
then ON again.  
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The following table lists the flags of recipe control register with their description. 

Recipe Control Register 

 
(1) b0 Recipe number change flag 
(2) b1 Recipe read flag (PLC  HMI) 
(3) b2 Recipe write flag (HMI  PLC) 
(4) b3 Recipe group change flag 
(5) b4~b7 Reserved 
(6) b8~b15 Specify Recipe group number  

b0 – 
Recipe number 

change flag  

Change the HMI recipe number. This is applicable to 16-Bit 
recipes. You must write the recipe number to be changed into 
the recipe number control register, and then trigger the recipe 
number change flag. 
Do one of the following to call or change the recipe number: 
• Use the HMI internal register RCPNO. 

 
• Use this recipe number change flag. 
When the recipe number change flag is turned ON, the recipe 
number is changed according to the value defined in the 
recipe number control register, and the number of RCPNO 
internal register is changed automatically. To reactivate the 
function, turn the flag OFF and then ON again. 

b1 – 
Recipe read flag 

(PLC  HMI) 

When the recipe read flag is turned ON, the HMI reads the 
controller recipe data and writes the data into the designated 
recipe data register. To reactivate the function, turn the flag 
OFF and then ON again. 

b2 – 
Recipe write flag 

(HMI  PLC) 

When the recipe write flag is turned ON, the HMI writes the 
designated recipe data into the controller register. To reactivate 
the function, turn the flag OFF and then ON again. 

b3 – 
Recipe group 
change flag 

Change the HMI recipe group number. This is applicable to 32-
Bit recipes. 
Do one of the following to call and change the recipe group: 
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Recipe Control Register 
• Use the HMI internal register RCPG. 

 
• Use the recipe group change flag. 
When the recipe group change flag is turned ON, the recipe 
group is changed according to the value defined in the recipe 
group change bits (b8~b15), and the number of the RCPG 
internal register is changed automatically. To reactivate the 
function, turn the flag OFF and then ON again. 

b8~b15 – 
Designate recipe 

group to be 
changed 

Designate the recipe group to be changed with the high byte 
(Bits 8~15) from the recipe control register. By activating the 
recipe group change flag, the HMI changes the number of the 
RCPG internal register, it is changing the recipe group. 

 

The following table lists the flags of recipe number register with their description. 

Recipe Number Register 

 

b0~b15 – 
Recipe designation 

Designate the group number of the recipe group to be 
changed through the recipe number register. By activating 
the recipe group change flag, the HMI automatically 
changes the number of the RCPG internal register, it is 
changing the recipe group. 

 

The following table lists the flags of system control register with their description. 
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System Control Register 

 

(1) b0~b7 Multi-language setting values 
(2) b8 Printer flag 
(3) b9 Printer form feed flags 
(4) b10~b11 Retrieve Ethernet address 
(5) b12 Wi-Fi retrieve network address 
(6) b13~b15 Reserved 

b0~b7 – 
Multi-language 
setting values 

Change the multi-language setting values to switch 
languages. You can set the multi-languages in Multi-
language setting page of Configuration dialog. 
Note: Supports adding up to maximum 32 languages. 

b8 – 
Printer flag 

Set the printing mode, which is divided into general 
printing and screen layout printing. 
• Set to ON, the printer runs according to the set mode. 
• Set to OFF, the printer is idled. 

 
Note: Only one mode is enabled at a time. The screen 
layout printing is prioritized. 
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System Control Register 

b9 – 
Printer form feed flag 

• Set to ON, the printer ejects the paper and flips the 
paper. 

• Set to OFF, the printer is idled. 

 

b10~b12 – 
Retrieve network 

address 

When the HMI fails to obtain the IP address assigned by 
the DHCP server, trigger this bit to retrieve the IP address.  
• b10 is for obtaining the IP address with LAN1 
• b11 is for obtaining the IP address with LAN2. 
• b12 is for obtaining the IP address with Wi-Fi. 

 

The following table lists the flags of enhanced recipe control register with their 

description. 
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Enhanced Recipe Control Register 

 

(1) b0 Enhanced Recipe number change flag 
(2) b1 Enhanced Recipe read flag (PLC  HMI) 
(3) b2 Enhanced Recipe write flag (HMI  PLC) 
(4) b3 Enhanced Recipe group change flag 
(5) b4~b7 Reserved 
(6) b8~b15 Specify group number of Enhanced Recipe 

b0 – 
Enhanced Recipe 

number change flag 

Change HMI recipe group. This is applicable to enhanced 
recipes. 
Do one of the following to call or change the enhanced 
recipe number: 
• Use the HMI internal register ENRCPNO. 

 
• Use enhanced recipe group change flag. 
When the enhanced recipe group change flag is turned 
ON, the enhanced recipe group is changed according to 
the number defined in the enhanced recipe group control 
register, and the number in the internal register ENRCPNO 
is changed automatically. To reactivate the function, turn 
the flag OFF and then ON again. 

b1 – 
Enhanced Recipe 

read flag 
(PLC  HMI) 

When the enhanced recipe read flag is turned ON, the 
HMI reads the controller enhanced recipe data and writes 
it into the designated enhanced recipe data register. To 
reactivate the function, turn the flag OFF and then ON 
again. 

b2 – 
Enhanced Recipe 

write flag 
(HMI  PLC) 

When the enhanced recipe write flag is turned ON, the 
HMI writes the designated enhanced recipe data into the 
controller register. To reactivate the function, turn the flag 
OFF and then ON again. 

b3 – 
Enhanced Recipe 

group number 
change flag  

Change the HMI recipe group number. This is applicable to 
enhanced recipes. 
Do one of the following to call or change the enhanced 
recipe group number: 
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Enhanced Recipe Control Register 
• Use the HMI internal register ENRCPG. 

 
• Use enhanced recipe group number change flag. 
When the enhanced recipe group number change flag is 
turned ON, the enhanced recipe group number is changed 
according to the value defined in the enhanced recipe 
group number bits (b8~b15), and the number in the 
internal register ENRCPG is changed automatically. To 
reactivate the function, turn the flag OFF and then ON 
again. 

b8~b15 – 
Designate enhanced 
recipe group number 

to be changed  

Designate the enhanced recipe group number to be 
changed with the high byte (Bits 8~15) from the enhanced 
recipe control register. By activating the enhanced recipe 
group number change flag, the HMI changes the number 
in the internal register ENRCPG, it is changing the 
enhanced recipe group. 

 

The following table lists the enhanced recipe control register with their description. 

Enhanced Recipe Control Register 

 

b0~b15 – 
Enhanced Recipe 

designation  

Designate the enhanced recipe group number to be 
changed from the enhanced recipe group control register. 
By activating the enhanced recipe group change flag, the 
HMI changes the number in the internal register 
ENRCPNO, it is changing the enhanced recipe group. 

 

The following table lists the advanced level access control register with their 

description. 
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Advanced Level Access Control 

b0~b3– 
Set User Level 

Change the user level of the current HMI by triggering the 
Bit 0, Bit 1, Bit 2 and Bit 3 flags. 
The following table lists how to set security levels. 

Security 
Level 

Flag Control 
Bit 3 Bit 2 Bit 1 Bit 0 

0 0 0 0 0 
1 0 0 0 1 
2 0 0 1 0 
3 0 0 1 1 
4 0 1 0 0 
5 0 1 0 1 
6 0 1 1 0 
7 0 1 1 1 
8 1 0 0 0 
9 1 0 0 1 

 

b15 
Set User Highest 

Level 
Highest security level control. 

Note: If Advanced Level Access Control is enabled, user level of General Control 
becomes invalid. 

 

Status Block 

The Status Block is used to monitor the present HMI status, such as current screen 

number, curves, recipe control, and user level. 

Note: If the Control Block is not set, the Status Block cannot monitor the status. 

Moreover, the addresses of the Control Block and Status Block cannot be the 

same. 
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Function Description 

Use 
discontinuous 

address in 
Status Block 

If selected, the settings in the Status Block are available, and 
you can define the register addresses in the controller or the 
HMI internal memory. 

 

The following table lists the flags of general control status register with their 
description. 

General Control Status Register 

 

(1) b0 Screen switch flag 
(2) b1~b2 Reserved 
(3) b3 Alarm buffer clear flag 
(4) b4 Alarm counter clear flag 
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General Control Status Register 
(5) b5 External storage device cache write flag 
(6) b6 Remote control lock flag 
(7) b7 Reserved 
(8) b8~b11 Set user level 
(9) b12~b15 Reserved 

b0 – 
Screen switch flag 

• When the screen is switching, the flag is turned ON, 
• When the screen switching is completed, the flag is 

turned OFF. 

 

b3 – 
Alarm buffer clear 

flag 

• When the HMI is clearing the alarm buffer, the flag is 
turned ON. 

• When the alarm buffer clearing is completed, the flag is 
turned OFF. 

 



 

Configuration 
 

 

64 DIAScreen V1.6.0 

General Control Status Register 

b4 – Alarm counter 
clear flag  

• When the HMI is clearing the alarm counter, the flag is 
turned ON. 

• When the alarm counter clearing is completed, the flag 
is turned OFF. 

 

b5 – External storage 
device cache write 

flag 

• When the HMI is updating the cache data into the USB 
or SD card, the flag is turned ON. 

• When data updating is completed, the flag is turned 
OFF. 

 

b8~b11 – 
Set user level 

Reads the current user level operated by the HMI. The 
following table lists the bit state corresponding to the user 
level operated by the HMI. 

Security Level Flag Control 
Bit 11 Bit 10 Bit 9 Bit 8 

0 0 0 0 0 
1 0 0 0 1 
2 0 0 1 0 
3 0 0 1 1 
4 0 1 0 0 
5 0 1 0 1 
6 0 1 1 0 
7 0 1 1 1 

Highest security 
level 1 0 0 0 

Note: If Advanced Level Access Control is enabled, the 
user level here will be invalid. 
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The following table lists the flags of screen No. status register with their description. 

Screen No. Status Register 

 

b0~b15 – 
Screen No. status 

Check the last opened screen number with this status register. 

 

The following table lists the flags of the curve control status register with their 

description. 

Curve Control Status Register 

 

(1) b0~b3 Curve sampling status flags 1~4 (b0 refers to flag 1, and so forth) 
(2) b4~b7 Reserved 
(3) b8~b11 Curve clear status flags 1~4 (b8 refers to flag 1, and so forth) 
(4) b12~b15 Reserved 
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Curve Control Status Register 

b0~b3 – 
Curve sampling 

status flags  
(1~4) 

When the Trend Graph or X-Y Chart elements sample the 
data, the HMI turns the corresponding curve sampling status 
flag ON. When the sampling is completed, the curve sampling 
status flag is turned OFF. 

 
The sampling flag 1 of the Trend Graph element corresponds 
to the curve sampling status flag 1; the sampling flag 2 of the 
Trend Graph element corresponds to the curve sampling status 
flag 2, and so forth. 
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Curve Control Status Register 

b8~b11 – 
Curve clear 
status flags 

(1~4) 

When the Trend Graph or X-Y Chart elements clear the data, 
the HMI turns the corresponding curve clear status flag ON. 
When the clearing is completed, the curve clear status flag is 
turned OFF.  

 
The clear flag 1 of the Trend Graph element corresponds to the 
curve clear status flag 1; the clear flag 2 of the Trend Graph 
element corresponds to the curve clear flag 2, and so forth. 

 
 

The following table lists the flags of recipe control status register with their 

description. 
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Recipe Control Status Register 

 

(1) b0 Recipe change status flag 
(2) b1 Recipe read status flag (PLC  HMI) 
(3) b2 Recipe write status flag (HMI  PLC) 
(4) b3~b15 Reserved 

b0 – 
Recipe change 

status flag 

When the control recipe group in the control block is 
changed, the recipe group change status flag is turned ON; 
when the HMI changes the recipe group and completes 
updating the RCPNO number, the recipe group change status 
flag is turned OFF. 

 

b1 – 
Recipe read 
status flag 

When the HMI reads back one set of recipe data from the 
control block, the recipe read status flag is turned ON; when 
the HMI completes reading and saving the recipe from the 
control block, the recipe read status flag is turned OFF. 
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Recipe Control Status Register 

b2 – 
Recipe write 
status flag  

When the HMI sends one set of designated recipe data to the 
control block, the recipe write status flag is turned ON; when 
the HMI completes writing the recipe into the control block, the 
recipe write status flag is turned OFF. 

 
 

The following table lists the flags of recipe control status register with their 

description. 

Recipe Control Status Register 

 

b0~b15 – 
Recipe number 

designation 
status 

• Whether you change the value of the recipe designation 
register RCPNO by the control block or HMI, the recipe 
group control status register updates its value so that the 
control block finds the current recipe number from this 
register. 

• This recipe designation flag must work with the recipe 
change flag. 

 

The following table lists the flags of system control status register with their 

description. 
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System Control Status Register 

 

(1) b0~b7 Multi-language status value 
(2) b8 Printer status flag 
(3) b9 Printer form feed status flag 
(4) b10~b11 Retrieve Ethernet address status 
(5) b12 Wi-Fi retrieve network address status 
(6) b13~b15 Reserved 

b0~b7 – 
Multi-language 

status value  

Display the corresponding status value of the language in use. 

b8 – Printer 
status flag 

• Set to ON, the printer is printing the display screen or the 
edited screen of the HMI. 

• Set to OFF, the printer is idled. 

b9 – 
Printer form feed 

status flag 

• Set to ON, the printer is ejecting the paper and flipping the 
paper automatically. 

• Set to OFF, the printer is idled. 

b10~b12 – 
Retrieve network 
address status 

value 

Displays the status value of IP retrieve. When the Control 
Block is triggered to retrieve the network address, the status 
value is 1, and the status value is toggled to 0 after the 
address is obtained. 
• b10 is the LAN1 status. 
• b11 is the LAN2 status. 
• b12 is the Wi-Fi status. 

 

The following table lists the flags of enhanced recipe control status register with their 

description. 
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Enhanced Recipe Control Status Register 

 

(1) b0 Enhanced Recipe change status flag 
(2) b1 Enhanced passive read status flag (PLC  HMI) 
(3) b2 Enhanced Recipe write status flag (HMI  PLC) 
(4) b3 Enhanced Recipe group change status flag 
(5) b4~b7 Reserved 
(6) b8~b15 Designate the enhanced recipe group number to be changed. 

b0 – 
Enhanced Recipe 

change status 
flag 

When the control-enhanced recipe group in the control block 
is changed, the recipe group change status flag is turned ON; 
when the HMI group is changed and the RCPNO number is 
updated, the recipe group change status flag is turned OFF. 

 

b1 – 
Enhanced Recipe 
read status flag 

When the HMI reads one set of recipe data from the control 
block, the enhanced recipe read status flag is turned ON; 
when the reading and saving of the enhanced recipe via the 
control block is completed, the enhanced recipe read status 
flag is turned OFF. 
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Enhanced Recipe Control Status Register 

b2 – 
Enhanced Recipe 
write status flag 

When the HMI sends one set of designated enhanced recipe 
data to the control block, the recipe write status flag is turned 
ON; after the enhanced recipe is written into the control 
block, the enhanced recipe write status flag is turned OFF. 

 
 

The following table lists the flags of enhanced recipe control status register with their 

description. 

Enhanced Recipe Control Status Register 

 

b0~b15 – 
Enhanced Recipe 
designation status 

• Whether you change the value of the enhanced recipe 
group designation register ENRCPNO by the control 
block or HMI, the enhanced recipe group status register 
updates its value so that the control block finds the recipe 
group number from this register. 

• The enhanced recipe designation status flag must work 
with the enhanced recipe group change status flag. 

 

The following table lists the advanced level access control with their description. 
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Advanced Level Access Control 

b0~b3– 
Set User Level 

Use Bit 0, Bit 1, Bit 2 and Bit 3 to read the current user 
authority level of the HMI. 
The following table lists how to set security levels. 

Security 
Level 

Flag Control 
Bit 3 Bit 2 Bit 1 Bit 0 

0 0 0 0 0 
1 0 0 0 1 
2 0 0 1 0 
3 0 0 1 1 
4 0 1 0 0 
5 0 1 0 1 
6 0 1 1 0 
7 0 1 1 1 
8 1 0 0 0 
9 1 0 0 1 

 

b15 
Set User Highest 

Level 
Highest authority level access. 

Note: If Advanced Level Access is enabled, user level of General Control 
becomes invalid. 

 

Real Time Clock 

Controller has a built-in real-time clock (RTC), allowing you to synchronize the HMI 

RTC time to the controller or the controller RTC time to the HMI. Some controllers do 

not have a built-in real-time clock, so this function cannot be used in operations 

related to time setting, for example, turn on and off the machine regularly every day, 

manage the access control, and so on. 

Note: Some old Delta controller models (ES / SS / EC) do not support real time clock 

update. 
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 Enable RTC Updates 

Function Description 

Enable RTC Updates 

Select to enable real-time clock update. 
Note: If the Delta controller is selected, the Time Field 
Setting area is disabled, and the address will be set to the 
special registers D1319 ~ D1313 of the real time clock of 
Delta controller. 

 

 PLC Link Settings 

Function Description 

Link Name 
Select the link name, even if the selected controller is 
COM1, COM2, COM3 or Ethernet. 
The default is Link2. 

Station No. 
Set the station number of the controller for which you 
want to update the time. If the selected controller does not 
support station number setting, this setting is not available. 
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Function Description 

Update Select the RTC update mode. The default is PLC RTC 
time set to HMI. 

Trigger Mode 

Select the RTC trigger mode. The default is Timer. 
• If Timer is selected, you can set how often to perform 

automatic update. The range is 1 ~ 1440 minutes, and 
the default value is 60 minutes. 

• If Bit On is selected, when the Bit is ON, it triggers to 
update the settings. 

• If Bit Off is selected, when the Bit is OFF, it triggers to 
update the settings. 

Note: If Bit On or Bit Off is selected, the trigger address 
must be set. The trigger address can be the internal 
memory or the register address of the controller. 

 

 Time Field Setting 

Function Description 

Start Address 

Set the register address of the controller for RTC time 
synchronization. 
Note: If Delta controller is selected, setting the Start 
Address is not required. 

Length 

Select the length according to the number of time field to 
synchronize. The value range is 1–7, and the default value 
is 3. 
Note: If Delta controller is selected, setting Length is not 
required. 

 

 Sync time from PC 

Function Description 

Sync time from PC If selected, after downloading the project, the HMI time 
synchronizes with the PC. 

 

The following table lists the setting steps with examples. 
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Setting Step Example 

Real Time Clock 
Update 

1. On the toolbar, go to General > Device 
Communication, and then configure the 
communication setting in the Device Communication 
dialog. 

 
2. On the toolbar, go to General > Configuration. 
3. In the Real Time Clock setting page, select Enable 

RTC Updates checkbox. 
4. In the PLC Link Settings area, select Link3 

(Mitsubishi – FX3U / FX3GA) for Link Name. 
5. Select PLC RTC time set to HMI for Update. 
6. Select Bit On for Trigger Mode. Click  to set the 

trigger address to $11.0. 
7. In the Time Field Setting area, set {Link3}1@D8013 

for the start address and 6 for Length. 
8. In the address list, select Second for the Time Field 

corresponding to {Link3}1@D8013. Select Minute for 
the Time Field corresponding to {Link3}1@D8014. 
Select Hour for the Time Field corresponding to 
{Link3}1@D8015. Select Day for the Time Field 
corresponding to {Link3}1@D8016. Select Month for 
the Time Field corresponding to {Link3}1@D8017. 
Select Year for the Time Field corresponding to 
{Link3}1@D8018. 

 
9. Click OK. 
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Setting Step Example 

Create button to 
trigger the real time 

clock 

1. Create a Maintained Button element and set its Write 
Address to $11.0. 

2. Edit the State 0 text as RTC BIT OFF, State 1 text as 
RTC BIT ON. 

3. Set the Foreground Color as red, representing the 
state is triggered ON. 

 

Create Numeric Entry 
element 

1. Create 6 Numeric Entry elements, and set their 
addresses as {Link3}1@D8013 ~ {Link3}1@D8018 in 
order. 

 
2. Create 6 more Numeric Entry elements, and set their 

Internal parameter as TIME_YEAR, TIME_MONTH, 
TIME_DAY, TIME_HOUR, TIME_MINUTE, 
TIME_SECOND in order. 

 

Result 

After completing the creation of all elements, compile and 
download to the HMI. When the RTC Maintained Button 
(BITON) is triggered, the system will set the RTC time of 
the controller to the HMI. The HMI internal parameter 
TIME_YEAR, TIME_MONTH, TIME_DAY, TIME_HOUR, 
TIME_MINUTE, TIME_SECOND will be synchronized with 
the RTC of the controller. 
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Setting Step Example 

 
 

Print 
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 Standard 

Function Description 

Printer DOP-100 series models support Honeywell, HP, EPSON, 
ZEBRA, GoDEX, Micro Printer, PDF Writer, and ePrinter printers. 

Paper The paper size varies depending on the selected printer. The 
available options include A4, LETTER, CUSTOM, and so on. 

Quality 
Set the resolution of the printer. 
72 and 203 DPI can be selected according to the selected printers. 

 

 Margin 

Function Description 

Top / Bottom / 
Left / Right 

Set the margins of the paper as the reserved area during printing, 
which means that it is displayed as blank and not printed. 
The value range is 0–550, and the default value is 0. 

 

 Print Size 

Function Description 

Width / Height Set the width and height. This setting is available when Paper is 
set as CUSTOM. 

Ratio 
Set the ratio of the width and height. 
The value range is 10–400, and the default value is 100. 

 

 Interface 

Function Description 

Interface 

USB, Ethernet, and COM Port can be selected according to the 
selected printer. If you choose ePrinter to print, you need to fill in 
the IP address and printer port (the default value is 85) of the PC 
you are using. 

 

 Direction 

Function Description 

Direction Set the printing direction as vertical or horizontal. 
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Function Description 

Auto Flip 

The printer provides an automatic paper ejection function, 
helping you to flip the paper to print. 
• If selected, the printer will automatically flip the paper and 

continue printing after the paper printing is completed. 
• If not selected, the printer will forcibly eject the paper after the 

paper printing is completed and you need to flip the paper 
manually. 

 

Default 

 

Function Description 

Default Boot Screen 
Set the initial screen when the HMI is turned on. You can 
choose another screen to set as the initial screen. The 
default is 1-Screen_1. 

Default Data Format Set the default data format when creating an element. 
The default is Unsigned Decimal. 

Default Screen 
Background 

Set the default background color when editing the screen 
on the HMI. The default is . 
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Function Description 

System Error Display 
Time 

Set the time the message stays when an error message 
appears. The value range is 0–5, and the default value is 
3. 
Note: When it is set to 0, if there is any error in the 
system, no message appears on the HMI. 

System Key Mode 

Set the response the HMI should have when pressing the 
system key. The available options include Disabled, 
Enable the password check, and Uncheck Password. The 
default is Uncheck Password. 

Disabled If selected, pressing the system key cannot 
enter the system screen of the HMI. 

Enable 
password 

check 

If selected, after pressing the system key, 
the HMI asks you to enter the system key 
password. 

Uncheck 
Password 

If selected, after pressing the system key, 
you can enter the system screen of the HMI 
without entering the system key password. 

 

System Key Password 

Set the system key password. This is the password that 
the HMI asks you to enter when the System Key Mode is 
set to Enable Password Check. The default value is 
12345678. 

System Default Font Set the system default font. The default is Verdana. 

Use Fallback Font 

Currently, the DOP-100 series is to download the existing 
fonts to display on the HMI. When the operating system 
lacks fonts set in the elements, it makes the HMI unable to 
display the text normally after downloading, so the 
firmware loads a set of default fonts. 
• If Use Fallback Font is selected, when the firmware 

default fonts fail, the software enables the backup font. 
• If Top Priority is selected, the priority of the backup 

fonts of the software will be higher than the default 
fonts of the firmware. 

Faster HMI page 
changing 

If selected, when there are a lot of graphics and static text 
on the screen, the display speed can be speeded up when 
switching pages. 

Reduce font size If selected, when the project is downloaded to the HMI, 
only the fonts used in the project will be downloaded. 
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Element Default Value 

 

Function Description 

Element text 
automatically 

wraps 

• If selected, the element text automatically wraps as long as 
it encounters the boundaries. 

 
• If not selected, when the text encounters the boundaries, 

the text does not wrap, but it gets extended. 

 
Font color Set the font color. The default is . 

Default size of 
element scroll 

(if any) 

Set the default size of the element scroll. The value range is 
20–60 pixels, and the default value is 20 pixels. 
Note: This setting is applied to the elements with scrolls, such 
as historical data and alarm tables. 
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Function Description 

Element flashing 
interval time 

Set the interval time for element flashing. The range value is 
500–5000, and the default value is 1000. 
Note: This setting is available only when the Blink property of 
the element is set to Yes. 
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When changing 
the page, the 
element value 

update 
sequence 

Set the update order of the element value when the HMI 
changes the page. The default is Communicate first, then 
display the value. 
• Display the value first, then communicate: The value is 

read normally after switching the screen and is not affected 
by the communication. 

 
• Communication first, then display the value: The value 

display of the Numeric Entry elements pauses due to the 
switching of the screen. 
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Function Description 

The following table lists the elements that currently support this 
feature. 

Button element 

Set to ON 
Set to Off 
Momentary 
Maintained 
Set value 

Meter element Meter(1) ~ (4) 
Pipe Diagram 

element Pipe Diagram (1), Pipe Diagram (2) 

Indicator element 
Multistate Indicator 
Range Indicator 
Simple Indicator 

Data Display 
element 

Numerical Display 
Character Display 
General Message display 
Moving Sign 

Graphic Display 
element 

State Graphic 
Animated Graphic 

Input element 
Numeric Entry 

Character Entry 
Barcode Input 

Curve element Curve Input 
Analog element Slider 

 

Default fill style 

Set the default filled style of the HMI. The default is Gradient. 
The settings of this page are global. After Filled Style is set, 
the filled style of the elements created later will be based on the 
setting here. 



 

Configuration 
 

 

86 DIAScreen V1.6.0 

Function Description 

Font smoothing 

Set whether the text font of the HMI is smooth. If set to Yes, the 
text is rendered anti-aliased. 
If Apply to all elements is selected, it will be applied to all 
elements and pops up a message. Otherwise, it will be applied 
to the Static Text elements. 

 

Elements are 
automatically 

resized 
according to text 

• Don’t Apply: All elements are not automatically resized. 
• Apply to all: All elements in the project are automatically 

resized. 
• Apply to new: The added elements are automatically 

resized. 
 

Boot Logo 
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Function Description 

Enable 

If selected, you can choose the boot screen from the picture 
bank. You can also: 
• Go to Project > Download the Boot Screen to replace 

the HMI boot screen.  
• Go to Project > Download Screen to download the 

boot screen. 
When a GIF file is selected, the gray circle at the bottom left 

corner displays as , you can preview the GIF action on 
the software. 
Note: 

• To use files not in the picture bank, import the picture to 
the picture bank first. 

• After downloading the boot screen, power on the HMI 
again. 

• Supported image file formats are BMP, JPG, GIF, ICO, 
and PNG. 

• Only the boot screen after conversion by the software 
less than 3 Mbytes can be imported. 

 

Boot Delay Screen 
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Function Description 

Enable If selected, the boot delay time can be set. 

Boot Delay Time Set the boot delay time to wait for the controller to start. 
The value range is 0–255. 

Default screen 

If the Boot Delay Time is set to 3 seconds, and the system 
default boot delay screen is used, then after downloading to 
the HMI, the HMI screen appears after counting down from 
3 seconds to 0 seconds. 

 

Custom Screen Define the boot delay screen, and set the graphic display 
mode, background color, and whether to repeat. 

 

Network Settings 
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Function Description 

HMI 
Set the name of the HMI. When using network remote 
monitoring or data sampling, use the HMI name to quickly 
identify which HMI is being monitored or is accessing data. 

Upload/Download 
port 

Set the communication port. The default value is 12346 and is 
in the ON state. 
Note: There are a total of 65536 communication ports. Some 
specific communication ports are only used by specific 
programs. 

MODBUS TCP 
Server Port 

Set the communication port number. The default value is 502. 
Note: 
• This communication port must be the same as that of the 

MODBUS TCP/IP controller. 
• If the HMI communicates with the MODBUS application on 

the PC side, change the communication port here. 

Time Select the time of the HMI to display according to the local 
time zone. 

Enable NTP 

If selected, the time of HMI can be calibrated through the 
network. 
Note: You must first check whether the network of HMI is 
smooth. 

Server Name Select the server provided in the software, or enter the local 
NTP server name. 

Calibration when 
startup 

If selected, the time of HMI is calibrated when the HMI is turned 
on. 

Calibration at set 
intervals 

If selected, set the number of seconds. The calibration timing 
is when the HMI is turned on and enters the screen. 
The value range is 10–99999, and the default value is 180. 

Daylight saving 
time 

Select whether to enable the daylight-saving time. The default 
is off. 

Enable Lua Online 
Debugging  

If selected, you can set breakpoints in the Program page to 
perform the Online debug function. 

Enable eComm 
Port 

If selected, you can enable the HMI forward function to forward 
data to the terminal device through the HMI, and then establish the 
forward tunnel through eComm of the COMMGR software. 

Enable One Wire 
Service 

If selected, you can open the QIP function and scan the devices 
connected to the HMI communication port through the COMMGR 
software. 
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Remote Desktop and Data Collection 

The following table lists the settings in the Remote Desktop and Real-time 
Monitoring tabs with their description. 

Remote Desktop 

 

 eServer 

Function Description 

Enable Select to enable the eServer function. 

Password 

Set the password to monitor or access data according to your 
needs. The default value is 12345678. 
• To comply with CyberSecurity specifications, the password 

must be set up to 8 characters and contain an uppercase 
letter, a lowercase letter, a number, and a symbol (!, $, #, 
%). 

• This is the password that must be entered to obtain the HMI 
project data and execute eServer and eRemote. 

Sampling time Set how often eServer and eRemote take to perform sampling. 
The range value is 100–5000, and the default value is 100. 
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Function Description 

Port 

Set the connection ports of eServer and eRemote. The default 
value is 12348. 
Note: The upload / download communication ports of the HMI 
are different from this communication port. The communication 
ports are different according to different programs. 

Show warning 
when 

disconnected 

This option is available only when Show warning when 
disconnected checkbox is selected. 
When the HMI is disconnected from the eServer or eRemote, 
the HMI displays a disconnection warning message. 

Close warning 
window when 
the connection 

is restored 

This option can only be enabled when Show warning when 
disconnected is checked. 
• If selected, an error message keeps popping up on the HMI 

until the connection between the HMI and the eServer or 
eRemote is restored. 

• If not selected, an error message only pops up once on the 
HMI. 

 

 VNC 

Virtual Network Computing (VNC) function is an application that can remotely 

monitor and operate the HMI. This application can transmit keyboard and mouse 

actions and real-time screens through the network. When operating VNC using web 

pages, the browser must support JAVA installation, otherwise it cannot be opened.  

Function Description 

Enable If selected, you can remotely monitor to operate the HMI 
through VNC. 

Password 

Set the connection password according to your needs. The 
default value is 12345678. To comply with CyberSecurity 
specifications, the password must be set up to 8 characters 
and contain an uppercase letter, a lowercase letter, a number, 
and a symbol (!, $, #, %). 

Multiple 
connection mode 

Select to allow multiple HMIs to be connected. Up to 64 HMIs 
can be connected. 

Monitor mode If selected, you can only monitor the HMI when VNC is 
connecting remotely. 

Port 

Set the connection port. The default value is 5900. 
VNC Viewer provides web page operation mode. In this mode, 
you only need to enter the IP Address of the HMI into the 
browser and set the port as 5800 (even if the communication 
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Function Description 
port is not set as default value 5900) to connect, such as 
http://192.168.123.148:5800. 
Note: 
• The connection port must be changed to 5902 when using 

VNC Viewer to connect. 
• Do not use 5800 when setting the connection port on the 

software side. If it is set to 5800, after downloading the 
screen to the HMI, it asks you to change the port. 

 

Network Use Select the port to open the VNC function. It applies to the HMI 
models with two Ethernet ports. 

 

Real-time Monitoring 

The real-time monitoring function allows you to write the value to the HMI on the web 

page, or monitor the change of the value by the web page after the HMI writes the 

value. The data formats supported by the monitoring address include BCD, Signed 

Decimal, Unsigned Decimal, Hexadecimal, Floating, and Char. You can set the 

reading length for each data format to decide whether to read Word or Double Word. 

When the number of reading is 1, the integer number of digits can be set up to 5, 

which means that the reading is Word; when the number of readings is 2, the integer 

number of digits can be set up to 10, which means that the reading is Double Word. 

Address input provides Word and Bit, which can support internal memory address 

and external controller address. 

How to use network real-time monitoring? 

1. In the Real-time Monitoring tab, select Enable real-time monitoring checkbox 

and set the address. 

2. Enter http: //[HMI IP]/RemoteMon/ on the browser. 

Note: The two characters R and M must be capital letters. 
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3. After the connection is successful, the login screen appears. Enter the password 

of the web application to log in. 

 

The following table lists the settings in the Real-time Monitoring tab with their 

description. 

 

Function Description 

Enable real-time 
monitoring 

If selected, the real-time monitoring settings are available. 

 

Click to add monitoring address. 
You can enter the name and address. The name can be 
entered up to 30 characters. 

 

Select the items you want to delete, and then click this icon to 
delete the monitoring address. 
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Function Description 

 

Click to import a CSV file. 

 

Click to export the monitoring address content to a CSV file. 

Password 

Set the password that must be entered when entering the 
connection address using the web page. The default value is 
12345678. To comply with CyberSecurity specifications, the 
password must be set up to 8 characters and contain an 
uppercase letter, a lowercase letter, a number, and a symbol 
(!, $, #, %). 

Items per Page 
Set the number of monitoring addresses to be displayed on 
one page. 
The value range is 1–20, and the default value is 10. 

Update  
Set how often the screen updates after updating the value. 
The value range is 1–30, and the default value is 30. 

 

SMTP 

SMTP (Simple Mail Transfer Protocol) is used to transmitting email and define the 

rules for sending email from a source address to a destination address to control 

how email is relayed. This function allows you to obtain the alarm message when an 

alarm occurs by receiving the email. 

Note: Before using the SMTP function, set up a Mail Server environment or search 

for a free Mail Server on the Internet. 

The following table lists the settings in the SMTP setting page with their description. 
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Function Description 

Enable Mail Host If selected, the mail host settings are available. 

Server Address 

Set the server address. This IP address is the Mail Server IP 
created by users. 
Note: Before using the SMTP function, set up a Mail Server 
environment or search for a free Mail Server on the Internet. 

Server Port Set the server port. This is the general SMTP communication 
port. The default value is 25 

Sender Address Set the sender's email address. 

SSL Encrypted 
Transmission 

SSL (Secure Socket Layer) is an encryption-based Internet 
security protocol, which ensures the confidentiality and 
integrity of communication between two applications, as well 
as verifying the identity of the server. 
To use Gmail to send email, do the following: 
1. After logging into your Gmail account, click Manage your 

Google Account. 
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Function Description 

 
2. On the left navigation panel, select Security. 
3. Enable 2-Step Verification function under How you sign 

in to Google. For the detailed operation method, please 
see Sign in with app passwords. 
After the above setting is completed, you can use Gmail to 
receive alarm emails. 

Note: The e-mail must support SSL function. 

Enable Security 
Authentication 

If selected, the account and password can be set. 
If the SMTP server is set up with an account and password to 
verify the identity, this option must be selected. 

Account 

If the security authentication checkbox that requires an 
account and password is selected when setting up the SMTP 
Mail Server, first enter the account and password. This 
account and password are used to check whether the recipient 
is a legitimate user of the back-end mail system to prevent 
uncollected emails from occupying the system resources to 
cause hidden mail security problems. 
Note: 
• The account and password must be set according to the 

requirements of the SMTP server. 
• The account format varies depending on the format of 

each SMTP Mail Server. You can look up the related rules 
of MIS. 

Password 

Time Select the local time zone so the time to send the alarm email 
will be more accurate. 

Contact 
Management 

Set the contact address for the mail information of the alarm. 
Follow the steps to set the contact address and its mail 
information. 

1. In the Contact list area, click  to add new contact. 

2. On the toolbar, click  to set the group name in the 
Group settings dialog. 

https://support.google.com/accounts/answer/185833?hl=en&ref_topic=7189145&sjid=918317101642660033-AP
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Function Description 

3. In All contacts area, choose the contact and click  to 
add it to the Group contact. You can also click  to 
remove the contact from the Group contact. 

4. In the Contact Management dialog, choose the group 
name in the Address book, the contact in the group lists 
in the Contact list. 

 
5. Set the mail recipient in the Mail field of the Alarm 

Settings page. The contacts or groups can be selected as 
Recipient. 
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After the SMTP settings are completed and downloaded to the HMI, go to System 
Menu > System Setting > Network App > SMTP to access the settings. You can 

also change the SMTP settings on the HMI and then upload the settings to 

DIAScreen. 

 

 

FTP 

FTP (File transfer protocol) is a standard communication protocol that is used for 

downloading alarms, historical data, recipes, and operation logs in a USB or SD card 

through the network to the PC for viewing. You can also upload files from your PC to 

a USB or SD card. 

The following table lists the rules of FTP with their description. 

FTP Rule Description 

Supported HMI Network-based HMI 

Network-based HMI 
File transfer application 
Windows File Explorer 
DOS Command Line 

Connection Limit 
Up to 3 FTP Clients can be connected at the same time 
Automatically disconnect when idle for more than 90 
seconds 
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FTP Rule Description 

Login method 

Anonymous 
login 

Adding of directories is not allowed. 
Uploading of files is not allowed. 
Downloading of files is not allowed. 
Deletion of files is not allowed. 
Change of filename is allowed. 

Account login 

Adding of directories is allowed. 
Uploading of files is allowed. 
Downloading of files is allowed. 
Deletion of files is allowed. 
Change of filename is allowed. 

File transfer rules 

Unlimited traffic 
Support resume 
Unlimited size of the file to be sent. 
The maximum length of file name is 260 bytes. 
Change of filename is allowed. 
Support Chinese filename. 
Encryption is not supported. 
Support active / passive mode connection. 
When FTP is transferring, you can enter and exit the 
system menu. 

 

The FTP Server supports connection through file transfer applications, Windows File 

Explorer, and DOS Command Line. 

• File transfer applications 

Upload / download files through file transfer applications. 

Note: The FTP Server provided by HMI needs to be used with FTP Client 

application. 

The following figure is an example using the file transfer application FileZilla, 

which is free and can be downloaded from filezilla-project.org/download.php. 
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The following table lists the functions in the FileZilla application with their 

description. 

Legend Function Description 

 Host Set the HMI IP address, the example is 
192.168.123.114. 

 Username Set the username as admin. 

 Password Set the password as 1234. 

 Port Set the port as 21. 

 Quick connect 
Click to quickly connect to the FTP Server. 
Note: Before executing this function, complete 
the above settings. 

 

• Windows File Explorer 

Upload / download files by connecting to the FTP Server through Windows File 

Explorer. 

1. Open the file manager and enter ftp://192.168.1.7/ in the input box for the file 

path. 

2. Enter the account and password to log in to FTP. 

After logging in, all files in the USB will be displayed. 
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• DOS Command Line 

Upload / download the files by connecting to the FTP Server through DOS 

Command Line. 

1. Open the command prompt and enter ftp 192.168.123.114. 

2. Enter users account admin and password 1234. 
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According to the FTP command, use help to view the supported related 

commands. 

 

Enter the dir command to list all files currently in the USB. 

 

To download files from a USB or SD Card, use the get command. If you want 

to upload files from PC to USB or SD Card, use the put command. 

 
The following table lists the functions of the FTP Host tab with their description. 
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FTP Host 

 

Function Description 

Enable FTP host 
function 

If selected, the FTP settings are available. 

FTP Host Port Set the FTP host port. The default value is 21. 
Account Set the account name. 

Password 

Set the password. 
To comply with CyberSecurity specifications, the password 
must be set up to 8 characters and contain an uppercase 
letter, a lowercase letter, a number, and a symbol (!, $, #, %). 

Root Directory 
Select the storage location of HMI files. The available options 
include USB Disk, USB Disk 2, SD, and HMI. The default is 
USB Disk. 

Anonymous 

If selected, you can log in to FTP without entering an account 
and password. 
Note: After using an anonymous connection to log into FTP, 
you cannot upload / download files, delete files or add new 
directories. 
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After the FTP settings are completed and loaded into the HMI, go to System Menu > 

System Setting > Network App > FTP Server to access the settings. You can also 

change the FTP settings on the HMI and then upload the settings to DIAScreen. 

 

 

FTP File Setting 

FTP file transfer provides functions such as account login / logout, file upload / 

download, file deletion, file management / rename, directory (folder) management, 

etc. File transfer can be carried out through DOP series HMI and FTP Server. 

Note: FTP file transfer should be used with the FTP File List element. 
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Function Description 

Enable FTP 
file transfer 

function 

Check to enable FTP Client function. 

Host Login 

IP addr. Set the FTP Server IP address to which 
to connect. 

Port addr. Set the FTP Server connection port to 
which to connect. 

Login trigger addr. The input value type is Bit. When this bit 
is turned On, it will be logged in. 

Logout trigger addr. The input value type is Bit. When this bit 
is turned On, the system will log out. 

Login account addr. Set the starting address of the account. 
The maximum length supports 16 
words. Max. length of account 

Login password addr. Set the starting address of the 
password. The maximum length 
supports 16 words. 

Max. length of 
password 

Change 
working DIR / 

File 

Change working DIR 
trigger addr. 

When this bit is On, the working 
directory is changed and automatically 
cleared after completion. 
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Function Description 

Example 
1. Set the string content of Working DIR name addr. ($500) to 

/lua. 

 
2. Set Change working DIR trigger addr. ($200.0) to On. 

 
3. The FTP File List element will be switched to the lua 

directory. If the directory does not exist, the operating state 
($1000) becomes 0x0022. 

 
4. Once Change working DIR trigger addr. ($200.0) operation 

is completed, it will be automatically cleared to Off. 

Check 
duplicate 
DIR/File 

Check duplicated 
DIR/File trigger addr. 

When this bit is On, the duplicated 
directory / file is checked and 
automatically cleared after completion. 

Example 
1. Set the string content of Change/Create/Check name addr. 

($750) to lua. 
 

2. Set Check duplicated DIR/File trigger addr. ($200.1) to On. 
 

3. If the Lua folder already exists, the content of Check 
duplicate DIR/File result ($900) becomes 1; otherwise, it 
becomes 0. 

 
4. Once Check duplicated DIR/File trigger addr. ($200.1) 

operation is completed, it will be automatically cleared to Off. 

Create DIR / 
Change DIR / 
Delete DIR / 

File 

Create DIR trigger 
addr. 

When this bit is On, a new directory is 
created and automatically cleared after 
completion. 

Example 
1. Set the string content of Change/Create/Check name addr. 

($750) to TestHMI. 
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Function Description 
2. Set Create DIR trigger addr. ($200.2) to On. 

 
3. Add the TestHMI folder in the FTP Server and update the 

FTP File List element. If the TestHMI folder already exists, 
Operating state ($1000) changes to 0x0042. 

 
4. Once Create DIR trigger addr. ($200.2) operation is 

completed, it will be automatically cleared to Off. 

Change DIR/File 
trigger addr. 

When this bit is On, the directory / file 
name is changed and automatically 
cleared after completion. 

Example 
1. Use the FTP File List element to select the directory TestHMI 

to be changed. 
2. Set the string content of Change/Create/Check name addr. 

($750) to ChangeHMI. 
 

3. Set Change DIR/File trigger addr. ($200.3) to On. 
 

4. Change the name of the TestHMI folder to ChangeHMI, and 
the HMI updates the FTP File List elements at the same 
time. If the ChangeHMI folder already exists, the Operating 
state ($1000) changes to 0x0052. 

 
5. Once Change DIR/File trigger addr. ($200.3) operation is 

completed, it will be automatically cleared to Off. 
Note: This example operates on a directory. You can also use the 
trigger address to operate on files. 

Delete DIR/File trigger 
addr. 

When this bit is On, the directory / file 
name is deleted and automatically 
cleared after completion. 

Example 
1. Set the string content of Selected DIR/File name addr. 

($700) to ChangeHMI. 
 

2. Set Delete DIR/File trigger addr. ($200.4) to On. 
 

3. Delete the ChangeHMI folder of the FTP Server, and the HMI 
updates the FTP File List element at the same time. 

4. Once Delete DIR/File trigger addr. ($200.4) operation is 
completed, it will be automatically cleared to Off. 
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Function Description 
Note: This example operates on a directory. You can also use the 
trigger address to operate on files. 

Get DIR / 
Filename 

Get DIR/File name 
trigger addr. 

When this bit is On, the directory / file 
name is obtained and automatically 
cleared after completion. 

Example 
The following figure shows the FTP File List. 

 
1. Set Index of DIR/File name addr. ($921) to 2. 

 
If the index value is set to 0, the Operating state ($1000) 
becomes 0x0027. 

 
2. Set Get DIR/File name trigger addr. ($200.5) to On. 

 
3. Get the folder name with FTP Server index value 2, Get 

DIR/File name result ($770) content is lua. 
 

Note: 
• This example operates on directory lines. You can also use 

this trigger address to operate on files. 
• The index value is based on the FTP Server. The sorting 

displayed in the FTP File List of the HMI may not be the same 
as the sorting of the FTP Server. 

Download DIR 
/ File 

Download directory/file 
trigger address 

When this bit is On, the HMI starts 
downloading files from the FTP Server 
and automatically clear them after 
completion. 

To use this function, first set up the FileSlot file function. In the 
menu bar, click Project > Other Settings > FileSlot 
Management to make related settings. 
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Function Description 

 
Example 
1. If the FTP Server file is stored in /lua/0001_project, switch to 

the /lua directory and select the 0001_project directory. 

 

 
2. Set Download DIR/File trigger addr. ($200.6) to On. 
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Function Description 
3. The HMI downloads the file from the FTP Server to the 

Selected FileSlot addr. ($920). If the directory contains 
multiple files, the Selected FileSlot addr. ($920) represents 
the starting FileSlot position. 

 
After the action is completed, the Number of downloads 
($910) becomes 6. 

 
4. After the file download is completed, the file will only be 

stored in the FileSlot address. To edit the downloaded file, 
you need to use the Text List element. To read out the file 
name of a downloaded file, use the FileSlotGetName macro 
command. 

Note: 
• This example operates on a directory, you can also use the 

trigger address to operate on files. 
• If the name of the downloaded file is known, the HMI can 

obtain the location information (ID) of the file stored in FileSlot 
through the FileSlotGetID macro command. 

FileSlot 
Operations 

FileSlot operate saving 
trigger addr. 

When this bit is On, the selected 
FileSlot file will be uploaded to the FTP 
Server and automatically cleared after 
completion. 

To use this function, you need to set up the FileSlot file function 
and execute the download directory/file function. 
Example 
1. Set Selected FileSlot addr. ($920) to 4. 

 
2. Set FileSlot operate saving trigger addr. ($200.7) to On. 

 
3. The HMI uploads the file (main.lua) with FileSlotID 4 to the 

FTP Server. 

FileSlot operate rename 
trigger addr. 

When this bit is On, the selected 
FileSlot file is renamed and uploaded to 
the FTP Serverm and automatically 
cleared after completion. 

To use this function, first set up the FileSlot file function and 
execute the download directory/file function. 
Example 
1. Set Selected FileSlot addr. ($920) to 4. 
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Function Description 
2. Set Change/Create/Check name addr. ($750) to 

main_new.lua. 
 

3. Set FileSlot operate rename trigger addr. ($200.8) to On. 
 

4. The HMI changes the name of the main.lua file to 
main_new.lua, and simultaneously rename the FileSlot and 
updates the FTP File List. 

 

FileSlot operate delete 
trigger addr. 

When this bit is On, the selected 
FileSlot file is deleted from the FTP 
Server and automatically cleared after 
completion. 

To use this function, you need to set up the FileSlot file function 
and execute the download directory/file function. 
Example 
1. Set Selected FileSlot addr. ($920) to 1. 

 
2. Set FileSlot operate delete trigger addr. ($200.9) to On. 

 
3. The HMI deletes the file LPT.bin on the FTP Server and 

updates the FTP File List simultaneously. 

FileSlot 
Operations 

FileSlot operate save 
as trigger addr. 

When this bit is On, the selected 
FileSlot file is saved in the FTP Server 
and automatically cleared after 
completion. 

To use this function, set up the FileSlot file function and execute 
the download directory / file function. 
Example 
1. Set Selected FileSlot addr. ($920) to 3. 

 
2. Set string content of the Change/Create/Check name addr. 

($750) to configNEW.ini. 
 

3. Set FileSlot operate save as trigger addr. ($200.10) to On. 
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Function Description 
4. The HMI adds a new file configNEW.ini on the FTP Server 

and updates the FTP file list simultaneously. 

 

FileSlot operate new 
trigger addr. 

When this bit is On, the selected 
FileSlot file is added to the FTP Server 
and automatically cleared after 
completion. 

To use this function, set up the FileSlot file function first. 
Example 
1. Set Selected FileSlot addr. ($920) to 10. 

 
2. Set Change/Create/Check name addr. ($750) to xyz.txt. 

 
3. Set FileSlot operate new trigger addr. ($200.11) to On. 

 
4. The HMI adds a file xyz.txt with a file size of 0 on the FTP 

Server, and updates the FTP File List simultaneously. 

 

Operation 
directory/name 

address 
setting 

Working DIR name 
addr. 

Set the working directory name and Max. 
Length Of Name. 
Note: It should be used with Change 
working DIR trigger addr. Refer to the 
example operation of Change working 
DIR trigger addr. 

Max. Length Of Name 

Selected DIR/File 
name addr. 

Set the directory or file to be deleted and 
the maximum length. 
Note: It should be used with Delete 
DIR/File trigger addr. Refer to the 
example operation of Delete DIR/File 
trigger addr. 

Max. Length Of Name 
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Function Description 

Change/Create/Check 
name addr. 

Set the directory or file to be changed / 
created / checked and the maximum 
length. 
Note: It should be used with Check 
duplicated DIR/File trigger addr. or 
Create DIR trigger addr. Refer to the 
example operations for Check 
duplicated DIR/File trigger addr. or 
Create DIR trigger addr. 

Max. Length Of Name 

Selected FileSlot 
addr. 

Enter data type as Word and set the 
selected FileSlot. 
Note: It should be used with Download 
DIR/File trigger addr. Refer to the 
example operation of Download 
DIR/File trigger addr. 

Index of DIR/File 
name addr. 

Enter data type as Word and set Index 
of DIR/File name addr. 
Note: It should be used with Get 
DIR/File name trigger addr. Refer to the 
example operation of Get DIR/File name 
trigger addr. 

Execution 
result setting 

Operating state 

When the actions in the FTP transfer 
settings are completed, the operating 
state changes accordingly. If the 
operation is successful, 0 is displayed; 
otherwise, an error code is displayed. 

Check duplicated 
DIR/File result 

Returns the result of Check duplicated 
DIR/File trigger addr. 

Number of downloads 
Returns the number of downloaded files. 
Note: It should be used with Download 
DIR/File trigger addr. 

Get DIR/File name 
addr. 

Returns the result of Get DIR/File name 
trigger addr. 

 

The following table lists the FTP Client’s return values with description. 

Return Value 
Description 

Decimal Hexadecimal 

0 0 Completed successfully 
20 32 Login failed 
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Return Value 
Description 

Decimal Hexadecimal 

21 33 Logout failed 
22 34 Failed to switch working directory 
23 35 Check for duplicate directory / file names failed 
24 36 Unable to obtain directory / file information 
25 37 Connection abnormality 
26 38 Insufficient system memory space 
27 39 Failed to query directory / file name 
40 64 Failed to create directory / file  
41 65 Unable to create file 
42 66 Unable to create directory 
50 80 Failed to rename directory / file 
51 81 File cannot be renamed 
52 82 Directory cannot be renamed 
60 96 Failed to delete directory / file 
61 97 Unable to delete file 
62 98 Unable to delete directory 
70 112 Fail to download directory / file 
71 113 Unable to download file 
72 114 Unable to download directory 
73 115 FIleSlot Insufficient storage space 
80 128 Fail to save FIleSlot 
81 129 Unable to save FileSlot 
82 130 Unable to save as FileSlot 
A1 161 Unable to create FileSlot 
A2 162 Unable to rename FileSlot 
A3 163 Unable to delete FileSlot 
A4 164 Unable to open FileSlot 
A5 165 Unable to copy FileSlot 
A6 166 Unable to obtain FileSlot ID 
A7 167 Unrecognized FileSlot ID 
A8 168 Unable to obtain FileSlot name 
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Return Value 
Description 

Decimal Hexadecimal 

A9 169 Unable to set FileSlot name 

AA 170 Unable to obtain the maximum number of FileSlots 
allowed 

AB 171 Unable to add FileSlot, the maximum number of 
FileSlots allowed has been exceeded. 

AC 172 Unable to obtain FileSlot space limit ed size 
AD 173 FileSlot name duplicate 

 

MAC Settings 

In the MAC Settings page, set the MAC of the HMI to be loaded when creating 

screen data file, the file only can update the screen on the specified HMI. If the MAC 

is not set, the HMI model is not restricted. You can obtain the MAC from System 
Menu > System Setting > Network on the HMI. 

 

The following table lists the functions in the MAC Settings page with their 

description. 
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Function Description 

 Click to add the MAC. 

 Click to delete the MAC. 
 

Multi-language 

The following table lists the functions in the Multi-language settings tab with their 

description. 

Multi-language settings 
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Function Description 

 Click to add a language. It supports adding up to 32 languages. 

 

Select the item to be deleted and click the icon to delete, a warning 
message appears and asks whether to proceed. 

 
Language 

Name 
Set the language name according to your needs. 
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Function Description 

Detail 

Detail column switches the language according to its value. To 
switch the language, you can: 
• Switch the language to the corresponding settings through the 

System Control in the Control Block page.

 
• Click General on the toolbar and select the language to be 

switched in the Language field of the State/Language pane. 

Enable 
The first row is the default language, the Enable checkbox cannot 
be unselected, or a warning message displays, informing that the 
language cannot be disabled. 

Default Font 
Style 

Apply the font name and font size according to the selected 
language. 
• If you only choose to apply the Font Name or Font Size, the 

font setting only applies to the newly created elements. 
• If you choose both Font Name and Font Size to apply, the font 

setting applies to the existing and newly created elements. 
Note: The font name and font size settings are applied to the 
elements that you can enter the text. 

 

System Language Settings 

System languages include 6 languages, which can be applied to the system menu of 

the HMI and the pop-up message when operating the HMI. 
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Industry Application 

 

Function Description 

Enable electronic 
record 

If selected, the electronic record settings are available. 
Note: If enabled, Advanced Level Access Control of Control 
and Status Block becomes invalid. 

Operation record 

The Operation record function records all operations of the 
HMI, including numerical changes and user level. 
Checksum and Operation Log data will be added to the 
operation record file. 
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Function Description 

 

Alarm record 

If selected, the HMI alarm data will be recorded, and the 
Export CSV File field in the Alarm Settings page will be 
forced to be set to Yes. 
To cope with electronic signatures, the file name of the 
exported alarm data file will be created according to the year, 
month, day, hour, minute and second. Checksum data will be 
added. 

 

 
Note: The timing of generating this file is based on the 
maximum number of records set by the alarm. 

History sampling 
record 

If selected, the HMI historical data will be recorded. In the 
Buffer Properties dialog of the History Buffer setting page, 
• Non-volatile will be forced to be set to HMI, SD, USB Disk 

or USB Disk 2 (based on the setting of Data storage), 
• Export CSV File checkbox will be forced to be selected, 
• The file storage method will also be forced to be set to 

Save As Multiple Files. 
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Function Description 

 
The historical data of Save As Multiple Files will be stored 
according to year, month, day, hour, minute, and second. 
Checksum and HISTORY data will be added. 
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Function Description 

Comm. error 
record 

If selected, the HMI will automatically store the communication 
error data in the HMI, USB, or SD card, and the storage 
location is HMI\HMI-000\CommEventLog. Checksum and 
Communication data will be added to the communication error 
record file. 

 

 

Data storage 

Select the storage location of all stored data in electronic 
records. The available options include HMI, USB Disk, USB 
Disk 2, and SD. 
The default value is HMI. 

 

The electronic record function mainly ensures that the data are consistent and 

accurately generated and saved, and can be viewed at any time, which is different 

from the daily records. Therefore, the generated record data will be added with a 

checksum mechanism and exported to a CSV file. 



 

Configuration 
 

 

123 DIAScreen V1.6.0 

Enable the Enable electronic record function will also enable the Second 
confirmation of account function for the Confirmation Window in the element 

dialog. 

 

If the account is set to Second confirmation of account, you will be asked to enter 

the password twice. 

 

 
The files generated by the electronic signature can be opened by Excel or the 

electronic record viewing tool eRecordViewer. The file storage location is 
C:\Program Files (x86)\Delta Industrial 

Automation\DIAStudio\DIAScreen 1.6\Utility\eRecordViewer. 

If the loaded data has not been tampered with, eRecordViewer will prompt “Verified 

OK”. 
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If the data has been tampered with, for example, eRecordViewer detects that the 

Checksum of the data in the 8th column of the file does not match, it will display 

“Verified fail records: {1}”. The number in the braces is the total number of error 

data. 

 

You can also save the electronic records as PDF files through eRecordViewer and 

print them.
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Device Communication 
The Device Communication function is used for configuring the related setting of 

communication between the HMI and devices, including COM Port, Ethernet, and 

other interfaces. 

This section describes the parameter settings for each communication interface. 

 

COM Port 

The following table lists the functions in the COM Port setting page with the 

description. 

 

 Connection 

• The settings of COM Port are only available when Connection is selected. 
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• You can customize the Link Name and select the device to connect. 

• If Connection is unselected, DIAScreen detects whether the current connection 

is being used. If so, a warning message appears, and the Address List dialog 

displays. In the Address List dialog, you can choose to change the address to 

another connection or Clear Address. 

 

 Communication Parameters 

Function Description 

HMI 
Station 

Select or enter the HMI station ID. The range value is 1–255 and the 
default value is 0. 

Interface 

Select the communication interface (transmission method). The 
available options are RS232, RS422, and RS485. 
For COM1, only RS232 can be selected; for COM2 and COM3, 
RS232, RS422, and RS485 can be selected. 

 COM1 COM2 COM3 

RS232 V V V 

RS422 - V V 

RS485 - V V 
 

Data Bits Select the length of the received data packet. 
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Function Description 

Stop Bits Select the stop bits that inform the receiver of the end of the data 
signal.  

Baud Rate Select the data transmission speed. 

Parity Bits Select the parity bits. It is used to check for errors in the transmitted 
data. The available options are None, Odd, Even, Mark, and Space. 

For other parameter settings, see Common Properties.  
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Ethernet Port 

The following table lists the functions in the Ethernet Port setting page with the 

description. 

 

Device 

 Device 

• Click  to add a link device named EtherLink1. The Link Name EtherLink1 

can be changed according to your need. 

• Up to 16 links are supported for each controller, and up to 4 types of controllers 

are supported for one network port. 
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 Communication Parameters 

Function Description 

HMI Station Select or enter the HMI station ID. The range value is 1–255 and the 
default value is 0. 

Controller IP 
Set the IP address of controller. 
Note: The controller IP address must be set in the same network 
segment as the HMI IP address. 

COM Port 
Select or enter the communication port. You can also set it 
corresponding to the controller’s port. 
Note: The COM Port varies depending on the selected controller. 

For the descriptions of the Main tab, see Common Properties. 
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Localhost 

 

Function Description 

Overwrite IP 

• If selected, the network IP address of the HMI is written 
according to the screen file settings when DIAScreen 
downloads the project or updates the screen file. 

• If not selected, the network IP address does not change due 
to project download and screen file updates. Go to System 
Menu > System Setting > Network on the HMI to change its 
IP address. 

Obtain an IP 
address 

automatically 

• This setting is only available when Overwrite IP is selected. 
• If Obtain an IP address automatically is selected, the HMI 

uses the DHCP mode to get the IP address. 

HMI IP 
address 

Set the IP address of the HMI. If Obtain an IP address 
automatically is not selected, the fixed IP address can be set. 
Note: The HMI IP address must be set in the same network 
segment as the controller IP address. 
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Function Description 

Subnet Mask 

Set the subnet mask. The subnet mask is used to segment the 
network and identify the destination address. It has the same 
format as the IP address, which is represented by four bytes 
separated by decimal points. 

IP Class Network Address Subnet Mask 

Class A 1.x.x.x~126.x.x.x 255.0.0.0 
Class B 128.0.x.x~191.255.x.x 255.255.0.0 
Class C 192.0.0.x~223.255.255.x 255.255.255.0 

Subnet Mask must be set when the IP address is set on each 
computer. For Class C in the table above, the first 3 bytes of the 
IP address are Network ID. Therefore, the first 3 bytes of the 
Subnet Mask are all 255. The last byte is the Host ID, which is 0. 

 

Device 

Set the connection parameters between HMI and external devices. 
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 Device list 

• A USB device has been added by default and cannot be deleted. 

• Click  to add a COM Port device. When all COM Ports are occupied, new 

devices cannot be added. 

Note: The device name is defaulted as Barcode scanner and cannot be changed. 

 Detail 

Note: For the reading setting of the external devices, see the content of Internal 
Parameter > Input Device in the Address Settings. 

 

Common Properties 

Controller Settings 

Function Description 

PLC Station 
PLC Station is the default station ID generated automatically 
after selecting the controller and can be changed. The range 
value is 0–255. 

Password 
Enter the password. If the set PLC requires a password check, 
you must set the corresponding password for communication in 
the software. The default value is 12345678. 

Function Description 

Device 
interface 

• The default interface is USB. 
• After adding a device, select an unoccupied COM Port. 

Communication 
Parameter 

• This setting is only available when using a COM Port device. 
• This setting is the same as that of COM Port. 

Read length Select or enter the string length (not including the terminator) for 
reading data. The range value is 10–1024. 

Terminator 

Choose the terminator. The available options are None (No 
Terminator), CR/LF, STX, ETX, STX/ETX, and Other. 
Note: Other is custom hexadecimal encoding, and the range 
value is 0X00~0XFF. 

Timeout Enter the time interval between scanning and reading the first 
character and the terminator. The range value is 0.1–30.0. 
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Function Description 

Comm. Delay 
Time 

Select or enter the time interval between each communication. The 
range value is 0–255 and the default value is 0. 

Connection 
Timeout 

Select or enter the connection timeout that HMI communicates 
with the device. The range value is 10–2000 and the default 
value is 1000. 

Connect 
Retries 

Select or enter the retries. If the controller fails to respond to the 
communication, the HMI sends the communication command 
again. If reaching the set number of retries, the HMI displays a 
warning message of abnormal communication. The range value 
is 0–15 and the default value is 2. 

Optimize 

• If selected, the process of reading the address of all 
elements referring to this link gets optimized to facilitate 
communication. 

• If unselected, the speed for reading the elements becomes 
slow. 

For COMMGR 
Communication 

Simulation 

Select the simulator driver configured in COMMGR to communicate 
with COMMGR simulator through the Off-line Simulation function. 
Note: Download and install COMMGR in DIAInstaller. 

 

Disconnect after communication interrupt 

• If Disconnect after communication interrupt is selected, Connect Retries 

can be set. When the communication is interrupted and the set Connect 
Retries is reached, the HMI will no longer connect with the controller. The range 

value of Connect Retries is 0–255 and the default value is 3. 

• When the communication between the HMI and controller stops due to reaching 

the Connect Retries, use Bit 0 in the Control Block to enable / disable the 

communication to restore the connection. 
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Custom Confirmation Window Screen 
DIAScreen supports the Confirmation Window Screen function. You can customize 

the confirmation window according to your needs. 

Follow the steps to customize the confirmation window. 

1. Do one of the following: 

• On the toolbar, click General > New Screen > Confirmation Window 
Screen. 

• Right-click the blank space of the Screen Management Window and select 

New Screen, select Confirmation Window Screen for Screen Type. 

 

The confirmation window screen is created. 

2. Create a Goto Screen element and double-click the element. 

3. In the property window of the element, select Custom for Confirmation 
Window in the Operating conds. tab. 

After downloading the screen to the HMI, the custom Confirm Window displays 

when you click the element on the HMI. 
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User Login Screen 
This section describes different types of user login screen which includes 

Login/Logout Screen, Add/Delete User Account Screen, and Change Password 
Screen. 

 

Login/Logout Screen 

You can use this screen to log in / log out the user account. 

To log in / log out the user account 

1. Create a Login/Logout Screen. Do one of the following: 

• On the toolbar, click General > New Screen > User Login Screen > 

Login/Logout Screen. 

• Right-click the blank space on the Screen Management Window and select 

New Screen, and then select Login/Logout Screen for Screen Type. 

2. Trigger the Login/Logout Screen. You can: 

• Set the User Security Level in the User Security Level tab of the element 

property dialog and click  to select the created Login/Logout Screen. 

• In the Security Level and Password setting page of the Configuration 

dialog, set the security level and the Login/Logout Screen to be triggered by 

this level. 
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If User Security Level of the element is set as 2 and Custom User Login 
Screen is set as None, the Screen2 login screen is triggered after pressing the 

element on the HMI. 
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Note: 

• The Configuration setting is Global setting, and the Element setting is Local 

setting. When different login screens are triggered if they have the same 

level, the login screen set in the element will take priority. 

 

 



 

User Login Screen 
 

 

139 DIAScreen V1.6.0 

• Since the highest security does not require an account setup, if the Security 
Login checkbox is selected, the User Account and User Account Status 

are disabled and not available for selection. 

 

 

Add/Delete User Account Screen 

You can use this screen to quickly add / delete the user account. 

To add / delete the user account 

1. Create an Add/Delete User Account Screen. Do one of the following: 

• On the toolbar, click General > New Screen > User Login Screen > 
Add/Delete User Account Screen. 

• Right-click the blank space on the Screen Management Window and select 

New Screen, and then select Login/Logout Screen for Screen Type. 

2. Create a Goto Screen element on the screen. 

3. In the element property dialog, set Add/Delete User Account Screen for Goto 
Screen in the Main tab. 

4. After downloading the screen to the HMI, press the Goto Screen element on 

the HMI, and then log in the security level account. 
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5. Enter the User Account, User Password, and User Level, and then you can: 

• Press Add to add the account. 

The user account is successfully added. 

 

Note: Only the accounts below the login level can be added. If accounts of 

the same level are added, the Add Status displays Fail. 
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• Press Delete to delete the account. 

The user account is successfully deleted. 

 

 

Change Password Screen 

You can use this screen to change the user password. 

To change the user password 
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1. Create a Change Password Screen. Do one of the following: 

• On the toolbar, click General > New Screen > User Login Screen > Change 
Password Screen. 

• Right-click the blank space on the Screen Management Window and select 

New Screen, and the select Change Password Screen for Screen Type. 

2. Create a Goto Screen element on the screen. 

3. In the element property dialog, set Add/Delete User Account Screen for Goto 
Screen in the Main tab. 

4. After dowloading the screen to the HMI, press the Goto Screen element on the 

HMI, and then log in the security level account. 

 

5. Select the User Account and enter the new password, and then press Change 
Password. 

Note: Only the passwords for accounts below or equal to the login level can be 

changed. 
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Compile 
DIAScreen provides the compiling function for convenient operation and use. 

 

Compile 

If only one screen among several screens is edited, you can use the Compile 

function to compile only that screen to save compilation time. 

 

How to use the Compile function? 

• Click Project > Compile on the menu bar. 

Or 

• Press Ctrl + F7. 

 

Compile All 

Use the Compile All function to compile all screens. If an error occurs during 

compilation, an error messages will be displayed in the Output pane to remind 

users. Click the message to link to the element with the error. 
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Download All Data 

Use the Download All Data function to download the screen data and recipe to the 

HMI. 

How to use the Download All Data function? 

• Click Project > Download All on the menu bar. 

Or 

• Press Ctrl + F8. 

When downloading all data, the software will detect the connection between the HMI 

and the computer. If the transmission interface between the HMI and the computer is 

not turned on, an error message will appear. The following table lists the check items 

with their description. 

Check Item Description 

USB Tunnel 

USB is turned on incorrectly. 
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Check Item Description 

During the download process, the transmission line is unplugged, 
or the communication is interrupted. 

 

Model Setting 

The HMI model is set incorrectly. 

 

Note: Perform the DIAScreen uploading and downloading on an authorized HMI. 

 

Download Screen 

The Download Screen function downloads only screen data. Refer to Download All 

Data for the download method. 

How to use the Download Screen function? 

• Click Project > Download All on the menu bar. 

Or 

• Press Ctrl + F9. 

 

Upload All Data 

When uploading all data, the software asks you to enter a password. The password 

entered here is the system default password 12345678. To set a password, go to 
General > Configuration > Security Level and Password. 



 

Compile 
 

 

147 DIAScreen V1.6.0 

 

After entering the password, save the screen file to upload. 
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After saving the file, the screen data starts to upload. You can click Stop to stop 

uploading the screen data. 

 

Besides uploading screen data, you can also go to General > Environment to set 

whether to include picture data. 
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On-line Simulation 

Use the On-line Simulation function to simulate the computer as an HMI and 

communicate with the controller through the computer’s COM port. If the 

communication is normal, the computer can be used as an HMI for actual operation. 

 

How to use the On-line Simulation function? 

• Click Project > On-line Simulation. 

Or 

• Press Ctrl + F4。 

When performing an online simulation, the software will first compile and check 

whether the screen for errors. Then set the COM port number of the compute. The 

HMI will communicate with the controller if the setting is correct. 
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In the COM Port Setting dialog, if the Ask me every time checkbox is selected, this 

dialog displays every time you perform an online simulation. If unselected, the dialog 

will not display. You can right-click the blank space on the online mode screen and 

select COM Setting to open this dialog again. 

 

Online simulation also provides a monitoring function. Right-click the blank space on 

the screen and select Monitor IO. After setting the monitoring address, you can 

monitor the content value of the IO device. 

The following table lists the setting in the IO Monitor dialog with their description. 
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Setting Description 

New item Click to add the address to monitor in the Input dialog. 

New blank Click to add a new item row, and you can directly enter the monitor 
address in the Device Addr. field. 

Delete item Click to delete the selected monitor address. 
Start Monitor Click to start monitoring the device. 
Stop Monitor Click to stop monitoring the device. 
Device Addr. Set the internal memory or controller register address. 

Device Value 

Enter the content value of the internal address or controller 
register. You can also change the content value of the device in 
real-time. 
Note: The Length setting is not required if you are using a Delta 
controller. 

Value Format Select the value format. 
 

The following describes the operation example of Monitor IO. 

1. Create 2 Numeric Entry elements on the screen, and then set the Write 
Address to $500 and {Link2}2@D100 respectively. 

2. Click Project > On-line Simulation on the menu bar. 

3. On the online simulation screen, right-click the bank space and select Monitor 
IO. 

4. Click New Item to add a monitor address in the IO Monitor dialog. 

5. Set the monitor address to {Link2}2@D100 in the Input dialog. 

 

6. Repeat steps 1~2 to set another monitor address to $500. 
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7. Click Start Monitor to start monitoring the values of {Link2}2@D100 and $500 

in the Device Value field. You can also manually change device values. 

 

 

Off-line Simulation 

Use the Off-line Simulation function to check whether the edited screen, the read 

and write memory address, and the Marco are correct. No communication with the 

controller is required. 

How to use the Off-line Simulation function? 

• Click Project > On-line Simulation. 

Or 

• Press Ctrl + F5. 

When performing an offline simulation, the software will first compile the screen and 

then enter the offline mode screen. 
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Language Management 
Language Management provides Import / Export Multi-language Text and Copy 
Multi-language Text functions, allowing you to quickly edit multi-language text in 

the project with multiple languages and states. 

 

Multi-language Configuration 

Follow these steps to configure multi-language. 

To configure multi-language 

1. In the Project pane, double-click Multi-language. 

2. In the Multi-language setting page, click  to add a language. 

3. Configure languages according to your needs. 

In the Text tab in the property dialog of the element, you can view the language 

configuration of each state. 
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Export Multi-language Text 

With the Export Multi-language Text function, you can export the element that 

multiple-language can be configured in the project as a file and edit. 

Follow these steps to export multi-language text. 

To export multi-language text 

1. Create an element on the screen and configure its multi-language. 

2. Click Project > Language Management > Export Multi-language Text on the 

toolbar. 

The multi-language content of all elements in the current project is exported as a 

file. 

 

 

Export Multi-language Text (excluding element font 
settings) 

With the Export Multi-language Text (excluding element font settings) function, 

the file size can be reduced when exporting / importing multiple-language text. The 

exported file only contains element description and multi-language content. 
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Follow these steps to export multi-language text excluding element font settings. 

To export multi-language text excluding element font settings 

1. Create an element on the screen and configure its multi-language. 

2. Click Project > Language Management > Export Multi-language Text 
(excluding element font settings) on the toolbar. 

The multi-language content (excluding font settings) for all elements in the 

current project is exported. 

 

 

Import Multi-language Text 

After importing the multi-language text file, check whether the edited data has been 

imported completely. 

To import multi-language text file 

• Click Project > Language Management > Import Multi-language Text on the 

toolbar. 

The following table lists the state before import and after import. 

State Chinese English 

Before 
Import 

 
 

After 
Import 
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Copy Multi-Language Font 

The Copy Multi-Language Font function helps you quickly apply the font settings of 

the existing language to the imported language. 

Follow these steps to copy multi-language font. 

To copy multi-language font 

1. In the Project pane, double-click Multi-language. 

2. In the Multi-language setting page, click  to add a language. 

 

3. Edit the screen in the first language and click Project > Language 
Management > Export Multi-language Text on the toolbar to export the 

language settings as an Excel file. 

4. Edit the text content of each language in the Excel file and save, 

5. Click Project > Language Management > Import Multi-language Text on the 

toolbar to update the edited content to the project. 

6. Click Project > Language Management > Copy Multi-Language Font on the 

toolbar. 

7. In the Copy Language Font Setting dialog, select the Source Language and 

Target Language, and then click OK. 

The font settings of the source language are applied to the target language. 

Note: 

• If there is only one language in the project, the Copy Multi-Language Font 
function is not available. 
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• If a text bank is applied in the element, the font settings will not be applied to the 

element after executing the Copy Multi-Language Font function. 

The following table lists the execution result. 

State Result 

Before 
Executio

n 

 

After 
Executio

n 
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Font Template 
DIAScreen provides a wide range of fonts. To save users' time in selecting fonts, 

DIAScreen provides font templates to help users to customize frequently used font 

settings that improve the efficiency of screen design. 

Follow the steps to set the font templates. 

To set the font templates 

1. On the toolbar, click General > Font > Import font template . 

2. In the Font Template dialog, click  to add a new font template in Font 
Template List, and set the font, size, style, and color in Font Template 
Settings.  

3. Click Change to save the font template. 

4. Create an element and double-click it. 

5. In the property dialog of the element, click Import Font Template in the Text 
tab. 

6. In the Font Template dialog, select the desired font template, and then click 

Import Template (all settings) or Only Import Font and Size according to 

your needs. 

The font settings are imported to the text of the selected status. 

Note: Font template settings are stored in the computer with DIAScreen installed. 

The same set of font template settings can be used when opening different projects 

on the same computer. 

 

The following table lists the settings in the Font Template dialog and their 

descriptions. 
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 Font Template List 

Setting Description 

 
Click to add the font template. 
You can configure up to 100 templates. 

 Select the template and click this icon to delete. 

 Click to import the font template. 

 

Click to export the template as a .xlsx file. The following displays 
the format content of the font template. 

 

 Click to clear all font templates. 

 

 Font Template Settings 

Setting Description 
Description Set the description of the font template. 

Text Bitmap / Font Choose to display a text in bitmap or font. 
Font setting Set the font, size, style, and color of a text. 

Preview Preview the effect of font template settings. 
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MODBUS TCP/COM Mapping Table 

Delta HMI can be used as a Modbus Slave for external Modbus Server devices to 

transmit data. Modbus communication supports TCP/IP and Serial Port connections. 

You can configure the HMI address to the corresponding Modbus address through 

Modbus TCP/COM mapping table function. 

How to open Modbus TCP/COM mapping table? 

• On the toolbar, click Project > Other Settings > Modbus TCP/COM mapping 
table. 

The following table lists the Modbus range limitation of TCP/IP and COM connection. 

Connection Data Type Maximum 
Length Modbus Range 

TCP/IP 
Coils 65536 00001(0x0000) ~ 65536(0xFFFF) 

Registers 65536 00001(0x0000) ~ 65536(0xFFFF) 

COM 
Coils 2048 00001(0x0000) ~ 02048(0x07FF) 

Registers 20000 40001(0xA410) ~ 60000(0xEA5F) 
 

The following describes the setting methods of Modbus Slave (TCP/IP) and Modbus 

Slave (COM). 

• Modbus Slave (TCP/IP) 

HMI with Ethernet ports will have the Modbus Slave function enabled by default. 

You can configure the Modbus address corresponding to the HMI address 

through the Modbus TCP/COM mapping table. 

Example Settings 

1. In the Modbus TCP/COM mapping table, configure the mapping table. 

• Set the HMI address to $4000.0, corresponding to the Modbus address of 

Coils function code 0x00000. 

• Set the HMI address to $5000, corresponding to the Modbus address of 

Registers function code 0x00000. 
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2. Create elements on the screen and set the HMI address corresponding to 

Modbus, and then download the project to the HMI. 

The Modbus Master device is connected with TCP/IP and set connected HMI 

IP. Change values of elements on the HMI, and the HMI transmits data 

through Modbus. 

 

The following figure shows the result that Modbus Poll is used as the Modbus 

Master and communicated with the HMI. 

 

• Modbus Slave (COM) 

Follow the steps to set the Modbus Slave (COM) mapping. 

1. In the Communication Settings dialog, select COM2. 
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2. Select Modbus for Manufacturers and RTU (Slave) for Series to perform 

the Modus communication of Serial Port. 

3. In the Modbus TCP/COM mapping table, click Modbus Slave (COM) to 

configure the corresponding relationship between the HMI address and 

Modbus address. 

Example Settings 

 

1. In the Modbus TCP/COM mapping table, configure the mapping table. 

• Set the HMI address to $2000.0, corresponding to the Modbus address of 

Coils function code 00001. 

• Set the HMI address to $0, corresponding to the Modbus address of 

Registers function code 40001. 

2. Create elements on the screen and set the HMI address corresponding to 

Modbus, and then download the project to the HMI. 

The Modbus Master device is connected through the Serial Port. Change 

values of elements on the HMI, and the HMI transmits data through Modbus. 

The following figure shows the result that Modbus Poll is used as the Modbus 

Master and communicated with the HMI. 
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EIP Data Exchange Table 
The HMI supports Ethernet / IP connection. You can import EDS (Electronic 

Datasheet) files or manually enter CIP parameters to establish connection data, and 

configure the data exchange between the HMI internal memory and network devices 

through the data exchange table. 

Note: 

• Only available for DOP-300 series HMI. 

• A maximum of 6 data exchange tables are supported and the same device 

supports up to 4 data exchange tables. 

How to open the EIP Data Exchange Table configuration page? 

• In the Project pane, double-click the EIP Data Exchange Table. 

The following table lists the settings on the toolbar in the EIP Data Exchange Table 

configuration page and their descriptions. 

Setting Description 

 

Import the EDS file of the connected device and set the connection 
parameters. 

 
Manually add an EIP device. Establish a device for connection by 
entering CIP parameters. 

 
After adding an EIP device, click this icon to add a data exchange 
table. 

 
After selecting one row of the data exchange table, click this icon to 
edit the connection parameters. 

 
After selecting one row of the data exchange table, click this icon to 
copy the selected row. 

 
After selecting one row of the data exchange table, click this icon to 
delete the selected row. 

 Click to delete all data exchange tables. 

 

Click to open the Device List dialog. In the Device List dialog, 
select the newly added or imported EIP devices to delete.  
Note: When a device is deleted, its corresponding data exchange 
table is also deleted. 
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The following table lists each field setting in the EIP Data Exchange Table 

configuration page and their descriptions. 

 

Setting Description 
No. Displays the line numbers of the data exchange table. 

Enable Select to enable the data exchange of the row. If not selected, 
the data exchange configuration will not be loaded to the HMI. 

Device Name 
Select the name of the connected device. 
This name is defined in an EDS file or when you manually add 
an EIP device. 

IP Address 
Displays the IP address of the connected device. It can be 
configured in the Connection Setup dialog. 
Note: The same IP cannot be set for different devices. 

Internal Memory 
Set the internal memory address of the HMI for data exchange. 
Note: The read / write addresses of the same data exchange 
table cannot be the same. 

HMI Read / 
Write 

Displays the read / write mark for the HMI. 

Size (Bytes) Displays the size of data exchange. It can be configured in the 
Connection Setup dialog. 

 

The following table lists the settings in the Connection Setup dialog of the device 

imported through EDS and their descriptions. 



 

EIP Data Exchange Table 
 

 

167 DIAScreen V1.6.0 

 

 Connection settings 

Setting Description 

Connection Name 
Select the name of the connected device for data exchange. 
Note: When the same IP address is set for the same 
device, the same connection name cannot be selected. 

IP Address Enter the IP address of the device. 

Port Enter the device port. The range value is 1–65525, and the 
default value is 44818. 

 

 General Parameters 

Setting Description 

Connection Path Displays the connection path. 
Trigger Type Select the trigger type of the connection. 

Transport Type This setting is available only when you manually add an 
EIP. 

RPI (ms) Enter the RPI of the connection. The range value is 5–1000, 
and the default value is 20.  

Timeout Select a timeout for the connection. The default value is 4. 
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 HMI Read / Write 

Setting Description 

Load Size Enter the read size. The range value is 0–200 (bytes), and 
the default value is 200 (bytes). 

Write Size Enter the write size. The range value is 0–200 (bytes), and 
the default value is 200 (bytes). 

Tar Configuration 
Size 

The setting is not available. 

Configuration Setup 

Click Setup to configure the connection data of the target 
device. In the Data Configuration dialog, set the data 
parameters in the Value field. 

 
Connection Type The setting is not available. 

Connection Priority The setting is not available. 
Transform Type The setting is not available. 

 

 Electronic Key 

Setting Description 

Enable 
Select the items to match. 
Note: The parameter setting of the electronic key is available 
when you select the Enable checkbox in the Enable field. 

 

The following table lists the settings in the Connection Setup dialog by manually 

establishing an EIP device and their descriptions. 
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 Connection settings 

Setting Description 

Device Name Enter the name of the device. 
IP Address Enter the IP address of the device. 

Port Enter the device port. The range value is 1–65525, and 
the default value is 44818. 

 

 Path Setup 

Setting Description 

Auto Gen Path Enter the CIP parameters, and the Connection Path will be 
automatically generated according to the set parameters. 

User Define Path Define the Connection Path in the General Parameter 
area. 
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 General Parameter 

Setting Description 

Connection Path This setting is available only when the User Define Path 
is selected. 

Trigger Type Select the trigger type of the connection. 
Transportation Type Select the transportation type of the connection. 

RPI (ms) Enter the RPI of the connection. The range value is 1–
10000, and the default value is 10. 

Timeout Select a timeout for the connection. The default value is 4. 
 

 HMI Read / Write 

Setting Description 

Load Size Enter the read size. The range value is 0–200 (bytes), and 
the default value is 200 (bytes). 

Write Size Enter the write size. The range value is 0–200 (bytes), and 
the default value is 200 (bytes). 

Tar Configuration 
Size 

Enter the size of the target configuration. The range value 
is 0–400 (bytes), and the default value is 16 (bytes). 

Configuration Setup 
Click Setup to configure the connection data of the target 
device. In the Data Configuration dialog, set the data 
parameters in the Value field. 

Connection Type Select the connection type. 
Connection Priority Select a connection priority. 
Transportation Type Select the transportation format. 

 

 Electronic Key 

Setting Description 

Enable 
Select the items to match and enter the parameters. 
Note: The parameter setting of the electronic key is available 
when the Enable is selected in the Enable field. 
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Installment 
The installment function allows customers to configure the device in stages by 

paying in installments to solve trial use and funding issues. A trial is also provided for 

customers. When the trial expires, it will lock the HMI screen to prevent further use. 

Note: 

• If external memory addresses, such as controller addresses, are used for the 

installment settings, it is important to ensure that the device is communicating 

properly and functioning correctly to avoid errors occurring when executing the 

installment function. 

• The installment function does not support online simulation and offline simulation. 

Follow these steps to set the installment. 

To set the installment 

1. Click Project > Other Setting > Installment on the toolbar. 

2. Set the installment in the Installment dialog. 

The following table lists the settings in the Installment dialog with the descriptions. 
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 Settings 

Settings Description 

Customized 
Unlock Screen 

If selected, the existing sub-screen is available for you to 
select which can be used as the unlock screen. You can also 

click  to add the example unlock screen. 

Password Input 
Address 

Set the password input address. 
Corresponding to the address set for the Character Entry 
element on the unlock screen. 

Installment Name 
Address 

Set the installment name address. 
• Character Display element can be configured on the 

screen to show the name of the current unlocked 
installment. 

• Corresponding to the address set for the Character 
Display elements on the unlock screen. 

Installment 
Expiration Time 

Set the installment expiration time address. 
• Date Display, Time Display, and Weekday Display 

elements can be configured on the screen to show the 
time of the next installment. 

• Corresponding to the address set for the Date Display, 
Time Display, and Weekday Display elements on the 
unlock screen. 

Unlock Trigger 
Address 

Set the unlock trigger address. 
Corresponding to the unlock button configured on the unlock 
screen. 

 

 Customer List 

Settings Description 

 

Click to add new customer. Up to 10 customers can be added 
and the names must not be the same. 
Select the customer number, the customer installment 
information will be applied when downloading the project. 

 After selecting the customer number, click this icon to delete. 
 

 Installment Settings 
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Settings Description 

Administrator 
Password 

Set the administrator password. Enter this password on the 
HMI to unlock all installments. 

Enable 
installment time 

reminder 

If selected, you can configure the number of days to set 
expiration reminders. The range value is 0–15 and the default 
value is 1. 

Password mode 

Select the password mode. 
• Select Use static password, the software will use a fixed 

password for each installment. 
• Select Use variable password, you can set an internal 

memory address and customize the Password Length, 
making it easy to set the password through macros or 
LUA. 

Installment HMI 
change trigger 

Set the HMI change trigger address to change the installment 
content on the HMI. 
• Trigger this address on the HMI and enter the installment 

setting manager password in the pop-up Password 
dialog. 

 
• Displays the Installment Settings dialog. Add / delete the 

installment setting in this dialog. 
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Settings Description 

 

Click to add a new installment, up to 32 installments can be 
added. 
Note: 
• The installment name can only be entered in English. 
• The installment password supports the characters 09, !, $, 

#, %, a~z, and A~Z. 
• For the same customer, the installment password cannot 

be the same (including the administrator password). 

 Click to delete the selected installment(s). 

Language The installment name can be set to different languages with 
the Multi-language function. 

 

Keep Installment Data when Downloading 

With this function, the installment information will not be updated after downloading 

the screen and the installment unlock record on the HMI will not be cleared. 

1. On the toolbar, click General > Configuration. 

2. In the Configuration dialog, select General > System Setting, and then select 

Keep Installment payment settings after screen download checkbox. 

 

Enable Next Installment 

To unlock the installment before the set installment time arrives, click Element > 

Button > Enable Next Installment, on the toolbar and create the Enable Next 
Installment button to cancel the current installment settings. 

 

The Remaining Time for the Current Installment 

Follow these steps to set the remaining time for the current installment. 

To set the remaining time for the current installment 

1. Add a Character Display element on the screen. 

2. Set the Read Address to “NEXT_INST_REMAIN_TIME” of Internal Parameter. 



 

Installment 
 

 

175 DIAScreen V1.6.0 

The HMI displays the remaining time until the next payment. 

 

The following figure shows the effect of displaying the remaining time for the current 

installment by the HMI. 

 

Note: The String Length of the Character Display element must be set to at least 

23 characters to display the time completely. 

 

Installment Lock Status 

DIAScreen provides the Internal Parameter “INST_LOCK_STATUS” to facilitate you 

in identifying the installment status. Status 0 indicates that the installment is 

unlocked, while Status 1 indicates the installment is waiting to be unlocked. Once 

you have locked an installment, you can unlock it again. 

 



 

Installment 
 

 

176 DIAScreen V1.6.0 

How to unlock installment? 

1. When the installment time is up or pressing the Enable Next Installment button 

on the HMI screen. 

The Unlock Installments screen displays. 

 

Note: The unlocking installment screen must be configured with a Drop-down 
menu element, and select Installment Period for Project Data Source, so that 

when unlocking the installment, you can select the installment to perform 

unlocking. 

2. In the Unlock Installments screen, choose the period to be unlocked, and then 

enter the password of the period. 

3. After entering the password, click the Unlock button. 

• If the password is entered correctly, a message displays and prompts you that 

the unlock is successfully. 
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• If the password is entered incorrectly, a message displays and prompts you 

that the unlock is failed. 

 

 

System Time Setting Restriction 

When the Installment function is enabled, the related functions of system time 

setting will be disabled, including LUA instructions, macros, NTP, system 

parameters, etc to prevent the device time setting from tampering during installment, 

causing the installment to fail to execute as scheduled. If system time calibration is 

required, you can use a project without installment settings or perform a factory 

reset, and then download the project with installment settings. 

Note: If there is an abnormality with the device battery, the system time may be 

restored to the default value of 1970/01/01, and the HMI will be locked and cannot 

be used. 

 

Project Protection 

The Installment function involves the financial transactions, the projects must be 

well-protected and set the protection mechanism, such as Check password when 
downloading program, Screen upload prohibited. Project files, download 

executables, auto update data files, etc. must not be easily provided to outsiders. 

Go to General > Configuration > Security Level and Password to set the protection 

mechanism. 
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Element 
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Button 
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Template Output 

Alarm records, operational records, recipe data and data history records can be 

exported as PDF files and stored in external storage devices through the Template 
Output element. 

Follow these steps to set the template screen. 

To set the template screen 

1. Create a template screen. Do one of the following: 

• In the menu bar, click General > New Screen > Template Screen. 

• Right-click the blank space on the Screen Management Window and select 

New Screen. Select Template Screen for Screen Type and click OK. 

2. In the template screen, you can customize the content displayed at the header 

and footer of the page. The blank space between two red dotted lines is the 

content of the report. 

 

3. In the Screen property setting dialog, set the display style of the page number 

in the Template setting area. 

4. Create a Template Output element on the screen. 

5. In the Template Output property dialog, select the Report Device. 
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The following table lists the settings in the Template setting dialog with their 

descriptions. 

 

 Report (separate) 

After creating report output of each type, PDF files will be generated respectively. 

Setting Description 
Select template Select the template you want to apply. 

File name 
address 

Set the profile name address. If not set, the report file gets 
exported with the default file name. 
Note: The report file storage path is \HMI\HMI-
000\@HMI0000. 

 
String length Select or enter the string length for the file name. 

File date 
Select the date display format for the file. You can also set it to 
None to not to export the file date. 
Note: This setting is only available for historical reports. 
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Setting Description 

File time 
Select the time display format for the file. You can also set it to 
None to not to export the file time. 
Note: This setting is only available for historical reports. 

 

 

 Reports (Batch) 

After customizing the display order of each type of report and exporting the reports, 

they will be consolidated as a single PDF file. 

Setting Description 
Select 

template Select the template to apply. 

File name 
address 

Set the file name address. If not set, the report file will be output 
with the default file name. 
Note: The default report file storage path is \HMI\HMI-
000\@HMI0000\batch.pdf. 
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Setting Description 

String length Select or enter the string length for the file name. 

Sort 

Sort 
(Fixed) 

Select the output type of report and click   to 
sort the order in which the report is displayed. 

Dynamic 
sorting 
(HMI) 

Select to sort the display order of reports on the HMI 
screen. 

 

Time 

All time Select to output reports of all recorded data. 

Interval 
setting 
(HMI) 

Select to specify the time interval for the output data 
on the HMI screen. 

 



 

Report List 
 

 

185 DIAScreen V1.6.0 

Report List 

The alarm data can be exported as CSV file and stored in external devices through 

the Report List element. 

Follow these steps to set the report list. 

To set the report list 

1. Create an alarm. 

2. In the Alarm settings page, select the storage location of non-volatile, and then 

select Yes for Export CSV File. 

3. Configure the CSV Field Setting. In the CSV Field Setting dialog, configure the 

content and order of the field to display. 

 

4. Create a Report List element on the screen. 

5. Click the element on the HMI, then export the alarm information as a CSV file 

and store it to the set report device. 

Note: The report file storage path is \HMI\HMI-000\@HMI0000\ 

HistoryOp\CSV.



 

Bar 
 

 

186 DIAScreen V1.6.0 

Bar 

• Normal 

The Normal Bar element displays the values corresponding to the read 

addresses in the form of a bar from the minimum value to the maximum value 

on the HMI. You can also set the colors for the lower limit, upper limit, and target 

values to identify them. 

 

 

• Differential 

The Differential Bar element displays the deviation between the value of the 

Read Address and the set target value on the HMI. 

 

The bar element of DIAScreen provides memory addresses with customizable target 

values and lower and upper limit values, making the application more flexible and 

meeting users’ requirements.  
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Common Properties 

• Main 

 Memory 

Select the Internal Memory or the controller register address. The Input 
memory Type must be Word. 

Detail 

 Data Type: The available options are Word and Double Word. 

 Data Format: The available options are BCD, Signed BCD, Signed 

Decimal, Unsigned Decimal, and Hexadecimal. 

 Minimum / Maximum: Enter the valid range value according to the set 

Data Type and Data Format. 

 Variable minimum / maximum limits: If selected, you can define the 

minimum and maximum value through the corresponding value of the 

memory address. 

• Style 
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Legend Setting Description 

 Style 

Select the appearance of the element. The 
available options are Standard, Raised, and 
Sunken. The default value is Standard. 

 Standard Raised Sunken 

Normal Bar 
  

 

Differential 
Bar  

  

 

 

Foreground 
Color / 

Background 
Color / Border 

Color 

Select the foreground color, background color, 
and border color of the element. 

 

 Filled style 

Select the filled style of the element. 
Note: Since the default style of DOP-100 series 
models is Gradient, if the DOP-B project is 
opened, the elements are displayed in Fixed, and 
the effect is similar to that of DOP-B. 

Gradient 

 

Fixed 

 

 

 Transparency 

Select or enter the transparency value of the 
element. The range value is 50—255 and the 
default value is 255. 
The lower the value is, the higher the 
transparency is. 

 
Smooth 

animation 

Select whether to enable the Smooth animation 
function. 
When this function is enabled, the element 
display becomes smoother. 

 

• Style – Scale Settings 
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Setting Description 

Scale Display 
Position 

Select the position to display scale on the element 
according to Direction. 
• Scale can be displayed on the top or bottom when 

Direction is Left or Right. 
• Scale can be displayed on the left or right when 

Direction is Top or Bottom. 

Scale Settings Set the mark number, color, width of the scale. The range 
value of Scale Mark Number is 1–99. 

Text Setting Select the Display mark checkbox to display the mark 
and set the text size and color. 

 

Normal Bar Properties 

• Main 

 Detail 
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Setting Description 

Target 

Select and enter the target value. You can also specify 
the display color. 
If the Variable target / range limits checkbox is not 
selected, enter only a constant value. 

Range 
Select and enter the Low Limit and High Limit. If the 
Variable target / range limits checkbox is not 
selected, enter only a constant value. 

Variable target / 
range limits 

If selected, set the memory addresses to dynamically 
change the displaying target value, and the low and 
high limit values. 

 

 Style 

 Numeric Display 

 

The available options are No display, Value, and Percentage. The default 

value is No display. If you select Value or Percentage, you can set the 

display style and alignment type. 
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Differential Bar Properties 

• Main 

 Detail 

 

Select and enter the Deviation. You can also set the display color for 

deviation values within the range. If the Variable target / range limits 

checkbox is not selected, enter only a constant value to define the deviation 

value of the Differential Bar element. 
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Pie 

The Pie element displays the values corresponding to the read addresses in different 

pie styles on the HMI. You can also set the colors for the lower limit, upper limit, and 

target values to identify them. 

 

 

 

Common Properties 
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Legend Function Description 

 Memory Select the Internal Memory or the controller register 
address. The Input memory Type must be Word. 

 Data Settings 

• Data Type: The available options are Word and 
Double Word. 

• Data Format: The available options are BCD, 
Signed BCD, Signed Decimal, Unsigned Decimal, 
and Hexadecimal. 

• Minimum / Maximum: Enter the valid range 
value according to the set Data Type and Data 
Format. 

• Variable minimum / maximum limits: If 
selected, you can define the minimum and 
maximum value through the corresponding value 
of the memory address. 

 Target 

Select and enter the target value. You can also 
specify the display color. 
If the Variable target / range limits checkbox is not 
selected, enter only a constant value. 

 Range 
Select and enter the Low Limit and High Limit. If 
the Variable target / range limits checkbox is not 
selected, enter only a constant value. 

 
Variable target / 

range limits 

If selected, set the memory addresses to dynamically 
change the displaying target value, and the low and 
high limit values. 

 Interval display 

Select or enter the interval display value. The range 
value is 0—100. 
To have an effect, the value displayed in the interval 
needs to be divided by the difference between the 
maximum value and the minimum value. For 
example, if the minimum value is 0, the maximum 
value is 100, the interval display value is 20, no scale 
is displayed when the value is 0~19; the scale is 20 
when the value is 20~39; the scale is 40 when the 
value is 40~59, and so on. 

 

• Style 
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Legend Function Description 

 

Border Color 
Foreground 

Color 
Background 

Color 

Select the foreground color, background color, and 
border color of the element. 

 

 

Low Range 
Color 

High Range 
Color 

Select the element’s low and high range color to 
display on the HMI. 

 Style 

Select the appearance of the element. The available 
options are Standard, Raised, Sunken, and 
Transparent. The default value is Standard. 

Standard Raised Sunken Transparent 

  
  

 

 
Display the 

colors of 
each 

• If select No, no matter what the value is, only the 
Foreground Color will be displayed. 

• If select Yes, with the Low Range Color and 
Range functions, it can represent different colors 
of each stage. 
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Legend Function Description 

 

 
The following is an example of setting Display the 
colors of each for Pie(1) element. 

 

 Transparency 

Select or enter the transparency value of the 
element. The range value is 50—255 and the default 
value is 255. 
The lower the value is, the higher the transparency is. 

 
Smooth 

animation 

Select whether to enable the Smooth Animation 
function. 
When this function is enabled, the element display 
becomes smoother. 

 Anti-aliasing 

Select whether to enable the Anti-aliasing function. 
When this function is enabled, the display of the 
elements will be more delicate, and there will be no 
aliasing. 

Yes No 
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Legend Function Description 

 
Target Value 

Style 

Select the style of the target value. The available 
options are Default and Style 1, and the default value 
is Default. 

Default 

 

Style 1 

 

 

 
Scale 

Settings 

 
Setting Description 

Scale Display 
Position 

Select the position to display 
scale on the element according to 
Direction. 

Scale Settings 
Set the mark number, color, width 
of the scale. The range value of 
Scale Mark Number is 1–99. 

Text Setting 
Select the Display mark 
checkbox to display the mark and 
set the text size and color. 

 



 

Data Display 
 

 

197 DIAScreen V1.6.0 

Data Display 

The Date Display, Time Display, and Week Display elements display the date, 

time, and week of the HMI system. The date and time can also be displayed by 

setting the timestamp through Read Address, and the Week Display element can 

be edited using the Multi-language function. 

Data Display 

Date Display 
The available Date Format options include mm/dd/yy, dd/mm/yy, 
dd.mm.yy, yy.mm.dd, yy/mm/dd, mm.dd, and mm/dd. The default 
value is mm/dd/yy. 

Time Display The available Time Format options include HH:MM:SS and 
HH:MM. The default value is HH:MM:SS. 

Week Display 

If multi-language has been set, edit the Week display in the Text 
tab of the element properties dialog to present the multi-language 
effect. 

 

Illustration 

After compiling the screen and downloading it to the HMI, the 
HMI screen appears as follows: 

Date Display Time Display Week Display 

 
 

Chinese English 

 
 

 

 

Timestamp 

Set the displayed date and time through Read Address. 

Timestamp rules 

• Start time: 1970/01/01 

• Standard type: in seconds 
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• Time zone setting: Go to General > Configuration > Network Settings > Time 
zone to set the time zone of the HMI time. 

 

Example 

1. Create Date Display, Time Display, and Week Display elements, and set 

Read Address to $10. 

2. Create a Numeric Entry element and set Write Address to $10. 

3. Compile the screen and download it to the HMI. Enter 0 to the Numeric Entry 

element on the HMI, and the time displays as 01/01/1970 00:00 (GTM +00:00). 

 

4. Enter 86400 to the Numeric Entry element and the time displays as 01/02/1970 

00:00 (GTM +00:00). 
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Note: 

• The timestamp is in seconds. It is suggested to set an address that supports 

Quad Word data type. 

• For timestamp conversion, see epochconverter.com/. 

• Setting None for Read Address displays the HMI system time. 

CODESYS time variable read 

The Date Display and Time Display elements support reading CODESYS time-type 

Tags, including TIME, LTIME, DATE, TIME_OF_DAY, and DATE_AND_TIME. 

Note: Except Date Display, Time Display, and Week Display elements, other 

elements do not support reading time-type Tags. 

 

https://www.epochconverter.com/
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List 
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File Browser 

You can browse the stored device files on HMI, and rename and delete files through 

the File Browser element. 

The following table lists the properties of the File Browser element with their 

descriptions. 

• Main 

 

 Memory 
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Setting Description 

Control Address 

Set the address to trigger actions. The following table 
lists the corresponding actions of the state value. 

State Value Action 
1 File deletion 
2 File rename 
3 Path write 
4 Switch to the previous page 

 

Control Return 
Address 

Set the return address after the action is completed, 
the status code and description of the return are as 
follows: 

Action Status  Description 
No action 0 - 
Succeed 1 - 

File deletion –1 Failed to delete the file 

File rename 

–2 

File name is too long 
Note: The maximum length 
of the file name is 255 
characters.  

–3 File does not exist 

–4 
The file name cannot 
contain the following 
characters: \/:*?\"<>| 

–5 The name of the file has 
not been changed 

–6 The same file name exists 

Path write 
–7 The path does not exist 

–8 The path write address is 
not set 

Note: 

• The data type of Control Return Address is 
signed decimal.  

• If the HMI language is non-English, the result 
description should be displayed using a Multi-
language Input element. 

Result Describes 
Address 
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Setting Description 

Write Path 
address  

Do one of the following to write path address: 

• Select the file on the HMI and click   on the 
toolbar of the element to write the path. 

• Write value 3 for Control Address, and then write 
the current file path for Write Path Address. 
Write the file path to this address, and the file 
browser redirects to the specified file. 

Note: 

• The file path does not contain the root directory, 
but the path after the address is written to the file 
location. 

• Set this parameter using the Character Display 
or the Multi-language Input element. 

 

 Detail 

Function Description 

File Types Select the type of file to display. 

Invisible Address Set the invisible address. When the invisible bit is 
On, the element is not visible to the HMI. 

 

 File Location 

Function Description 

Dynamic File Location 
Choose whether to set the file location 
dynamically. Select Yes to select by the root 
directory of the address file. 

File Location Choose the root directory to which the path is 
written. 

 

The following table lists the functions on the toolbar of the File Browser element 

with their description. 

Icon Function Description 

 

Previous 
Click to switch to the previous level of directory. 
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Icon Function Description 

 
File deletion 

Click to delete the currently selected file. 

 
File rename 

After selecting a file, click this icon to enter the file name 
to change the name of the selected file. 
Note: If you want to input words other than English or 
numbers, check the languages in the Configuration 
dialog. 

 

 
Path write 

After selecting the file, click this icon to display the full 
path of the file at the Write Path Address. 
Note: If you don't select a file, clicking this button has no 
effect. 

 
Display toggle Click to display files as icons or manifests. 

 
Folder switching Click to display or not display the folder. 

 
File sorting 

Click to set how the files are sorted. 

 



 

Picture Viewer 
 

 

205 DIAScreen V1.6.0 

Picture Viewer 

You can select files and view pictures on the HMI through the Picture Viewer 
element. 

The following lists the properties of the Picture Viewer element and their 

descriptions. 

• Main 

 

Legend Function Description 

 File Location 

Select the location to store the files. 
• If Dynamic File Location is set to No, the 

storage device can be specified for reading. 
• If Dynamic File Location is set to Yes, the 

storage device can be dynamically specified 
on the HMI. The value 2 is USB disk, 6 is 
USB disk 2, 3 is SD card. 
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Legend Function Description 

 Folder 

Set the folders to display in the File Browser. 
• Root: The root directory of the specified File 

Location. 
• Capture Picture: The screen_capture folder 

under the specified File Location. 
• Define By User: The specified folder under 

the specified File Location. 
If Dynamic Folder Path is set to Yes, the folder 
to display can be dynamically specified on the 
HMI. 
Note: You can only specify internal memory 
address of the HMI for Dynamic Folder Path. 

 File Selection 

• Choose whether to automatically display the 
latest pictures. Select Yes to select whether 
to send a notification when the picture is 
updated, and specify the memory address of 
the notification. 

 
• Choose whether to specify the file by the 

address. Select Yes to specify the file name 
of the picture by the address on the HMI to 
display the picture on the element. 

 

• Style 
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Setting Description 

Toolbar Location Select the location to which the toolbar is displayed on the 
element. 

Background 
Color 

Select the background color of the element. 

Hide Delete 
Button 

Select whether to hide the delete button. 

Invisible Address Set the invisible address. When the invisible bit is On, the 
element is not visible to the HMI. 

 

Note: 

• Only one Picture Viewer element can be configured for a screen, and only for a 

general screen. 
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• The picture will not be loaded by default when the HMI starts, and the picture 

will only be displayed if you enter the File Browser element and click on the 

picture file, or specify the file name by the file address. 

The following table lists the functions on the toolbar of the Picture Viewer element 

with their descriptions. 

Icon Function Description 

 

File browsing 

Click to toggle to File Browser. The directory under 
the set File Location is displayed by default. For the 
functions on the toolbar of the File Browser, refer to 
File Browser. 

 
Refresh 

Click to reload the currently displayed picture. 

 
Delete 

Click to delete the currently displayed picture. 

 
The first picture 

Displays the pictures in alphabetical order by file 
name. 

 
Previous picture 

 
The next picture 

 
The last picture 

 
Maintain 

proportions 
Click to maintain the picture’s aspect ratio. The ratio 
scales according to the size of the element. 

 
Actual size 

Click to display the original size of the picture. 
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Frame and Multimedia 
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VNC Viewer 

VNC (Virtual Network Computing) uses the RFB protocol to achieve screen sharing 

and remote operation. It can transmit keyboard and mouse movements and real-time 

images through the network. The VNC Viewer element of the HMI receives and 

controls the display device operated by the server. 

Note: This function is only available for DOP-300 series models. 

The following table lists the settings in the property dialog of the VNC Viewer 

element with the description. 
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Legend Function Description 

 State Address 

Set the State Address in Word type. 
• Obtain the current connection state through the 

State Address values. The following table lists the 
state values with the corresponding description. 

State Description 
0 Stopped 
1 Connecting 
2 Connect failed 
3 Authentication error 
4 Server disconnect 
5 Security error 
6 Attempting to reconnect 
7 Reconnect failed 
8 Reconnect successful 

 

 Action Address 

Set the Action Address in Word type. 
• Send the action to the VNC device through the 

Action Address. The following table lists the state 
values with the corresponding description. 

State Description 
0 None 
1 Start 
2 Stop 
3 Update 

 

 IP Address 

Set the IP address for the VNC server. 
• When selecting Yes for Set IP as variable, you 

can dynamically change the IP address on the 
HMI. Use the 4 Word addresses read by the IP 
starting address continuously as the set IP 
address. 

 Port Set the Port for the VNC server. The default value is 
5900. 

 Password 

When selecting Yes for Set password as variable, 
you can dynamically change the VNC connection 
password on the HMI. Use the set Password Max 
Length, read by the set starting address, as the 
password. Password can consist of numbers and 
letters. 

 Color Level 
Set the display color for different bits. The available 
options are High (32 Bit), Middle (16 Bit), and Low (8 
Bit). The default value is High. 
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Legend Function Description 

 
Enable virtual 

keypad 

If select Yes, the Keyboard button appears at the 
bottom right corner of the element after clicking the 
VNC Viewer element on the HMI. Click the Keypad 
button to call out the ASCII keypad. 

 Number of 

• If the connection to the server is disconnected, a 
message “Attempting to reconnect to VNC server” 
appears. When the connection is not restored after 
the set retries are reached, it will be automatically 
aborted and a message “Disconnected from VNC 
server” will appear. 

• If set to 0, it means the number of retries is 
unlimited. The maximum number is 65535, and the 
interval between each retry is 3 seconds. 
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Drawing 
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Rectangle Element 

The Rectangle element provides various filled styles and border configurations and 

supports importing pictures from the picture bank. Use the set read address to control 

the moving position, color, size, and blinking of the rectangle element. 

The following table lists the functions in the Rectangle element property dialog with their 

description. 

 

Main 
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Legend Function Description 

 

Read 
Address 

Select the internal address or controller register address. 
• When Variable Position is set to Yes, the value of the 

Read Address is regarded as the X coordinate of the 
horizontal axis for the upper left corner of the dynamic 
Rectangle element. 

• When Variable Position is set to Yes, the value of 
Read Address+1 is regarded as the Y coordinate of 
the vertical axis for the upper left corner of the 
dynamic Rectangle element. 

• When Variable Size is set to Yes, the value of Read 
Address+2 is regarded as the width for the dynamic 
Rectangle element. 

• When Variable Size is set to Yes, the value of Read 
Address+3 is regarded as the height for the dynamic 
Rectangle element. 

• When Variable Color is set to Yes, the value of Read 
Address+4 is regarded as the color for the dynamic 
Rectangle element. Its value range is 0–65535. 

• When Blink is set to Yes, the value of Read 
Address+5 determines whether the dynamic 
Rectangle element blinks or not. When its value is 
greater than 1, the dynamic Rectangle element is 
displayed as blinking; when the value is 0, it does not 
blink. 

• When Variable Position is set to No, the 
corresponding memory addresses are automatically 
filled in. 

 

 

Data 
Format 

Select the data format. The default value is Unsigned 
Decimal. 
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Legend Function Description 

 

Variable 
Position 

Select whether the position can be moved. The default 
value is No. 
• If select Yes, the position of the dynamic Rectangle 

element can be moved. 
• If select No, the dynamic rectangle element cannot be 

moved, but the size can be changed. 

 

Variable 
Color 

Select whether the color can be changed. The default value 
is No. 
• If select Yes, the color of the dynamic Rectangle 

element can be changed. Its value range is 0–65535. 
Note: This setting has no effect when the Filled style is set 
to more than one color such as Gradient or Fill Pattern 
Style. 

 

Variable 
Size 

Select whether the size can be changed. The default 
value is No. 
• If select Yes, the size of the dynamic Rectangle 

element can be changed by changing its coordinates 
at the lower right corner. 

• If select No, the size of the rectangle element cannot 
be changed. 

 

Image File 
Name 

Address 

Specify the selected item through this setting, and then set 
Load Image Trigger Address to On, the element 
displays the selected item. 
• Image File Name Address supports selecting the 

controller address (Word) and internal register address 
(Word). 

• Load Image Trigger Address supports selecting the 
controller address (Bit) and internal register address 
(Bit). 

 

Load Image 
Trigger 

Address 

 

Save in 

Select the stored type. The default value is USB Disk. 
By storing the image file in a USB Disk, USB Disk 2 or SD 
Card, the image file can be read on the HMI. Currently 
supports BMP, JPEG, PNG, and TIFF file formats. 

 

String 
Length 

Select or enter the file name to read. The default value is 
16. 

 

Extended 
mode Select the extended mode. The default value is All areas. 
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Style 

 

Legend Function Description 

 

Foreground 
Color 

Set the foreground color of the element. 
Note: This setting has no effect when the Filled style is 
set more than two gradients. 

 

Round 
Corner 
Radius 

Select or enter the round corner radius. 
The size of this round corner radius is determined by the 
width and height of the Rectangle element. Take the 
smaller value among width/2 and height/2 of the 
Rectangle element. This is the maximum value that can 
be set for the radius. 

 

Blink 

Select whether to blink or not. The default value is No. 
• If select Yes, the dynamic Rectangle element 

displays as blinking. When the value of the 
corresponding read address is great than 1, the 
dynamic Rectangle element displays as blinking; 
when the value is 0, it does not blink. 

• If select No, the dynamic Rectangle element does 
not blink. 
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Legend Function Description 

 

Transparent 

Select whether to display in transparent. The default 
value is No. 
• If select Yes, the Foreground Color setting has no 

effect. 
• If select No, the dynamic Rectangle element 

displays only the rectangle border line with the 
middle shown in transparent  

 

Penetrate 

Select whether the element that overlaps with the 
Rectangle element can be clicked. The default value is 
ON. 
Example Operation 
1. Create a Numeric Entry element. 
2. Create one more Numeric Entry element and make 

it overlaps on top of the Numeric Entry element. 

Function Illustration 

Penetrate 
ON 

The Numeric Entry element under 
Rectangle element can be clicked. 

 

Penetrate 
OFF 

The Numeric Entry element under 
Rectangle element cannot be clicked. 

 
 

 Filled style 

Select the fill style of the element. The default value is 
Gradient. The following table lists the functions in the 
Gradient Fill view with their description. 
Function  Illustration 
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Legend Function Description 

Gradient 
Style 

Set the Gradient Style by setting the 
Current Angle or Center Point. Set the 
Current Angle or Center Point by dragging 
the mouse on the preview image, or set 
the memory address for dynamic 
configuration on the HMI. Supports adding 
gradient stop points and setting stop point 
colors to present the effect of multi-color 
gradients. 
Note: Up to 5 stop points can be set. 
• Mono Gradient 

The gradient color automatically 
configured by the software does not 
provide stop point configuration and is 
compatible with the behavior of 
DOPSoft software. 

 
• Linear Style 

 
• Radiation Gradient 
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Legend Function Description 

 
• Conical Style 

 

Solid 
Color 

Set a single color fill, the same as the 
Foreground Color setting. 

 

Fill 
Pattern 
Style 

Provides a variety of Fill Pattern styles and 
two color combinations to present pattern 
fill effects. 

 



 

Rectangle 
 

 

221 DIAScreen V1.6.0 

Legend Function Description 

Note: This feature is supported in software version 1.4.0 
and above. 

 Transparency Select or enter the transparency value. The range value is 
50–255 and the default value is 255. 

 Anti-aliasing 

Select whether to enable anti-aliasing effect. 
• If select Yes, the element border displays smooth. 
• If select No, the element border displays in aliasing. 
Note: This setting only has effect when the Round 
Corner Radius is set. 

 
Customize 
each fillet 

radius 

Set each fillet radius. 
Note: The fillet radius settings are available when this 
setting is selected. 

 

Border 

Note: This feature is supported in software version 1.3.1 and above. 

• Border Style 

 Fixed 

 

Function Description 

Width Select the border width. The range value is 1 ~ 8, and the 
default value is 1. 

Color Set the border color to display. 
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 Linear Gradient 
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Function Description 

Linear 
Degree 

Select the angle of transition from Begin Color to End Color. 

Angle Result 

From 0 
degree 

 

From 45 
degree 

 

From 90 
degree 

 

From 180 
degree 

 
 

Variable 
Border 
Color 

Select whether the border color is variable. 
• If select No, the Begin Color and End Color are fixed. 
• If select Yes, the Begin Color and End Color dynamically 

change on the HMI according to the set address. 
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Function Description 

 
The value entered in the address corresponds to the color 
as shown in the following figure. 

 
 

 Radiation Gradient 
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Function Description 

Radiation 
Gradient 

Begin Color radiates from the mid point of the gradient to the 
End Color. 

Angle Result 

From Mid 
point 

 

From Top-
Left cor. 
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Function Description 

From Top-
Right cor. 

 

From Bot-
Right cor. 

 

From Bot-
Left cor. 

 
 

 

 Transition Gradient 
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Select Transition Gradient, and HMI will dynamically cycle according to 

Begin Color, Mid Color, and End Color. 
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 Figure-Filled 

 

Function Description 

Figure Style 

Select Figure Style. The dotted line type uses Begin Color 
as the line background color and End Color as the dotted line 
color. 

Style Result 

Style 1 
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Function Description 

Style 2 

 

Style 3 

 

Style 4 
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 Flashing-Outline 

 

Function Description 
Flashing 
Speed 

Select Flashing Speed. Begin Color and End Color flash 
alternately according to Flashing Speed. 

Twinkle 
Control Bit 

Select Twinkle Control Bit and set it to $1.1 as an example. 
When $1.1 is OFF, the border color is Begin Color; when 
$1.1 is ON, the border color is End Color. 
Note: This function is only available when the Flashing 
Speed is set to Custom. 

 

Coord. 

You can set Rotation angle as a variable or a constant, which is a value for clockwise 

rotation. 
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Alarm Setting 
You can set the properties to be used by the alarm elements, such as read address, 

sampling cycle, maximum records, non-volatile data storage, and alarm moving sign, 

and can also edit the alarm message contents to be displayed. The Bit or Word 

addresses can also be configured to trigger alarms through the continuous alarm 

address and non-continuous alarm address functions. 

The content of the alarm message also supports dynamic changes. You can add 

%d1 and %f1 to the alarm message, and then enter the value through the monitoring 

address function. When the alarm is triggered, the alarm message with the current 

value can be displayed immediately. 

The formula provided by the software calculates all the alarm relevant data edited. 

Then, the set non-volatile memory (HMI, USB Disk, and SD) saves these calculation 

results. For data saved in the HMI, the alarm data size is subject to change based on 

the HMI model, you can see the specifications for non-volatile memory in the HMI 

installation manual. For data saved in the external storage devices (USB Disk or SD 

Card), the alarm data size is determined by the external storage devices. 

The alarm formulas are applicable to the Alarm History Table and Alarm 
Frequency Table. The CSV file size is determined by the message (length) entered, 

there is no formula for the CSV file. 

The following describes the formulas for the Alarm History Table and Alarm 
Frequency Table. 

1. Alarm History Table 

 

a Time and Date Data 
b Alarm Data 
c Scan Points 
d Data File Header 
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2. Alarm Frequency Table 

 

a Alarm Frequency Data 
b Alarm Records 

 

How to open the Alarm setting page? 

• In the Project pane, double click Alarm. 

• On the toolbar, click Data Management > Alarm Settings. 

Use the following the steps to set an alarm. 

1. Click Data Management > Alarm Settings on the toolbar. 

2. In the Alarm setting page, set the alarm for continuous alarm address and non-

continuous alarm address. 

• Continuous Alarm address: Add 3 alarms. 

 

Set the alarm Address in the Properties tab, as shown below. 

 

• Non-continuous Alarm address: Click  on the toolbar and set the Type, 

Address, and Trigger Condition. 
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3. In the Alarm setting page, set the Scan Time (seconds) and Alarm Moving 
Sign in the Properties tab. 

 

4. Click Data Management > Alarm on the toolbar and select Alarm History 
Table, and add it to the screen. 

5. In the Alarm History Table element, select the items to display in the Field 
attributes tab. 
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6. Create elements on the screen to trigger alarms. 

• Continuous Alarm address: Create 3 Maintained Button elements with 

addresses set to $0.0, $0.1, and $0.2. 

 

• Non-continuous Alarm address: Create 2 Numeric Entry elements to 

trigger Word type alarms and a Button element to trigger Bit type alarms. 

 

7. Click General > New Screen > Subscreen on the toolbar. 

8. In the Alarm setting page, set the Alarm Screen of the number 1 item to the 

subscreen you have created. 

 

9. Click Project > Compile All on the toolbar and download the screen to the HMI. 

The following example shows the behavior of continuous alarm address on the 

HMI. 

Since Alarm 1 has an alarm screen set up, when clicking the button with the 

address $0.0 will trigger Alarm 1 and pop up an alarm dialog. 
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When the alarm is recovered, the Recovery field of the Alarm History Table 

displays the recovery time. 
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Alarm Settings Toolbar 

The following table lists the settings on the toolbar in the Alarm setting page and 

their descriptions. 

Setting Description 

 

Click to copy the selected alarm items. 
• Support single and multiple copy functions. 
• Press Ctrl to select the alarm item to copy, and press Shift to 

select a range of alarm items to copy. 

 

Click to paste the selected alarm items. 
• Supports single and multiple paste functions. 
Note: You must first copy the alarm items. 

 

After selecting the alarm items, click this icon to delete. The 
settings of the item will return to default settings. 

 

Click to display the next 2048 entries. 

 

Click to display the previous 2048 entries. 

Alarm Font 
Size Set the text size for displaying alarm message on the screen. 

Alarm Font Set the font for displaying alarm message on the screen. 

Alarm Font 
Ratio 

Set the scaling ratio for display alarm message on the screen. 
The value range is 33% – 200%, and the default value is 100%. 

Ratio Result 

100% 

 

150% 

 

 

 

Click to switch between Continuous Alarm Address and Non-
continuous Alarm Address. 
Set the alarm address in the Alarm setting page, and the alarm 
can be triggered using Bit or Word addresses. 
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Setting Description 

 

Click to quickly set alarm categories in batches. 
In the Alarm Category Settings dialog, set the Starting Alarm 
Number, Ending Alarm Number and Category ID, click Batch 
Setting. The alarms and categories from the start number to the 
end number will be set to the specified numbers. 
• The category number range is 0 ~ 4095. 

 

Click to import the alarm data file. Supports .xlsx, .alm, and .ini 
formats. 
Note: .alm and .ini are alarm configuration files exported by the 
old software. 

 

Click to export the edited alarm data file. Supports .xlsx format. 
The exported .xlsx file contains AlarmContent and AlarmSetting. 
You can edit the contents of each field and alarm properties of the 
alarm in the alarm data file. 

 

 

 

Click to optimize the reading of non-continuous alarm addresses 
and speed up the alarm reading and writing. 
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Alarm Message Settings 

The following table lists the setting in the Detail tab in the Alarm setting page. 

Setting Description 

No. The number of alarm messages, and supports up to 20480 alarms. 

Enable 

Enable / disable the alarm. 
• If selected, run according to the set alarm rules after downloading. 

When you change any alarm setting field, the alarm is 
automatically enabled. 

• If not selected, the alarm content will not be checked when 
compiling the rule, and the alarm rule will not be executed when 
downloading to the HMI. 

Message 
Content 

Set the content of the alarm message to be displayed. 
• If you want to dynamically display message content, you can use it 

with the Monitor Address field. 
• If you want to set the message content displayed in different 

languages, you can go to Project pane > Multi-language to add a 
new language, and then go to General > Language drop-down 
menu to swtich. 

Category 

Set the category of the alarm number. 

On the toolbar, click  to quickly set the category numbers. After the 
setting is complete, you can set the display order in the alarm 
elements or display the alarm category according to the set range. 
The value range is 0–4095. 

Type 
Set the trigger type of the alarm as Word or Bit. 
Note: You must switch the alarm address to non-continuous. 

Address 
Set the trigger address of the alarm. 
Note: You must switch the alarm address to non-continuous. 

Trigger 
Condition 

• Continuous Alarm Address: Set the Trigger Condition as On or 
Off. 

 Select On to trigger an alarm when the Bit is On. 
 Select Off to trigger an alarm when the Bit is Off. 
• Non-continuous Alarm Address: Establish the Trigger conditions 

according to the set trigger type. 
 Select Bit for Trigger Type, the Trigger Condition can be 

configured as On or Off. 
 Select Word for Trigger Type, you can configure the trigger 

condition range in the Trigger Condition field. 
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Setting Description 

Monitor 
Address 

Configure the settings for dynamic display of alarm message. The 
alarm message can display the current value of the monitor address. 
• The supported formats include %d (positive integer), %f (floating-

point number), and %s (Alphanumeric). Besides, one alarm can 
set up to 8 monitoring addresses. 

• Enter the alarm message to be displayed in the Message Content 
field, and add the set Monitor Address such as %dx or %fx where x 
indicates 1~8. 

Alarm message 
setting 

 

Result 
 

 

Text 
Color 

Set the text color of the alarm message displayed by the alarm element 
or the alarm moving sign when the alarm is triggered. 

Alarm 
Screen 

Set whether to show the specified alarm screen when the alarm is 
triggered. The default value is None. 

Mail 

Set the mail information. When an alarm occurs, the Mail function sends 
an e-mail to relevant recipients. 
Click Recipient, Copy or Bcc in the Select Name dialog and select 
Select contact to select the recipient's email address in the contact 
list. 
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Setting Description 
Note: E-mail sending requires SMTP settings. Go to General > 
Configuration > SMTP to configure the mail address. 

 
 

Alarm Property Settings 

The following table lists the settings in the Properties tab in the Alarm setting page. 
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 Address 

Setting Description 

Address 

Set the Internal Memory or the controller register address to read 
addresses. 
Note: Address field is available only the alarm address is switched 
to continuous. 

Acknowledge 
all alarms 

Set the Internal Memory address to acknowledge all alarms. 
When the alarm is triggered, the Alarm History Table will record 
the alarm acknowledge time. 

 

 Detail 

Setting Description 

Scan Time 
(seconds) 

Set the time when the alarm is updated. 
The value range is 0.5–10, and the default value is 3. 

Max 
Records 

Set the max records for scan point. When the recorded scan point 
reaches the maximum, the record starts from 1 and overwrites the 
previous data. 
The value range is 1–9,999, and the default value is 500. 

Non-volatile 
Data 

Storage 

Set the storage location when the power is off. The storage location 
varies depending on the HMI model, including None, HMI, USB 
Disk, USB Disk 2, and SD. 
• If select HMI, when the HMI is powered off, the data is saved in 

the HMI SRAM. 
• If Export CSV File is set to Yes, set Non-volatile Data Storage to 

USB Disk or SD. 
Export CSV 

File 
Set as Yes to save the alarm data as CSV files in the external 
storage devices (USB Disk or SD Card). 

CSV 
Field Setting 

Select the column items for the exported CSV file, and you can 
adjust the column order. 
Use the Print Output button element to print the historical alarm 
content into a CSV file according to the CSV Field Setting and store 
it in the external storage devices. 
Note: This setting is available only the Export CSV File is set to 
Yes. 

Exit 
Screensaver 
when alarm 

occurs / Time 
to enter 

screen saver 

• These functions are used with the screen saver. 
• Set Exit Screensaver when alarm occurs to Yes: When an alarm 

occurs, the screensaver screen will stop immediately. if the 
screensaver screen is not set, the HMI will not enter backlight 
mode. 
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Setting Description 
again The following table lists the timing to enter the screensaver 

screen again. 

Timing Description 

No alarm is 
triggered on the 

HMI 

As long as no alarm is triggered, the HMI 
can enter the screensaver mode. 

No alarm is 
triggered during 
the screen saver 

waiting time 

• As long as no alarm is triggered during 
the screen saver waiting time, the HMI 
can enter the screensaver mode. 

• The screen saver waiting time can be 
set in Configuration > Screensaver 
Setup. 

• Set Exit Screensaver when alarm occurs to No: The HMI exits 
the screen saver when the alarm is triggered for the first time. 
After that, whether the alarm is cleared or not, the HMI enters 
the screensaver mode according to the set time. 

• Screensaver screen creation: Create a normal screen and go 
to General > Screensaver Setup. In the Screensaver Setup 
dialog, drag the screen from All Screens to Screensaver 
Screen. 

Display alarm 
screen 

Set to display the alarm screen automatically or manually. 
• Set to Auto: The HMI displays the alarm screen as soon as the 

alarm with a set alarm screen is triggered. 
• Set to Manual: It must be controlled with the Alarm History 

Table element. The triggering methods are as follows: 
 In the element property dialog, set Action Control Addr. in 

the Operating conds. tab. When the value is set to 2, the 
alarm screen displays. 

o In the element property dialog, select the Trigger alarm 
screen checkbox in the Function Buttons tab to display the 
alarm screen. 

 

 Alarm Moving Sign 

Setting Description 

Enable 

Set whether to display the alarm moving sign. The default is No. 
• Set to Yes: When the alarm is triggered, no matter which page 

you operate on the HMI, an alarm moving sign shows at the 
specified position on the screen. 

• Set to No: When the alarm is triggered, alarm messages are not 
displayed. 
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Setting Description 

Position 

Set the display position. The default is Top. 
• Set to Top: When the alarm is triggered, the alarm message is 

displayed at the top of the HMI screen. 
• Set to Bottom: When the alarm is triggered, the alarm message 

is displayed at the bottom of the HMI screen. 

Direction 

Direction Result 

Left 
 

Right 
 

Up 

 

Down 

 

 

Points per 
time 

Set the points per time. The greater the number, the greater the 
distance each time the text moves. The value range is 1–50 (pixel). 

Interval (ms) 

Set how often the alarm moving sign moves. The value range is 1–
50. 
Note: The moving distance is determined by the setting of Points 
per time. 

Background 
color Set the background color of the alarm moving sign. 
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Setting Description 

Translucent 

Set the transparency level of the alarm moving sign. The value 
range is 0–255, and the default value is 255. 

Value Result 

255 

 

100 
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Alarm Element 
You can create alarm element to display alarm status. Alarm elements including 

Alarm History Table, Active Alarm List, Alarm Frequency Table,Alarm Moving Sign, 

and Gantt Chart. This section introduces the properties of each alarm element. 

 

Common Properties 

• Main – Enable group number filtering 

You can select the group number for Category in the Detail in the alarm setting 

page. 

In the alarm element property dialog, select the Enable group number filtering 

checkbox in the Main tab. On the HMI, the element will display the alarm group 

according to the specified number. The value of the group number can be a 

variable or constant. 

Note: When the Group is 0, all alarms are displayed. 

• Operating conds. – Filter 

In the alarm element property dialog, you can use the filter function to configure 

the items displayed on the alarm element in the Operating conds. tab. 

The following table lists the settings in the Filter area in the Operating conds. 

tab and their descriptions. 
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Setting Description 

Filter control 
address 

Set the filter control address to filter the specified items. 

Value Action description 

0 Default status, displays all triggered alarms. 

1 Hides the alarms with both Recovery Time 
and Acknowledge Time. 

2 Hides the alarms with Recovery Time. 

3 Hides the alarms with Recovery Time or 
Acknowledgement Time. 

4 Hides the alarms with Acknowledgement 
Time. 

5 

• This setting must be used with Alarm 
counter display. 

• The alarm display count refers to the value 
of Alarm counter display. When the 
alarm display count is smaller than this 
value, the alarm is hidden. 

6 

• This setting must be used with Alarm 
category start addr. and Alarm 
category end addr. 

• When the alarm category number is not 
within the range set by Alarm category 
start addr. and Alarm category end 
addr., the alarm is hidden. 

 

Alarm 
counter 
display 

• This setting is applicable to the Alarm History Table 
element and the must be used with Filter control 
address. 

• When Filter control address is set to 5, enter the value of 
the alarm count. 

Example Description 

Alarm 
element has 
alarms with 

alarm 
counts 1, 2, 
and 3 times 

• Set to 1 for Alarm counter display, the 
Alarm History Table element displays 
the alarms with 1 or more alarm counts. 

• Set to 2 for Alarm counter display, the 
Alarm History Table element displays 
the alarms with 2 or more alarm counts. 

• Set to 3 for Alarm counter display, the 
Alarm History Table element displays 
the alarms with 3 or more alarm counts. 
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• Operating conds. – Control 

In the alarm element property dialog, you can set the scroll control address in 

the Operating conds. tab and switch the alarm table display page on the HMI 

through the memory address. The scroll control supports 16-bit Unsigned, 16-bit 

signed, 32-bit Unsigned, and 32-bit signed data formats. 

• Style 

The display style of Alarm elements on the HMI can be set. 

Setting Description 

Background 
Color 

Set the background color of the element. The default is white. 
When set to red, it displays as follows. 

 

Alarm 
category 

start addr./ 
Alarm 

category end 
addr. 

• This setting must be used with Filter control address. 
• When Filter control address is set to 6, enter the alarm 

category number. 

Example Description 

Alarm 
element has 
alarms with 

alarm 
category 

numbers 1 
and 5 

• Set to 1 for Alarm category start addr. 
and 3 for Alarm category end addr., only 
the alarms with alarm category number 1 
are displayed on the alarm element. 

• Set to 1 for Alarm category start addr. 
and 5 for Alarm category end addr., the 
alarms with alarm category numbers 1 
and 5 are displayed on the alarm element. 
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Setting Description 

Border Color 

Set the border color of the element. The default is gray. 
When set to red, it displays as follows. 

 

Gridline 
Color / Show 

Gridlines 

Set the gridline color of the element. The default is white. 
When set to red, it displays as follows. 
Note: The Gridline Color setting is valid only when you select 
Yes for Show Gridlines. 

 

Select Row 
Color 

Set the color of the selected row of data when operating the 
element on the HMI. The default is blue. When set to red, it 
displays as follows.  
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Setting Description 

Row Color 

Set the color to display for each row of the alarm. The default 
is light blue. When set to red, it displays as follows. 

 

Alternating 
Row Color 

Set the color for the alternating row of the alarm. The default is 
blue. When set to red, it displays as follows. 

 

Transparency 
Set the transparency of the element. The range value is 50–
255, and the default value is 255. 
The smaller the value, the more transparent the element is. 

 

• Field attributes 

In the alarm element property dialog, set the field items to be displayed in the 

alarm table in the Field attributes tab. 
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Legend Setting Description 

 

Column display Select the columns to be displayed in the element. 

 

Column width Select or enter the width for each column. 

 

Column title Enter the titles for each column. 

  Column order 
After selecting the columns to be displayed, click 

 to adjust the column displaying order. 

 

Allow to change 
the field width 

Select to drag the field on the HMI to change the 
displaying width. 

 

Title bar 

Title Text 
Alignment 

Select the title bar text as left, 
center or right. 

Title 
Background 

Select the background color of 
the title bar. 

Title Text Color Set the text color of the title bar. 

 

Date and time 

Date Format Set the display date format. 

Time Format Select the display time format. 

Color Select the display color of date 
and time. The default is black. 
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• Function Buttons 

You can add function buttons in the Function Buttons tab of the alarm element 

properties dialog to control the display of the alarm table. 

Setting Description 

Function 
Description 

Select to add function buttons. 

Default 
Description 

Set the description of the function button. Click Set As Default 
Description to insert the default strings to the input fields. You 
can switch between the different languages to define the 
default text. 

Default 
Button Width 

Set the width of the function buttons. The value range is 25–
100, and the default value is 60. 
After adjusting the width, right-click the element on the screen 
and select Rearrange Function Buttons, all function buttons 
display according to the settings. 

Default 
Button Height 

Set the width of the function buttons. The value range is 25–
100, and the default value is 40. 
After adjusting the height, right-click the element on the screen 
and select Rearrange Function Buttons, all function buttons 
display according to the settings. 

 

Alarm History Table Properties 

• Style 

You can set Trigger Column Color, Confirm Column Color, and Recovery 
Column Color after selecting Color Mode as Alarm Status. When an alarm is 

triggered on the HMI, colors display according to different statuses. 

Example Setting 

1. Select the Color Mode. 

2. Trigger an alarm on the HMI. 

The trigger column is displayed in red. 
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3. Click the Acknowledge Alarm or Acknowledge All Alarm button on the 

Alarm History Table. 

The confirm column is displayed in green. 

 

When an alarm is recovered, the recovery column is displayed in blue. 
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• Operating conds. 

 

 Event 

Setting Description 

Action Control 
Addr. 

Set the action control address to change screens or 
acknowledge the alarms for specified alarms. 

Value Description 

0 Default status, no action. 

1 Acknowledge for selected alarms in the Alarm 
History Table element. 

2 

If the selected alarm in the Alarm History 
Table element has a set alarm screen which 
is set to display manually, the alarm screen 
displays when the value is 2. 
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 Sort 

Setting Description 

Use header 
controls to sort 

If selected, click the header of the Alarm History Table 
element to sort the alarms in ascending or descending 
order. The Sorting Control Addr. and Sorting Order 
Address settings are not available. 
Note: The sorting of the Message column is not supported. 

Sorting Control 
Addr. 

Set Sort Control Addr. for the specified item. 

Value Description 

0 Default status, no action. 
1 Sort by Trigger Time. 
2 Sort by Acknowledge Time. 
3 Sort by Recovery Time. 
4 Sort by alarm count. 
5 Sort by alarm category. 

 

Sorting Order 
Address 

Set the sorting order address with the Sorting Control 
Addr. value to determine the ascending or descending 
order. For example, if the Sorting Control Addr. is set to 1 
and the Sorting Order Address is set to 0, the Trigger 
Time is sorted in ascending order. 

Value Description 
0 Sort in ascending order. 
1 Sort in descending order. 

 

 

Active Alarm List / Alarm Frequency Table Properties 

• Operating conds. 

Select the fields you want to display in the Field attributes tab, and then select 

Use header controls to sort checkbox in the Operating conds. tab, the 

Default sort field can be selected. 
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Alarm Moving Sign Properties 

The Alarm Moving Sign element records the alarm number, time and date when an 

alarm is triggered. You can also set the time interval and moving distance according 

to your needs. 

In the Main tab, you can set the content of the Alarm Moving Sign. 

The following table lists the properties in the Main tab in the Alarm Moving Sign 

element and their descriptions. 

 

 Direction 
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Setting Description 

Direction 

Select the display direction. The default value is Left. 

Left 

 

Right 

 

Up 

 

Down 

 
 

 

 Interval 

Setting Description 

Interval (ms) Set how often the message moves. The default value is 100. 
 

 Points per time 

Setting Description 

Points per time 
Set the distance each time text moves. 
The greater the number, the greater the distance each time the 
text moves. The value range is 1–50, and the default value is 1. 
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 Status Display 

Setting Description 

Time format Select the time format. The default value is hh:mm:ss. 
Date format Select the date format. The default value is mm/dd/yy. 

Display Color Select the display color of the time and date. 
 

 Other displays 

Item Description 

Alarm No. 

If selected, the Alarm Moving Sign element displays the alarm 
number when an alarm is triggered. 

 

Alarm Group 

If selected, the Alarm Moving Sign element displays the alarm 
category when an alarm is triggered. 

 
 

In the Style tab of the property dialog, you can set the display style of the Alarm 
Moving Sign element. 
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Legend Setting Description 

 Style 

Set the appearance of the element. The options 
include Standard, Raised, Sunken, and Transparent. 

Standard Raised Sunken Transparent 

 

 

  

 

 Border Color 

Set the border color of the element. The default is 
gray. When set to red, it displays as follows. 
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Legend Setting Description 

 Filled style 

Select the fill style of the element. The default value is 
Gradient. The following table lists the functions in the 
Gradient Fill view with their description. 

Setting Description 

Gradient 
Style 

Set the Gradient Style by setting the 
Current Angle or Center Point. Set the 
Current Angle or Center Point by dragging 
the mouse on the preview image, or set 
the memory address for dynamic 
configuration on the HMI. Supports adding 
gradient stop points and setting stop point 
colors to present the effect of multi-color 
gradients. 
Note: Up to 5 stop points can be set. 
• Mono Gradient 

The gradient color automatically 
configured by the software does not 
provide stop point configuration and is 
compatible with the behavior of 
DOPSoft software. 

 
• Linear Style 

 
• Radiation Gradient 
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Legend Setting Description 

 
• Conical Style 

 

Solid 
Color 

Set a single color fill, the same as the 
Foreground Color setting. 

 
Fill 

Pattern 
Style 

Provides a variety of Fill Pattern styles 
and two-color combinations to present 
pattern fill effects. 
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Legend Setting Description 

 
Note: If select Transparent for Style, the set Filled 
style will not be applied. 

 Size Set the text size of the alarm message to be displayed. 

 Font 
Set the font of the alarm message to be displayed. 
You can switch between different languages to set the 
font settings corresponding to the language. 

 Ratio Set the scaling ratio of the alarm message to be 
displayed. 

 Transparency 
Set or enter the transparency value. The smaller the 
value, the higher the transparency of the element. The 
value range is 50–255, and the default value is 255. 

Note: When an alarm element is created and the alarm reading address is not set, 

the error message will be displayed in the Output pane after compilation. 
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Gantt Chart Properties 

The Gantt Chart element displays the alarm trigger time to restore time. You can 

filter the alarm information to view using  

Note: This element is only available for DOP-300 series model, and one screen can 

only have one Gantt Chart element. 

• Style 

The following table lists the settings in the Appearance Settings dialog with 

their description. 
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Setting Description 

Display time span Set the time range to display on the Gantt chart. 

Title 

Set the background color, text color, and date / time 
format of the title. 
Note: The format setting synchronously applies to 
Current Segment and Inspection Line. 

Title Axis Set the background color, category text color, and 
event record text color of the title axis. 

Grid Set the background, line color, and number of grids. 
Current segment Set the line color and text color. 
Inspection Line 

Footer Set the background color, text color, and date and time 
format. 
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History Buffer 
The history buffer records specific data in HMI or external storage device, through 

the buffer attribute to set the sampling data, trigger mode, and file output content, 

after the buffer data is established. The sampling data can be displayed on the HMI 

through the sampling element. 

 

History Buffer Settings 

How to open the History Buffer settings page? 

• In Project pane, double-click History Buffer. 

Or 

• On the toolbar, click Data Management > History Buffer. 

On the History Buffer settings page, click the  to open Buffer Properties 

dialog. 

The following table lists the settings in the Buffer Properties dialog with their 

description. 
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Settings Description 

Address Select either the internal memory or the controller register address. 

Read 
Length 
(Word) 

Select or enter the number of words that can be sampled. The 
maximum value is 256. 

Sample 
Number 

Enter the number of historical data to be recorded. Up to 9,999,999 
sampling points can be  
This function needs to be used with the Auto Stop function. If the 
Auto Stop checkbox is selected, the recording stops automatically 
when it reaches the set sample number. If the Auto Stop checkbox 
is not selected, the recording does not stop when it reaches the set 
sample number; instead, the recording restarts from the first record 
and overwrites the previous data. 

Enable 
active bit 

Select to set the active bit. 
If the Trigger is set to Timer for Data sampling, the HMI 
immediately records the sampling data as soon as it starts up. The 
Enable active bit function allows you to determine when to start 
sampling. When the active bit is On, it starts to sample; when the 
active bit is Off, it stops sampling. 
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Settings Description 

Stamp 
Time and 

Date 

Select to set the time format and date format. 

Trigger 

Select the trigger source. 
• With Timer as the trigger source, you can choose between 

Sampling Cycle and Custom Cycle. 
 Sampling Cycle: The range value is 100~86400000. 
 Custom Cycle: The cycle time of sampling can be dynamically 

set on HMI through the specified memory address. The 
maximum value can be set to 32767. If Use DWORD is 
selected, the maximum value can be set to 2147483647. 

• With Memory Address as the trigger source, you can configure 
the bit address to trigger data capture. When the bit is On, it will 
be sampled. 

Data 
Clearing 

Set the address of data clearing as a bit address. When the trigger 
address is On, the buffer data is cleared. 

Status 
Block 

Set the status block address as a bit address to read the sampling / 
clearing status. When the address is On, data sampling / clearing is 
performed. 

Non-volatile 

Check and select the storage location of data. The storage location 
varies depending on the external device supported by the model, 
including HMI, USB Disk, and SD. 
If HMI is selected, the data is recorded in the HMI SRAM when the 
power is cut off. 

Auto Stop 
If selected, the recording stops automatically when the set Sample 
Number is reached. 
Note: Refer to the instructions of Sample Number. 

Export CSV 
File 

Select to export historical data to a CSV file, and you can set the Field 
Name for a CSV file. 
Note: This setting is only available when Non-volatile is selected. 
The following table lists the settings in the CSV Fields dialog with 
their description. 
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Settings Description 

 
Legend Setting Description 

 
Title 

Setting 

Follow these steps to set the title. 
1. Title column: Select or enter the 

Column and click Detail to display the 
corresponding columns. 
Note: Support up to 20 columns. 

2. Title row: Click the buttons on the right 
to add, delete or move the title row. 
Note: Support up to 10 rows. 

3. Enter the content of the displayed title in 
the title field. 

 
Time and 

Date  Enter the time and date. 
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Settings Description 

 
Column 
Settings 

Set for the column item. 
• The column items are displayed 

according to the Read Length (Word) 
setting. You can choose whether to 
Open the item or not, and set the data 
style to be presented on the CSV file, 
including the title name, data format, 
and integer digits/fractional digits. 

• You can also set the Data Start 
Position and Length according to the 
read data. Different Length supports 
different data formats. The following 
table lists the valid range value 
corresponding to the data format. 

Length is 1 
Data 

Format Valid Range Value 

BCD 0~9999 
Signed 
BCD –999~9999 

Signed 
Decimal –32768~32767 

Unsigned 
Decimal 0~65535 

Hex 0~0xFFFF 
Char 2 words 

Length is 2 
Data 

format Valid Range Value 

BCD 0~99999999 
Signed 
BCD –9999999~99999999 

Signed 
Decimal 

–
2147483648~2147483647 

Unsigned 
Decimal 0~4294697295 

Hex 0~0xFFFFFFFF 
Char 4 words 

Floating 0~9999999 
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Settings Description 

• Use Export / Import buttons on the right 
to export the data as an XLSX file. After 
editing, you can import it into the field 
settings. 

The field name of the CSV file and the corresponding output result, 
as shown in the following figure. 

 
Note: If Non-volatile is not enabled, it can be used with the LUA 
command history.ExportCSV to export a CSV file. 

File storage 

Select to save the history butter data as single file or multiple file. 
• Save As Single File: All data is saved in a single file. You can 

define the file name (including English and numeric), and the 
maximum length is 8 characters. 

• Save As Multiple Files: When the Sample Number record of 
the historical buffer data is full, or the Archive trigger bit is 
triggered, the current data will be saved and the buffer data will be 
cleared. 

• The file name format of the multiple files is File 
Name_Date_Time. 

Note: Save As Multiple Files and Auto Stop cannot be used at the 
same time. To enable Auto Stop, select Save As Single File 
option. 

 

The following table lists the functions on the toolbar in the History Buffer settings 

page. 

Function Description 

 

Click to adds buffers. Up to 40 sets of buffers can be added. 
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Function Description 

 Click to delete the selected buffer data. 

 
Click to open the selected buffer properties dialog to modify the 
buffer properties. 

  Click to export buffer data as an XLSX file. 

 Click to import buffer data after modification. 

 

Click to enable / disable the Continuous historical buffer 
control command address function. 
• Enabled: Use continuous address to control the sampling or 

clearing of data in each buffer. It is set on the Properties tab. 
Refer to the next paragraph. 

• Disabled: Set the respective control command addresses in 
the Buffer Properties dialog. 

Note: If continuous address function is not enabled, it may affect 
the performance of the HMI. 

 

Enabling optimization is recommended when the set addresses of 
multiple buffers are not continuous. 
If multiple buffer addresses are already continuous, enabling this 
function may result in the slow read speed. 

 

In the Properties tab, you can set the control bit of the data sampling or clearing of 

the history buffer. It controls the actions of each buffer with the set starting address. 

Take the Data Sampling as an example, set the starting address to $10. You can 

click  to query the buffer number of each sampling bit control or view the actual 

control bits of that buffer in the properties dialog of each buffer. 
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Note: The continuous historical buffer control command address function needs 

to be enabled to set the Control Block / Status Block address. 

The following table lists the settings in the Properties tab with their description. 

Setting Description 

Data Sampling 
Controls the buffer sampling flag. When the control bit is ON, a 
sampling is performed. 
Note: The Trigger of the buffer needs to be Memory Address. 

Data Clearing Clears the buffer data flags, including data for sampling 
elements and non-volatile records. 

Data Sampling 
Status 

When the HMI samples the history buffer, it turns the 
corresponding history buffer sampling status flag ON. After the 
sampling is complete, the history buffer sampling status flag is 
turned OFF in real time. 

 

Data Clear 
status 

When the HMI clears the history buffer, it turns the 
corresponding history buffer clear status flag ON. After the 
clearing is complete, the history buffer clear status flag is turned 
OFF in real time. 

 

Auto Reset 
Flags 

Set whether to automatically clear flags. When Auto Cleared 
Flag is set to Yes, all data sampling or data clearing addresses 
will be cleared to 0 after sampling or clearing any buffer. 

Sampling Cycle 
(ms) 

Set the interval at which the sampling is performed. 
The default value is 300, and the range value is 100~1000. 
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Sampling Function 

Displays the sampling elements of historical buffer data. The following are sampling 

elements. 

• Historical Trend Graph: Displays the sampled data over a period on the 

element in the form of a trend chart. A maximum of 60 curves can be displayed. 

• Historical Data Table: Lists the values sampled from the history buffer on the 

element. A maximum of 60 fields can be displayed, corresponding to 60 curves 

in the historical trend chart. 

• Historical Event Table: Converts the sampled values into information and 

presents them on the element in Word or LSB format. 

• Historical Overview Table: Draws the historical data stored on an external 

storage device (USB disk or SD card) on the element in the form of a trend 

chart. 

• Circular Trend: Draws the sampled data over a period as a circular trend chart 

using the polar coordinate system. A maximum of 60 curves can be displayed. 

Note: There can be only one Circular Trend element per screen. 

 

Common Properties 

• Style 

The following table lists the common style properties of Historical Data Table 

and Historical Event Table. 

Setting Description 

Border Color 

Set the border color of the element. The default color is 
gray. When set to red, it displays as shown in the following 
figure. 
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Setting Description 

Background 
Color 

Set the background color of the element. The default color 
is white. When set to red, it displays as shown in the 
following figure. 

 

Row Color 

Set the color of the odd number of rows. The default color is 
light blue. When set to red, it displays as shown in the 
following figure. 

 

Alternating Row 
Color 

Set the color of the even number rows. The default color is 
blue. When set to red, it displays as shown in the following 
figure. 

 
Select Row 

Color 
Set the color of the select row to be displayed after clicking 
the element when executing on the HMI. 

Transparency 
Select or enter the transparency value of the element. The 
range value is 50~255. The smaller the value, the higher the 
transparency of the element. 

 

• Function Buttons 

The function buttons control the display of charts on the HMI. 

Setting Description 

Zoom In Select to zoom in or out historical data on the X-axis on the 
trend chart. 
Note: This function is used for Historical Trend Graph. Zoom Out 

Zoom Reset 
Select to reset the X-axis to the default style. 
Note: This function is used for Historical Trend Graph. 
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Setting Description 

Scroll 

Configure the scroll direction and interval according to the 
characteristics of the element. 
The trend chart can be scrolled left and right, and the data 
table can be scrolled up and down. 

Set the time 
display interval 

Displays the corresponding data according to the set time 
interval. 

Set as the 
default 

description 

Click to fill in the function description as default strings. 

Default button 
width / height 

Select or enter the height and width of the function buttons.  
After changing the height or width, click Rearrange 
Function Buttons in the element context menu to update 
the button size. 

 

Historical Trend Graph Properties 

• Main — Global curve setting 

The Global range checkbox needs to be selected to set the format of all curves 

on the trend chart uniformly. 
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Setting Description 

Scale Settings 

Set the position of the scale, the size and color of the 
markers, and the scale mark number. 
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Setting Description 

Curve style Select the curve style. 

Length 
Select the length. If the read length is 1, the length of the 
read data is 1 Word. If the read length is 2, the length of 
the read data is 2 Word. 

Data Format 
Select the data format. 
Note: Floating can only be selected when the read length 
is 2.  

Integer Digits / 
Fractional Digits 

Set integer digits and fractional digits to be displayed. 

Minimum / 
Maximum 

Set a valid range value according to the set Read Length 
and Data Format. You can enter a constant or a custom 
memory address to change the minimum / maximum value 
dynamically.  

Display High 
Value / Display 

Low Value 

Select to display high or low lines. You can enter a constant 
or custom memory address and set the color of the 
marking.  

 

• Style 
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Setting Description 

Number of 
Curves 

Select the number of curves to display. Support up to 60 
curves. 
This setting is synchronized with the number of Curve in 
the Historical data tab. 

Filling Curve 

Select whether to fill the curve. If set to Yes, the area 
below the curve will be filled with the curve color. The filling 
effect is shown in the following figure. 
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Setting Description 

Monitoring Line 
Select whether to display the monitoring line. If set to Yes, 
the monitoring line will be displayed after clicking the 
sampling point on the HMI screen. 

Horiz. Grid 
Number /  

Gridline Color 

Set the horizontal grid number and the gridline color. The 
horizontal grid number divides the number of zones of the 
Historical Trend Graph element. If set to 2, there is one grid 
line and 2 zones; if set to 3, there are two grid lines and 3 
zones, and so on. 
Support up to 50 zones. 

Background 
Color 

Sets the background color of the element. The default color 
is blue. When set to red, it displays as shown in the 
following figure.  

 
Filled style Sets the fill effect of Background Color. 

Transparency 
Select or enter the transparency of the element. The range 
value is 50~255. The lower the number, the higher the 
transparency. 

Anti-aliasing 
Select whether to enable the anti-aliasing function. If select 
Yes, the element display becomes more delicate without 
jagged edges. 

Margin 

Select whether to enable the margining function. If select 
Yes, it leaves white space around the element, and the 
trend chart will be indented as shown in the following 
figure. 

 
 

• Historical data – Individual curve setting 

Make the individual settings for all curves on the trend chart. 
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Follow these steps to configure the individual curve settings. 

To configure the individual curve settings 

1. Select the buffer data to be presented by this element, and the Buffer ID 

corresponds to the data number set in the History Buffer Setup dialog. 

 

2. In the Style tab, set the Number of Curves, and then configure the individual 

curve settings table. The following table lists the settings of the individual 

curve settings table with their description. 
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Setting Description 

Enable 

Set whether to enable the curve to read the data.  
• A value of 1 is enabled, and a value of 0 is not 

enabled. 
• The bit address can be set to enable curves 

dynamically on the HMI. 

Length 
Select the read length according to the data source. 
Note: If Global range is selected, it is not possible to 
set the read length for individual curves. 

Start Position Select the data start position, and it depends on the 
Read Length set in the History Buffer Setup dialog. 

Data Format 

Select the data format. 
Note: 
• If Global range is selected, it is not possible to set 

the value format for individual curves. 
• Floating can only be selected when the Read 

Length is 2. 

Integer Digits / 
Fractional Digits 

Select the integer digits and fractional digits to be 
displayed. 
Note: If Global range is selected, it is not possible to 
set the integer digits and fractional digits for individual 
curves. 

Line Color Set the line color of the curve. 

Line Weight Select the line width of the curve. The range value is 1–
8. 

Minimum / 
Maximum 

Set the minimum and maximum values according to the 
Read Length and Data Format. 
Note: If Global range is selected, it is not possible to 
set the minimum and maximum values for individual 
curves. 

Write Address Set the write address of the curve value on the 
monitoring line. 

Curve Style Select the curve style. 
 

〇 Time/Date 

 Time / Date Format: Select to display the sampling time and date, and select 

the format to be displayed. 

 Display time/date: Select to display the timeline and set the time interval. 
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 Time Interval: Select or enter the interval between the sampling points 

displayed at the set time. If the interval is 3, the sampling time will be 

displayed on the timeline at the first and fourth sampling points. 

 Timeline scaling: Select the zoom ratio of the timeline display. The scale is 

smaller, the more sample points can be seen. 

 

Historical Data Table Properties 

• Style 

The following table lists the unique properties in the Historical Data Table. For 

other Style properties, refer to Common Properties. 
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Function Description 

Column Counts 

Select the number of curves to be displayed. Support up to 
60 columns. 
This setting is synchronized with the number of curve item 
in the Historical data tab. 

Gridline Color / 
Show Gridlines 

Select the gridline color of the element. The default color is 
white. 
When set to red, it displays as shown in the following figure. 
Note: Gridline Color only works when Show Gridlines is 
set to Yes. 

 
 

• Historical data – Individual field setting 
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Follow these steps to configure the individual field settings. 

To configure the individual field settings 

1. Select the buffer data to be presented by this element, and the Buffer ID 
corresponds to the data number set in the History Buffer Setup dialog. 

 

2. In the Style tab, set the Column Counts, and then configure the individual 

field settings table. The following table lists the settings of the individual field 

settings table with their description. 

Setting Description 

Length Select the range of length and start position, which 
depend on the Read Length set in the History Buffer 
Setup dialog. Start Position 

Data Format 

Select the data format. 
Note: 
• Floating can only be selected when Length is 2. 
• If Length is greater than 2, you can use only the 

Char format. 

Integer Digits / 
Fractional Digits 

Set the number of integer digits and fractional digits to 
be displayed. 
Note: There are no integers / fractional digits in the 
Char format. 

Color Set the text color of this field. 

Column Width Set the display width of this field. The range value is 
0~9999. 

Prefix Zero Select to determine the number of digits to prefix 
according to the set Integer digits. 

Title bar 
Enter the title bar. 
Note: The title bar name is only displayed on the 
element when the Show title bar is selected. 

Field alignment Select to align the text in the field to the left, center, or 
right. 

  



 

History Buffer 
 

 

285 DIAScreen V1.6.0 

 Time/Date 

 Time / Date Format: Select to display sampling time and date, and set the 

display format, alignment, and field width. 

 Color: Select the display color of the text. 

 Show Title 

Select to display the title bar, and set the time, date, and the title of the index, 

as well as the background color and text color of the title bar. 

Note: The text in the title row of the data field is configured in the individual 
field settings. 

 Show No. 

Select to display the index, and set the text color and alignment of the index 

row. 

• Order 

Select the data sorting method, which is sorted by the sampling time. 

• Text 

Select the display font size of the text. 
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Historical Event Table Properties 

 

• Main – Detail 

 Data Type: If select Word, you can set 1 to 256 states; if select LSB, the 

sampling values of historical data are converted into binary display, and you 

can set 1 to 16 states. 

 Note: To display State 0, select LSB (Support State 0). 

• Main– Buffer setting 

 Buffer Number: Select the buffer data to be presented by this component, 

which corresponds to the data number set in the History Buffer Setup 

dialog. 
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 Data No: Select the data number, which depends on the Read Length set in 

the History Buffer Setup dialog. If the read length is 1, the data position is 0.  

 Time/Date: Time / Date Format: Select to display the sampling time and 

date, and select the display format and text color. 

 

Historical Overview Table Properties 

The Historical Overview Table element has a file browsing area on the left and the 

trend chart on the right, which have different properties. 

For the trend chart properties, refer to Historical Trend Graph Properties. The 

following lists the properties of the file browsing area with their description. 
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• Main – File Extension Filter 

Enter the extension of the file you want to browse. The default value is dat. 

• Main – Text 

Set the font, size, and color of the text in the file browsing area. 

• Style 

Set the border color, background color, and transparency of the file browsing 

area. 

 

Circular Trend Properties 

• Main — Global curve setting 
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Setting Description 

Distance (hours) 

Set the length of time for a circle of the circular trend chart. 
The range value is 1–24. You can also set the memory 
address to dynamically change the length of time on the 
HMI. 

Starting Position Select the starting position of the curve. 

Zoom Factor 
Set the zoom factor. The range value is 1–10. You can also 
set a memory address to change the displayed zoom factor 
on the HMI dynamically. 

Current time 
output (seconds) 

Set the time gap between the loading time by HMI and the 
last historical data, which is recorded in seconds. 

Select Historical 
Time Output 

Set the time gap between the HMI loading time and 
monitoring line. Record in seconds. 
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Setting Description 

Function Button 
Display 

If selected, you can open the settings dialog and adjust the 
circle’s display settings on the HMI. 

• Click  to open the setting dialog to set the displayed 
time range of data and displayed channel. 

 
• Click  to expand the function menu. The following 

table lists the functions in the function menu. 

Icon Function Description 

 

Displays the previous 
data 

Click to toggle the 
displayed time 
range. The time 
range in units of the 
set time distance.  

Display the next data 

 

Display the last data 
Click to display the 
last data in units of 
the time distance. 

 

Set the factor for 
zoom in to 1 

Click to reset the 
factor for zoom in to 
1. 

 

Zoom in 1x 

Click once to 
increase the factor 
for zoom in by 1 
until the factor 
reaches 10 and no 
longer zooms in. 

 

Zoom out 1x 

Click once to reduce 
the factor for zoom 
out by 1 until the 
factor reaches 1 and 
no longer zooms 
out. 
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• Style 

 

Setting Description 

Number of 
Curves 

Select the number of curves to display. Support up to 8 
curves. 
This setting is synchronized with the number of Curve in 
the Historical data tab. 

Monitoring Line 

Select whether to display the monitoring line. If set to Yes, 
the monitoring line is displayed after clicking the sampling 
point on the HMI screen, and the monitoring line time is 
displayed at the upper left. 

Anti-aliasing 
Select whether to enable the anti-aliasing function. If select 
Yes, the element display becomes more delicate without 
jagged edges. 

Show Grid Select to display the circular grid, and configure the 
number of grids and time scale settings. 

Time Scale 
Display 

Select to display the time scale on the circular trend chart, 
and set the scale font and color. 
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Setting Description 

Channel Scale 
Display 

Select to display the channel scale on the circular trend 
chart, and set the scale font. 
Note: The scale color is displayed based on Line Color in 
the Historical data tab. 

Time/Date Select to display the current time at the upper left of the 
element, and set the format and color to display. 

 

• Historical data – Individual curve setting 

 

Follow these steps to configure the individual curve settings. 

To configure the individual curve settings 

1. Select the buffer data to be presented by this element, and the Buffer ID 

corresponds to the data number set in the History Buffer Setup dialog. 
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2. In the Style tab, set the Number of Curves, and then configure the individual 

curve settings table. The following table lists the settings of the individual 

curve settings table with their description. 

Setting Description 

Enable 

Set whether to enable the curve to read the data. 
• A value of 1 is enabled, and a value of 0 is not 

enabled. 
• The bit address can be set to enable curves 

dynamically on the HMI. 

Interlock State This setting is only available when Enable is set as a bit 
address. 

Length Select the read length according to the data source. 

Start Position Select the data start position, and it depends on the 
Read Length set in the History Buffer Setup dialog. 

Data Format 
Select the data format. 
Note: Floating can only be selected when the Read 
Length is 2. 

Integer Digits / 
Fractional Digits 

Select the integer digits and fractional digits to be 
displayed. 

Line Color Set the line color of the curve. 

Line Weight Select the line width of the curve. The range value is 1–
8. 

Minimum / 
Maximum 

Set the minimum and maximum values according to the 
Read Length and Data Format. 

Write Address Set the write address of the curve value on the 
monitoring line. 
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History Buffer Setting Example 

Follow these steps to add a history buffer and view the history data through the 

sampling element. 

1. In the History Buffer settings page. Click  on the toolbar to add Buffer 
Properties dialog. 

2. In the Buffer Properties dialog, set the buffer properties as shown in the 

following figure. 

 

The example of setting the Field Name of Export CSV File is shown in the 

following figure. 
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3. Create a Historical Trend Chart element on the screen, and then double-click 

the element to open the properties dialog. 

a. In the Style tab, select 3 for Number of Curves. 

b. In the Historical data tab, set Enable in Individual curve setting table to 1, 

and set the curve properties. 

c. In the Time/Date area, set the display method of time and date. 
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4. Create a Historical Data Table element on the screen, and then double-click 

the element to open the properties dialog. 

a. In the Style tab, set 3 for Column Counts. 

b. In the Historical data tab, set each property of the Individual curve setting 
table. 

c. Select the Time Format, Date Format, and Show Title checkboxes. 
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5. Create 3 Numeric Entry elements on the screen, and then set the Write 
Address is the read address of the history buffer $1000. 

6. Create 2 Momentary button elements on the screen, and then set the Write 
Address to $10.0 and $20.0 respectively, corresponding to the trigger bit and 

data clear bit. 

 

7. Download the screen to the HMI and enter the value within 100 to 3 Numeric 
Entry elements respectively. Click the button with the memory address of $10.0, 

and the Historical Data Table records the current value. Click $10.0 button 

again, and the historical trend chart draws the data curve. The following figure 

shows the execution result. 
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8. The historical data is synchronously written to the USB disk. The file path is 

HMI\HMI-000\History\CSV\H0001.csv, and the content of the CSV file is 

also written to the data content according to Field Name. 
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Enhanced Recipe 
Due to production needs, an enhanced recipe is provided that can record a mixture 

of alphanumeric (string) and numeric formats. The data type supported by the 

enhanced recipe is Word or Double Word and use the address of the control area 

different from the 16-Bit / 32-Bit Recipe to set the control area. When reading or 

writing recipes, you need to specify the recipe number and recipe group for reading 

and writing one of the recipes. 

The following table lists the definition of each enhanced recipe special registers. 

Register Name Definition 

ENRCP Enhanced Recipe Register 

ENRCPNO Enhanced Recipe Number Register 

ENRCPG Enhanced Recipe Group Register 

ENRCPGNAME Enhanced Recipe Group Name Register 
 

Enhanced Recipe Number Register (ENRCPNO) 

The enhanced recipe number register is used to specify the enhanced recipe 

number. Read and write a group of recipes according to the recipe number recorded 

in the recipe number register. For example, when selecting the first group of recipes, 

ENRCPNO = 1; when selecting the fourth group of recipes, ENRCPNO = 4. 
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Note: The enhanced recipe number registers do not have power-off retentive 

function. When the HMI is powered off, the data in the register cannot be retained. 

 

Enhanced Recipe Register (ENRCP) 

The recipe buffer is arranged in front of the recipe register. This area allows you to 

place a selected group of recipes. When the number of fields in the recipe buffer is 

the same as the number of fields in the selected recipe group, it means that the 

recipe buffer occupies L recipe registers. The number of recipe buffers occupied by a 

recipe table is L * (G+1), where G+1 represents the number of registers with one 

more set of buffers. 

 

The main purpose of the recipe buffer is that you only need to switch the number of 

recipe groups to know the currently specified recipe parameters. If the selected 

recipe group (ENRCPNO) is 1, and then the recipe buffer displays the first group 

recipe value, that is, ENRCPNO = 1. 
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Enhanced Recipe Group Register (ENRCPG / 
ENRCPGNAME) 

The enhanced recipe set selection register is used to specify the enhanced recipe 

set. Up to 255 sets of enhanced recipe data can be created. To call the enhanced 

recipe data, users must use recipe set 1~255 (ENRCPG 1~255). If enhanced recipes 

are enabled, the default value for the recipe set is 1. Therefore, if the first group of 

recipes for the first set of enhanced recipes is selected, that means ENRCPG = 1, 

ENRCPGNAME = chocolate, and ENRCPNO = 1. 
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ENRCPGNAME extracts the recipe content by entering the recipe name while 

ENRCPG enters a value from 1 ~ 255. 

ENRCPGNAME names the recipe group name in Unicode, you can enter the 

language of each country. With this register, you can enter the recipe name to call 

the recipe. It must be used with the Multi-Language Input element (available for 

DOP-100 series HMI) must be used with. 

Note: The enhanced recipe group register does not have the power-off retention 

function. When the HMI is powered off, the data in the register cannot be retained. 

 

Enhanced Recipe Quantity Limitation 

If the non-volatile data storage area is set in the USB disk or SD card, the maximum 

number of enhanced recipe files cannot exceed 256 fields X 10000 groups. If the 

non-volatile data storage area is set in the HMI, the editable size of the enhanced 

recipe depends on the flash memory specifications of different models. 

 

Enhanced Recipe Example 

The following table lists the example of operating the enhanced recipe. 

Set the enhanced recipe 

1. Click Data Management > Recipe > Advanced Recipe on the toolbar. 

2. Select the Enable checkbox in the enhanced recipe setting page, and then set 

Enhanced Recipe Address to $0. 

3. Click . 

4. Set the Name as Chocolate, Fields as 6, and Group as 5 in the Enhanced 
Recipe Setting dialog, and then click Next. 

5. Configure the data format. Do the following: 

• Set the 1st field as Unsigned Decimal and Length to 1. 
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• Set the 2nd field as Floating, and Length to 2, Integer Digits to 3, and 

Fractional Digits to 2. 

• Set the 3rd field as Char and Length to 5. 

• Set the 4th field as BCD and Length to 2. 

• Set the 5th field as Signed Decimal and Length to 1. 

• Set the 6th field as Hexadecimal and Length to 1. 

 

6. Click Finish, and then enter recipe data. 
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7. Add a new recipe, and then set Name to Strawberry, Fields to 6, and Group to 

3. 

8. Set the same data format and enter the recipe data. 

 

Create ENRCPG Numeric Entry element 

1. Create a Numeric Entry element. 

2. Set the Write Address to ENRCPG. This element is mainly used to select the 

enhanced recipe group. 

 

Create ENRCPGNAME Multi-Language Input element 

1. Create a Multi-language Input element. 

2. Set the String Length to 10. 

3. Set the Write Address to I ENRCPGNAME. This element is mainly used to 

select the enhanced recipe group by entering the recipe name. 
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Create ENRCPNO Numeric Entry element 

1. Create a Numeric Entry element. 

2. Set the Write Address to ENRCPNO. This element is mainly used to select the 

enhanced recipe number. 

 

Create ENRCP Numeric Entry element 

Before creating the Numeric Entry element to display the enhanced recipe register, 

the formula [(L*(G+1)-1)}] of the recipe register can be applied to calculate the 

number represented by n in ENRCPn. According to the configured recipe field length 

(L) is 3 X group number (G) is 3, substitute into the recipe, and the number ENRCPn 

is ENRCP0~ENRCP11. 

1. Create a Numeric Entry element and set the Write Address to ENRCP0. Set 

its representation mode according to the first field of the recipe table, select the 

Data Type as Word and Data Format as Unsigned Decimal. 

2. Create a Numeric Entry element and set the Write Address to ENRCP1. Set 

its representation mode according to the second field of the recipe table, select 

the Data Type as Double Word and Data Format as Floating, and then set the 

Integer Digits to 3 and Fractional to 2. 

3. Create a Multi-Language Input element and set the Write Address to 

ENRCP2. Set its representation mode according to the third field of the recipe 

table, select or enter the String Length as 10 

Note: One word length can store two characters. 

4. Create a Numeric Entry element and set the Write Address to ENRCP3. Set 

its representation mode according to the fourth field of the recipe table, select 

the Data Type as Double Word and Data Format as BCD. 

5. Create a Numeric Entry element and set the Write Address to ENRCP4. Set 

its representation mode according to the fifth field of the recipe table, select the 

Data Type as Word and Data Format as Signed Decimal, and then set its 

Maximum and Minimum. 
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6. Create a Numeric Entry element and set the Write Address to ENRCP5. Set 

its representation mode according to the sixth field of the recipe table, select the 

Data Type as Word and Data Format as Hexadecimal. 

7. Repeat steps 1 ~ 6 to create ENRCP6 ~ ENRCP23 elements in order and set 

their data formats. 

 

Note: ENRCP0~ENRCP5 is the recipe buffer, and the actual recipe data is 

ENRCP6~ENRCP23. 

Create recipe read controller address element 

Repeat steps 1~6 of the ENRCP address setting to create elements in order and set 

the Write Address to $0~$11 and set its Data Format. 

 

Set Enhanced Recipe Control 

Click General > Configuration on the toolbar, select the Enhanced Recipe Control 
checkbox in the Control Block page, and then set the start address of the control 

block to decide the recipe control address. 
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Create Momentary button element 

Create two Momentary Buttons elements, set the Write Address to $50.1 and $50.2 

respectively, corresponding to Bit 1 and Bit 2 of the recipe control flag to read and write 

recipes. 
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Result 

After completing the establishment and configuration of all elements, compile and 

download all data to HMI. You can select different enhanced recipe group according 

to your needs. 

The recipe data will be displayed in ENRCP0 ~ ENRCP11 according to the selected 

recipe group, among which ENRCP0 ~ ENRCP5 is the recipe buffer data, and the 

start address of the first group of actual recipe data is ENRCP6. 

 

Trigger the Recipe Write button, which will refer to the selected enhanced recipe 

group, and write the recipe data of this group to the PLC. Triggering the Recipe 
Read button will also refer to the selected enhanced recipe group, write the PLC 

data, and read it back to the selected data content of the formula group by HMI. 

• Write Recipe 

1. Set the recipe number and group to be written to the controller. 

2. Click Recipe Write To PLC to write the data in the recipe buffer to the 

controller address. 
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• Read Recipe 

1. Set the recipe group name on the HMI screen. 

 

2. Click Recipe Read From PLC to read the controller address data back to the 

specified recipe number. 
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Enhanced Recipe Attributes 

The following table lists the settings in the enhanced recipe setting page and their 

descriptions. 

Setting Description 

 Click to add a recipe. Up to 255 sets of recipes can be added. 

 
Click to delete a recipe. After the deletion, a message dialog 
displays, asking you whether to delete the enhanced recipe 
data. 

 

Click to import the recipe file. Support .csv and .xlsx file formats. 
Note: If the wrong file is opened, the recipe data will not be 
displayed normally, and an error message will be displayed 
after loading. 

 

Click to export the recipe files is .csv and .xlsx file formats. 
• The .csv file only records the data format of the recipe field 

and the content of the recipe data. 
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Setting Description 

 
• The .xlsx file records detailed recipe address information, 

including data format, recipe title, recipe group address or 
field read address. 
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Setting Description 

 

Click to clear all recipe contents. 

Before 

 

After 

 
 

 Click to set the Name, Fields, Group, and Data Format. 

Recipe Storage 

Select the recipe storage location. The options vary from the 
model, including HMI, USB Disk, USB Disk 2,and SD. 
If select HMI, the data will be recorded in the ROM of HMI when 
powering off. 

 

Click to switch to Continuous recipe address or Non-
continuous recipe address. 
Unclicking the Continuous Recipe Address icon, the Group 
addresses are consecutive checkbox displays on the recipe 
group page. 
• If select Group addresses are consecutive, you can set 

the group Read Address. Its address is the start address of 
the recipe group. 

• If unselect Group addresses are consecutive, the read 
address will be displayed in the recipe table, and the read 
address of each recipe field can be set individually. 

Enable Click to enable the enhanced recipe. If not selected, all 
enhanced recipe settings will be invalid. 
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Setting Description 

Enhanced 
Recipe Address 

Select internal memory or controller register address. 

If click , the start address of all enhanced recipes is the set 
address. 

(Groups, Fields) 
Search 

After entering the number of groups and fields to be searched, 
click this button to search.  

RCPNOname 
index 

After entering the RCPNO name to be searched, click this 
button to search. 

 

The following table lists the settings in the Enhanced Recipe Setting dialog and their 

descriptions. 

Setting Description 

Name Enter the group name of the enhanced recipe. Support Unicode 
input, you can enter the languages of each country. 

Field Select or enter the number of fields. Fields indicates the length 
and of the recipe. The value range is 1–2048. 

Group Select or enter the number of groups. Group indicates the 
length of the enhanced recipe. The value range is 1–65535. 

Data Format 

Select the data format. The options are BCD, Signed Decimal, 
Unsigned Decimal, Hex, Floating, and Char. 
Among them, the read length of the Char format supports up to 
32 Word lengths (that is, 64 characters), and supports Unicode 
input. 
Note: If select Char, do not fill in the value with the same 
character as the delimiter, otherwise, it will cause data errors 
and the data will fail to import. 

Length 

Select the read length. The read length varies from the data 
format. 

Data Format Length 
BCD 1: Word 

2: Double Word 
4: Quad Word 

Signed Decimal 
Unsigned Decimal 

Hexadecimal 

Floating 
2: Double Word 
4: Quad Word 

Char Supports up to 32 Words (64 
characters) 
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Setting Description 

Integer Digits 

This setting is available only when the Data Format is selected 
as Floating. 
Note: The sum of Integer Digits and Fractional Digits only 
supports 7 digits. 

Fractional Digits 

This setting is available only when the Data Format is selected 
as Floating. 
Note: The sum of Integer Digits and Fractional Digits only 
supports 7 digits. 
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OPC UA 
Use the OPC UA Client function to import tags from files or use Ethernet to connect 

to the OPC UA Server. This section introduces the setting instructions for OPC UA 

Client and OPC UA Server. 

 

OPC UA Client Settings 

To set OPC UA Client 

1. Create a project for a model that supports Ethernet. 

2. On the menu bar, click General > Device Communication. 

3. In the Device Communication dialog, click Ethernet1. 

4. In the Device tab, click  to add a new network connection, and then select 

the controller as OPC UA Client. 
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To import OPC UA Tag 

• Import from file 

1. In the Device Communication dialog, set the controller as OPC UA Client, 
and click Import. 

2. In the Tag List dialog, click  to import tag (XML or CSV file). 

Note: 

• The .xml file is a file exported by the OPC UA server. 

• The .csv file is a file exported by ISPSoft software. Follow the steps to 

export a .csv file. 

a. In ISPSoft software, in Project pane, double-click Global Symbols > 

OPC UA Table. 

b. In the OPC UA Table dialog, right-click an empty space and select Add 
a Symbol to create the symbol. 

c. Export the global symbol table. Do any of the following: 

 Right-click an empty space and select Export Global Symbol. 

 In Project pane, right-click OPC UA Table and select Export Global 
Symbol. 

 

Note: The OPC UA Server function is currently only available for AS-300 

series models. It requires an additional AS-FOP02 communication card 

and ISPSoft version 3.13 and above. 



 

OPC UA 
 

 

317 DIAScreen V1.6.0 

• Import Tags from OPC UA Server 

1. In the Device Communication dialog, after setting Controller as OPC UA 
Client, enter IP address and communication port of the OPC UA server in 

Controller IP field. 

 

2. Click Import. 

3. In the Tag List dialog, click . 

The Tag has been imported to the OPC UA Server through the set IP 

address. The tag list can be viewed. 
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Using OPC UA Tag 

• Used for elements: In the Read Address / Write Address dialog, select 

EtherLink1 for Link. 
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• Userd for macro commands: In the macro editing dialog, click  and enter 

macro command. If the variable content selects OPC UA Tag, OPC UA Tag 

automatically adds single quotes after updating the macro; if you use  to 

input OPC UA Tag, you need to manually add single quotes before and after the 

OPC UA Tag. 

 

The following table lists the supported OPC UA Tag NodeID types and OPC UA Tag 

data types. 

OPC UA Tag NodeID Type Support List 

NodeID (Identifier Type) Scalar Array 

I (Numeric)  V V 

B (Opaque) V - 

S (String) V V 

G (GUID) V - 

Data Type Scalar Array 

Boolean V V 

Byte V V 

Int32 V V 

Int16 V V 

Int64 V V 

Double V V 

Float V V 

SByte V V 

String V V 

UInt32 V V 

UInt16 V V 

UInt64 V V 
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OPC UA Server Settings 

Set the communication address as an OPC UA variable through the OPC UA Server. 

Note: This function only supports DOP-107WV, DOP-103WQ, DOP-110WS, DOP-

112MX, DOP-115MX, DOP-112WX, DOP-115WX, and DOP-300 series models. 

How to open OPC UA server? 

• In Project pane, double-click OPC UA Server. 

Or 

• Click IIoT > OPC UA Server on the menu bar. 

The following table lists the functions in the OPC UA Server dialog with their 

description. 

Function Description 

 Click to add a new group. 

 

Click to add a new tag. 
Note: Address is required. If not set, a message appears to inform you 
that the address input failed. 

 
Select the tag or group you want to delete, then click this icon to 
delete. 

 

Select the tag or group you want to edit, then click this icon to edit its 
properties. 
Note: You can double-click a tag or group to edit properties. 

 

Follow these steps to apply the OPC UA server tag to the element. 

To apply OPC UA server tag to element 

1. Create an element. 

2. In the address Input dialog of the element, select OPCUA Server for Link. 

Tags display in the list below. 

3. Select the tag you want to apply to the element, and click OK. 
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OPC UA Security Policy and User Authentication 

In OPC UA (Open Platform Communications Unified Architecture), security can be 

ensured through account authentication and encrypted communication. The account 

authentication is the most basic and simple. Enter the user's account name and 

password and have the server verified the credentials and allow access if they 

match. 

Note: This function is only available for DOP-300 series models. 

Follow these steps for OPC UA authentication. 

• OPC UA Client 

1. In the Device Communication dialog, click Ethernet1. 

2. In the Device tab, select OPC UA Client for Controller, and the Certification 

tab displays. 
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The following table lists the functions in the Certification tab with their description. 

 

 Security 

Function Description 

Security Policy 
Select a security policy. The available options include 
None, Basic128Rsa15, Basic256, Basic256Sha256, 
Aes128Sha256RsaOaep, and Aes256Sha256RsaPss. 

Message Security 
Mode 

Select a message security mode. The available options 
include None, Sign, and Sign & Encrypt. 

 

 Authentication 

Function Description 

Anonymous 
Choose anonymous login or user login. Username/Password 

Login 
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• OPC UA Server 

In the OPC UA Server dialog, click  to open OPC UA server settings 

dialog. 

The following table lists the functions in the OPC UA server settings dialog with 

their description. 

 

Function Description 

General 

Port Number 
Select or enter the port number. The range 
value is 0–65535, and the default value is 
4840. 

Security Policies 

Check the security policy and select message 
security mode. 
• Security policy options include None, 

Basic128Rsa15, Basic256, 
Basic256Sha256, 
Aes128Sha256RsaOaep, and 
Aes256Sha256RsaPss. 

• Message security mode options include 
None, Sign, and Sign & Encrypt 

Verification 
Allow anonymity If selected, check at least one of the options - 

Browse, Read, or Write. 
Username & 

Password 
If selected, Name and Password should not 
be vacant. 
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MQTT Settings 

HMI sends messages through an object to the MQTT server or subscribes to a topic 

from the MQTT server. It can also be an MQTT server. When the HMI is an MQTT 

server, the messages will not be sent to other servers. 

 

MQTT Broker 

You need to add a Broker to enable MQTT functions. 

To add a Broker 

1. Click IIoT > MQTT Settings on the toolbar. 

2. In the MQTT Settings dialog, click  to add a Broker on the toolbar. 

Note: Supports up to 5 MQTT Broker for one HMI. 

3. In the MQTT Broker Information dialog, enter the information for the Broker in 

the General tab. 
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Note: In the MQTT specification, each client will have a Client ID, allowing the broker 

to determine where the data is sent, but if the Client ID is duplicated, the client that 

connects later will fail to connect. In order to avoid duplicate client IDs, HMI provides 

two variables, %0 (HWID) and %2 (Random Code) settings, where HWID is an 

internal parameter and is a unique identification code in the HMI, and different 

machines will have their own HWID. 

 

Will Message 

The Will Message is a simplified version of the PUBLISH message. It is specified 

through the CONNECT packet when the device is connected to the server. The 

server publishes Will Message to the Will Topic specified when the device is 

unexpectedly disconnected, the server must complete the storage of the Will 

Message before responding CONNACK to ensure that the message is published. 

Follow these steps to set up Will Message. 

To set up will message 

1. In the MQTT Broker Information dialog, set up Will Message. 
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2. Open MQTTX software and set up the Will Message Subscriber of the MQTT 

connection. 

Note: You can go to mqttx.app/zh to download the MQTTX software. 

 

 

https://mqttx.app/zh
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When the HMI is disconnected, MQTTX receives the WILL Message. 

 

3. In the MQTTX tool, click  and reconnect to receive the WILL retained 

message. 
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Address Setting 

The States Address function displays the current connection status and error codes 

of the Client and Server. The connection state helps you check whether the device is 

disconnected. If disconnected, you can check the type of the current communication 

error through the error codes and set the Control Address on the HMI to change the 

connection message, such as Broker IP, Port, account, password, and so on. 

To set states address and control address 

• In the MQTT Broker information dialog, set the current States Address and 

Control Address in the Address tab to automatically configure all controls 

through the continuous address function. 

Note: The States Address and Control Address limit setting the internal 

memory address. 

 

The following table lists the internal addresses limited by States Address with their 

description of error codes. Set the States Address to $180 as an example. 
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Address Error Code Description 

$180 (Status address) 
• 0: Stopped 
• 1: Disconnected 
• 2: Connected 

$181 (Error address) 

• 0: No errors 
• 3: Invalid parameter 
• 4: Client is not connected to Broker 
• 7: Disconnected 
• 14: Underlying system calls failed 

Note: Look over and judge from the system log or 
other relevant messages for detailed error 
messages. 

• 15: Network address analysis error or not use the 
external network to connect 

• 99: JSON data type is not yet supported 
 

The following table lists the internal address limited by Control Address with their 

description of error codes. Set the Control Address to $200 as an example. 
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Address Error Code Description 

$200 
(Command address) 

• 0: None 
• 1: Start 
• 2: Stop 
• 3: Update 

$201~204 
(Broker IP address) 

Used to set the IP address for which the Data Type is 
Word. 

$206 (Client ID) A maximum of 20 bits are supported. 

$226 
(Authentication address) 

• 0: Disabled 
• 1: Enabled 
Note: This address is based on whether the 
Certification Information is enabled. 

 

$227~242 
(Username address) 

Used to configure the user account address. 
Set the Character Input element for which the string 
length is 16. 

$243~259 
(Password address) 

Used to configure the password address. 
Set the Character Input element for which the string 
length is 16. 

 

The following figure is an example of the screen configuration. 
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After downloading the screen to the HMI, the addresses are shown in the figure 

below. 

 

 

MQTT Publisher & Subscriber 

This section describes the properties content of Publisher and Subscriber. 

Note: Publisher and Subscriber can add up to 100 topics each. 

 



 

MQTT Settings 
 

 

332 DIAScreen V1.6.0 

General Properties 

 

Function Description 

Topic 

• In order to reduce the possibility of duplicate topics and 
make it easier for users to distinguish where data is being 
sent and received from, you can set the topic as a variable, 
providing %0 as HWID and %1 as the Client ID.  

• DOP-300 series HMI can dynamically set the topic. After 
configuring the address variable for the topic content, the 
topic content can be dynamically changed through the 
address variable on the HMI to obtain different topic 
messages. 
Follow these steps to set the topic. 

1. Click  in the Topic field on the General Properties tab 
or in the Topic field on the Publisher or Subscriber list. 
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Function Description 

 
2. In the Address Settings dialog, set Variable definition 

and Topic address and click OK. 
Note: 

 The setting formats are %s: String, %f: Floating, %d: 
Decimal, and Hexadecimal. 

 
 The maximum number is 8. 

3. Enter the variable definition in the Topic field in the 
General Properties tab, for example, %s1%d2%f3. 

4. Execute on the HMI. When the topics of Publisher and 
Subscriber are the same, the HMI sends the corresponding 
data. 
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Function Description 

 

Sampling 
method 

Select the sampling method during execution. 
• Value Change: Sampling when the value changes. 
• Timed Execution: Sampling according to the set sampling 

time. 
Note: This function is only available in the Publisher properties. 

Retain Message 

When Publisher publishes a message, if the Retained mark in 
the MQTTX software is set as True, the message is a Retain 
Message in MQTT. The MQTT server stores the latest retain 
message for each topic so that clients that come online after the 
message is published can still receive the message when 
subscribing to the topic. 
Note: This function is only available in the Publisher properties. 

Content format 

Select the content format. 
• JSON (General): Basic JSON format. 
• JSON (Advanced): You can customize the JSON format of 

the nested structure. 
Note: JSON (Advanced) is only supported in the DOP-300 
series HMI. 

Timestamp / 
Use “d” for the 

top level 

• Timestamp and d message format may not exist in different 
application scenarios. However, the default MQTT Message 
function of Delta HMI displays these two pieces of 
information. In case the messages received when receiving 
data do not contain these two pieces of information, the 
communication fails. It is suggested to enable Time stamp 
and Use “d” for the top level functions. 

• Confirm whether the timestamp and “d” mark appear in the 
JSON format of the HMI topic through the MQTTX software. 
Note: Go to mqttx.app/zh to download the MQTTX software. 

 
Timestamp: 

https://mqttx.app/zh
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Function Description 

 
Use “d” for the top level: 
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Content Settings 

JSON (General) 

DIAScreen provides Unsigned Decimal, Signed Decimal, Floating, Hexadecimal, and 

Char numeric formats with different numerical units for users to set according to the 

data size to transfer. 

 

JSON (Advanced) 

Note: 

• This function is only supported in the DOP-300 series HMI. 

• Advanced JSON format can set up to 8 layers of nodes. 

• A maximum of 512 nodes can be set for a topic. 

The following lists the toolbar settings in the Content Settings tab for JSON 

(Advance) with their description. 
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Function Description 

 

Click to add an object. The JSON format is represented by { }. 

 
Note: The maximum name input length is 256 characters. 

 

Click to add a general array. The JSON format is represented by [ ]. 

 
Note: 
• The maximum name input length is 256 characters 
• The names of child nodes under general arrays cannot be 

edited, and the software will automatically name them with [0] ~ 
[n]. 
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Function Description 

 

 

Click to add a Numeric array. In the Numeric Array dialog, set 
Name, Type, Address, and Size for a numeric array. 

 
Note: The maximum name input length is 256 characters. 
The following figure shows the JSON format of a numeric array. 

 
 

Click to add a value. In the Numerical Value dialog, set Name, 
Type, Timestamp, and so on for a numerical value. 
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Function Description 

 
Function Description 

Name 
Enter a value name. 
Note: The maximum input length is 256 characters. 

Type Select the numerical type. The default is String. 

Numerical 

Select the numerical format. The default is Address. 
Note: 
• When String is selected as Type, a maximum of 

256 characters can be entered for a Fixed Value. 
• When Quantity is selected as Type, up to 20 

characters can be entered for a Fixed Value. 
• When setting Subscriber topic content, the Fixed 

Value option is not available and the Timestamp 
option is limited to one topic selection. 

 
The corresponding JSON format of each numerical type is shown in 
the following figure. 
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Function Description 

 

 

 

Select the node to be deleted and click this icon to delete. 
Note: Its child nodes will be deleted together. 

Before 
delete 

 

After 
delete 

 

 

 Select the node to be edited and click this icon to edit. 
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Function Description 

 

Select the node to be copied and click this icon to copy and paste. 
Note: Its child nodes will be copied together. 

Copy 

 

Paste 
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Function Description 

 

Click to use a template. In the JSON Text dialog, fill in the JSON 
format, the corresponding tree structure will be automatically 
converted. 

JSON text 
content 

 

Tree structure 
after conversion 

 

Note: 
• The Value node in the Publisher topic settings is converted to a 

Fixed Value. 
• The Value node in the Subscriber topic settings is converted to 

an Address Value. 
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Function Description 

 

Click to preview the JSON format. The tree structure content will be 
converted to the corresponding JSON format. 

Tree structure 
content 

 

JSON text 
content after 
conversion 

 

 

 

Support Azure IoT Hub and Aliyun Server 

MQTT supports Azure IoT Hub and Aliyun server. The applicable models are as 

follows. 

• Azure IoT Hub server: All series models 

• Aliyun server: DOP-300 series models 
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The comparisons between Azure IoT Hub and Aliyun server are as follows. 

 Azure IoT Hub Aliyun 

Cert certificate version TLS 1.2 and above TLS 1.2 and above 
QoS 0, 1 0, 1,2 
Communication MQTT v3.1.1 MQTT v3.1.1 
Default port 8883 8883 

 

MQTT Broker Information Settings Limit 

• When selecting Azure IoT Hub or Aliyun for Server, Communication can only 

be selected as MQTT v3.1.1. 

• When selecting Azure IoT Hub for Server, QoS can only be set to 0 or 1. 

• When selecting Azure IoT Hub and Aliyun for Server, Version can only be set 

to TLS1.2 in the Certificate file dialog of the Cert field. 
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• When selecting Aliyun for Server, Content format can only be set to JSON 
(Advanced) in the property dialog of the Publisher and Subscriber tabs. 

• When selecting Azure IoT Hub for Server, in the MQTT Subscriber Property 

dialog of the Subscriber tab, the Topic field requires two special open symbols, 

such as # and #, and # can only be placed in the end of the final level. 

Example: 

 # symbol 

Enter devices/Delta_HMI/messages/events/#, other characters must not be 

entered after the # symbol. 

 + symbol 

Only /single-level message can be entered after the + symbol, for example, 

devices/+/temperature. If you enter two levels of message, you will not be 

able to receive the information. 

• When selecting Amazon AWS for Server, you need to verify its credentials. 

Without a credential, you cannot use the Amazon AWS server. 
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IIoT 
IIoT integrates the cloud platform for DIAScreen, which can upload DIAScreen 

projects to the cloud or download projects from the cloud to DIAScreen for editing. At 

the same time, the HMI can also transmit data to the cloud and monitor the device 

through the configuration screen of the cloud platform. 

Note: This function is only applicable to DOP-300 series models. 

To create a template and upload it to the cloud 

1. On the menu bar, click IIoT > DIACloud > Cloud Template. 

2. In the Cloud Template dialog, check Enable cloud templates. 

Note: The VNC function will be enabled at the same time to monitor the HMI 

screen from the cloud. 

3. In the Upload Template area, click Create New Template. 

4. In the Template Information area, click Edit Template to edit template. 

5. In the Cloud Template Information dialog, enter the template information and 

click OK. 

The template is created. 

6. Click Login in the upper right corner to open Login to DIACloud dialog. 

7. In the Login to DIACloud dialog, enter your DIACloud Account and Password, 

and then click Login. 

Note: If you have not registered a DIACloud account, go to 

hms.diacloudsolutions.com to register. 

8. Click Transmission starts to start to upload the DIAScreen project to the cloud. 

https://hms.diacloudsolutions.com/
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You can also create cloud data in DIAScreen so the configuration screen can 

reference the corresponding variables to monitor the device. 

To create Cloud Tag 

1. On the menu bar, click IIoT > DIACloud > Cloud Tag. 

2. In the Cloud Tag dialog, click  to add a new tag. 

3. Make relevant settings and click OK. 

 

Note: 
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• Cloud tag supports BOOL, UINT16, UINT32, UINT64, INT16, INT32, INT64, 

REAL, LREAL and STRING data types. The corresponding data type can be 

selected based on the actual data value. 

• If the currently edited project has been bound to a template, you need to log in 

to DIACloud before opening the Cloud Tag dialog to ensure that the tag content 

is synchronized with the cloud. 

• If the cloud tag is used in the configuration screen, some fields in the Cloud Tag 

will be grayed out and cannot be edited. 

 

You can also download projects to DIAScreen from the cloud. 

How to enable cloud templates? 

• In the main menu, click Open Cloud Template. 

Follow these steps to download a project from the cloud to a template. 

To download projects to templates from the cloud 

1. Click Login to log in to DIACloud. 

2. Select the template you want to download. 

3. Click OK to start the transfer. 
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Address Conversion 
After selecting an element on the screen, modify all the addresses of the selected 

element directly in the list through the address conversion function. You can also 

replace the address for a specific element. 

How to open Address Conversion? 

• On the menu bar, click Tools > Address Conversion. 

Or 

• Right-click the element and select Address Conversion. 

The following table lists the settings in the Address Conversion dialog with their 

description. 
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Legend Function Description 

 
Hide 

unaddressed 
items 

Select to hide items whose addresses are not set. 

Function Illustration 

Unselected 

Display addresses with None. 

 

Selected 

Hide addresses set to None. 

 
 

 
Hide constant 

items 

Select to hide addresses set to constant, such as 
element position and upper/lower limit value. 

Function Illustration 

Unselected 

Display constant addresses. 

 
Selected Hide constant addresses. 
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Legend Function Description 

 
 

 
Hides 

unchanged 
items 

If selected, only items with changes to The Converted 
Address field will be displayed. 

Function Illustration 

Unselected 

Display all element addresses. 

 

Selected 

Hide unchanged items. 

 
 

 
Automatically 

adjust all 
addresses 

Select to adjust all addresses automatically. Changing 
the address of the first item in The Converted Address 
column and then selecting the item will automatically 
offset The converted address according to the original 
address offset. 
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Legend Function Description 

 

 Display type Select the type of address to display in the address list. 
The default is All addresses. 

 
Address 

Search and 
Replace 

Enter Find What and Replace With to find and replace 
the string with a new string. 
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All Tags 
You can convert a memory address to tag through the DIASceen Tag configuring 

function for use as well as use the import function of different files to import the 

variables declared in the programming software to DIAScreen. 

 

DIA Tag 

Synchronize the global variables declared in DIADesigner through DIA Tag function 

to DIAScreen and use. The following describes the setting method of DIA Tag. 

DIADesigner operation 

1. Create a project. 

2. In Project Explorer, add a controller device. 

3. Double-click Programming, right-click Global Variable, and then select Add 
Global Variable Table. 

4. In the Add Global Variable Table dialog, enter the Name and Comment, and 

then click OK. 

5. In the Global Variable table, add variables. 

Note: The variable address must be configured. If not configured, DIAScreen 

will not be able to use the Tag. 

6. Click Compile on the toolbar. 

 

DIAScreen operation 

1. Create a project. 

2. In the Device Communication dialog, select Delta controller. 

Note: The controller type must be the same as the controller type created in 

DIADesigner. 

3. In the Project pane, double-click DIA Tag. 
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4. In the DIA Tag settings page, click . 

5. In the DIA Tag Import Settings dialog, select a DIADesigner project file 

(.diade). 

6. Select a Link Name. The communication parameters of the connection are 

listed in the dialog. 

7. Set the Station No. 

Note: 

• The Don’t specify station number checkbox is selected by default. The 

Station No. field is available only when the DIA Tag is used on the element. 

• If unselect the Don’t specify station number checkbox, the specified station 

number can be entered in the Station No. field. 

8. Click OK. 

9. In the DIA Tag setting page, click  to enable DIA Tag automatic 

synchronization. 

10. In the DIA Tag Synchronization Settings dialog, select Enable automatic 
sync checkbox and set Automatic check cycle. 

11. Create an element on the screen, and then double-click it. 

12. In the address Input dialog of the element, select DIA Tag for Link. The 

variables are listed in the dialog. 

Note: You can also export .diatag files from ISPSoft or DIADesigner software, and 

select DIATag File (.diatag) in the DIA Tag Import Settings dialog to import the files, 

but tags of this file type do not support Synchronization function. 

 

Tag 

You can add tags of different types in the tag page or declare structures and arrays 

of user-defined data types as tags. 

The following table lists the functions of Tag Property Setup dialog with their 

description. 
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Function Description 

Name 

Enter a tag name. The naming convention is as follows: 
• The name cannot exceed 220 bytes, and one Chinese 

character occupies 2 bytes. 
• The name cannot start with a number. 
• System reserved keywords, such as recipe register address 

RCP, cannot be used. 
• Decimal points, square brackets, and @ symbol are not 

allowed in names. 
• The name should be in the same language as the operating 

system (except English and number). Using a language 
different from the system language will result in garbled 
characters. 

Address 
Set the address corresponding to the tag. 
Note: Configure an address of sufficient length according to the 
selected Type. 

Description Enter a description for the tag. 

Length 
Select or enter a length. 
Note: This function is only available when Basic Type is STRING 
or WSTRING. 

Type 
• Basic Type 

The following table lists the format and description of each Basic 
Type. 
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Type Description 

BOOL 
1-Bit value format, which can only be used for bit 
control addresses, such as bit-type button 
elements. 

INT Word unit and signed integer format 
DINT Double Word unit and signed integer format 
LINT Quad Word unit and signed integer format 

WORD Word unit value format 
DWORD Double Word unit value format 
LWORD Quad Word unit numerical format 

REAL Floating point value format of Double Word unit 
LREAL Floating point value format of Quad Word unit 
UINT Word unit and unsigned integer format 

UDINT Double Word unit and unsigned integer format 
ULINT Quad Word unit and unsigned integer format 

STRING String format, 1 ASCII character is 1 byte, up to 
128 bytes. 

WSTRING String format, 1 ASCII character is 1 byte, up to 
256 bytes. 

• User-defined Data Type 
Create a user-defined type on the structure or array page. You 
can create a tag for the user-defined type in the tab page. 

 

Tag Import 

The set tags can be exported as XLSX files and imported into Excel after editing. 

CSV files of variable tables edited by external software can also be imported into 

DIAScreen for programming. 

Note: You need to clear the current tag content before importing the tag. 

Tags usage 

In the element address Input dialog, select Tag for Link name, and then select the 

tag. The element address will be presented as a tag name. 
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User-defined Data Type 

A user-defined data type (also called DUT (Data Type Unit) or UDT (User-defined 

Data Type)) is a data type that is combined by users using existing basic data types. 

 

Structure 

A structure consists of a fixed number of elements of various data types, and a 

structure or array element can also serve as an element of another structure. 

Structures can be used to define grouped data and to transmit parameters as a data 

unit. 

Follow these steps to build a structure. 

To build a structure 

1. In User-defined Data Type page, click +Structure to add a structure. You can 

edit the structure name in the Name field. 

2. Select the data type. 
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3. Select Structure and click +WORD. A new element will be added under the 

structure, and the element name can be edited in the Name field. 

The naming rules for structure names and element names are as follows: 

• Structure names must not be repeated. 

• It is not allowed to add new elements with duplicate names in the same 

structure. 

• The maximum length of the structure name and element name is 32 characters. 

• Structure names and element names cannot have spaces, and cannot use 

special characters such as * # ? \ % @ [] () . , etc. 

• Structure names should be in the same language as the operating system 

(except English and number). Using a language different from the system will 

result in garbled characters. 

 

Array 

An array consists of fixed length and the same data type. 

Follow these steps to create an array. 

To create an Array 

1. In User-defined Data Type page, select a data type. 
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2. Click +WORD to add a new array. In the Name field, edit the array name. 

The naming rules of array names are as follows: 

• Array names must not be repeated. 

• The maximum length of the array names is 32 characters. 

• Array names cannot have spaces, and cannot use special characters such as * 

# ? \ % @ [] () . , etc. 

• Array names should be in the same language as the operating system (except 

English and number). Using a language different from the system will result in 

garbled characters. 
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Address Settings 
Each HMI function needs to be executed through address concatenation, you can 

set the address in the element property dialog. The address settings include Internal 

Memory Address and External Controller Address. This section describes various 

address definitions and their setting methods. 

 

Internal Memory 

Delta HMI has a total of 13 types of registers with different functions. 

1. Internal register $ 

2. Non-volatile internal register $M 

3. Indirect address register *$ 

4. Extended memory EM0~15 

5. Recipe register RCP 

6. Recipe number register RCPNO 

7. Recipe group register RCPG 

8. Recipe indirect addressing register *RCP 

9. Enhanced recipe register ENRCP 

10. Enhanced recipe number register ENRCPNO 

11. Enhanced recipe group register ENRCPG 

12. Enhanced recipe group name register ENRCPGNAME 

13. Enhanced recipe indirect addressing register *ENRCP 

Types 5~13 belong to recipe addresses. For detailed description, see the manual of 

the recipe. 
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Internal Register ($) 

The Internal Register is the HMI internal memory that freely reads data and supports 

all kinds of configurations, such as the communication address of the element. 

The HMI can access 200,000 sets of 16-bit internal registers. 

Note: The internal register does not have a power-off retention function, so the data 

in the register is not retained when the power is off. 

Access Type Element Type Access Range 

Word $n $0~$199999 

Bit $n.b $0.0~$199999.15 

Note: n is Word (0~199999); b is Bit (0~15). 
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Non-volatile Internal Register ($M) 

The Non-volatile Internal Register provides a power-off retention function. The data 

in the register is retained when the power is off so that you can record important data 

in this register. The HMI can access 5000 sets of 16-bit non-volatile internal registers 

($M0.0~$M4999.15). 

Access Type Element Type Access Range 

Word $Mn $0~$4999 

Bit $Mn.b $0.0~$4999.15 

Note: n is Word (0~4999); b is Bit (0~15). 

 

Indirect Address Register (*$ / *D$) 

The Indirect Address Register uses the value of the internal memory as the address, 

and assigns the address value to the corresponding Indirect Address Register of 

the internal memory. 

Access Type Element Type Access Range 

Word *$0~*$199999 $0~$199999 

Double Word *D$0~*D$199998 $0~$199998 
 

Indirect address register *$n or *D$n, obtains the value from the internal memory $n, 

sets the value as a new address, and then accesses the value from the new 

address. For example, $10 = 101, $101 = 55, then *$10 = 55. 
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If the address assigned by the internal memory exceeds the value of one Word 

(65535), the indirect address register must use *D$ and obtain the value in Double 

Word format. 

Note: The indirect address register does not have a power-off retention function, so 

the data in the register is not retained when the power is off. 

 

Extended Memory 

The Extended Memory (EM) can store data on an external storage device so that the 

data can be retained even after the HMI is powered off. The elements on the HMI 

screen are also read and written through the extended memory. 

• The extended memory has 16 groups (EM0~EM15). 

• Supports file storage in external storage devices (USB, USB 2 disk and SD 

card). 

• Each EM is a file, supporting a maximum of 512MB. 

• Values can be read and written into the file. 

• The maximum Word address is 268435455, and the last Word of the 512MB file 

can be read. 

• The address of the last Bit is EM0_268435455.15. 

• EM addresses can be used in elements and macro functions, and can also be 

used to create data codes. 

Follow the steps to set the extended memory. 

1. On the toolbar, click Project > Other Settings > Extended Memory Settings. 

2. In the Extended memory settings dialog, set the file name corresponding to 

each EM area. 

The file name supports multiple languages, and the maximum file name length is 

(32*4) bytes. The file extension stored on the external storage device is .emi. 
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3. In the address Input dialog of the element, select Internal Memory for Link, 

select EM0~EM15 for Device Type, and then enter the read and write address. 
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The following table lists the API for LUA applications to read and write extended 

memory. 

Command Description 

mem.em.Read (EMID, addr, [FORMAT]) Read 1 WORD from the addr 
address of EMID 

mem.em.Write (EMID, addr, value) Write 1 WORD from the addr 
address of EMID 

mem.em.ReadDW (EMID, addr, [FORMAT]) Read 1 DWORD from the addr 
address of EMID 

mem.em.WriteDW (EMID, addr, value) Write 1 DWORD from the addr 
address of EMID 

mem.em.ReadQW (EMID, addr, [FORMAT]) Read 1 QWORD from the addr 
address of EMID 

mem.em.WriteQW (EMID, addr, value) Write 1 QWORD from the addr 
address of EMID 

mem.em.ReadBit (EMID, addr, bit_index) Read the bit_index value from 
the addr address of EMID 

mem.em.WriteBit (EMID, addr, bit_index, value) Write the value from the addr 
address bit_index of EMID 

mem.em.ReadFloat (EMID, addr) Read 1 Float from the addr 
address of EMID 

mem.em.WriteFloat (EMID, addr, value) Write 1 Float from the addr 
address of EMID 

mem.em.ReadDouble (EMID, addr) Read 1 Double from the addr 
address of EMID 

mem.em.WriteDouble (EMID, addr, value) Write 1 Double from the addr 
address of EMID 

mem.em.ReadASCII (EMID, addr, length) Read length characters from the 
addr address of EMID 

mem.em.WriteASCII (EMID, addr, string, length) Write length characters from the 
addr address of EMID 

 

DXMC Series Internal Memory Address 

The following table lists the internal memory address range of Word elements. 
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Register Type 

Symbol 
Format Read and Write Address 

Range 
Data 

Length Remark 
Word 
No.(n) 

X_Register Xn X0~X1FFFFF Word Hexadecimal 
Y_Register Yn Y0~Y1FFFFF Word Hexadecimal 

DV_Register DVn DV0~DV262143 Word Even 
addressing 

DH_Register DHn 

• DXMC-1H08AD-70, 
DXMC-1H08CD-7S, 
DXMC-1H08ED-7S: 
DH1000000~DH1061439 

• DXMC-1P08NE-4S/70/7S, 
DXMC-1P04NE-7S, 
DXMC-1FA1RN-70F: 
DH1000000~DH1024575 

• DXMC-1FA2RN-70F: 
DH1000000~DH1049151 

Word Even 
addressing 

SDV_Register SDVn SDV3000000~SDV3065535 Word Even 
addressing 

SDH_Register SDHn 

• DXMC-1H08AD-70, 
DXMC-1H08CD-7S, 
DXMC-1H08ED-7S: 
SDH6000000~SDH6065535 

• DXMC-1P08NE-4S/70/7S, 
DXMC-1P04NE-7S, 
DXMC-1FA1RN-70F: 
SDH6000000~SDH6004095 

• DXMC-1FA2RN-70F: 
SDH6000000~SDH6008191 

Word Even 
addressing 

RP_Register RPn RP0~RP7FFFFF Word Hexadecimal 
Controller CRn CR0~CR14FFFFF Word Hexadecimal 

MW_Register MWn MW0~MW67108863 Word Even 
addressing 

MD_Register MDn MD0~MD67108863 Word Even 
addressing 

ML_Register MLn ML0~ML67108863 Word Even 
addressing 
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The following table lists the internal memory address range of Bit elements. 

Contact Type 

Symbol 
Format 

Read and Write Address Range Remark 
Byte No.(n);  

Bit No.(b) 
X_Coil Xn.b X0.0~X1FFFFF.15 Hexadecimal 
Y_Coil Yn.b Y0.0~Y1FFFFF.15 Hexadecimal 

DV_Coil DVn.b DV0.0~DV262143.7 - 

DH_Coil DHn.b 

• DXMC-1H08AD-70, 
DXMC-1H08CD-7S, 
DXMC-1H08ED-7S: 
DH1000000.0~DH1061439.7 

• DXMC-1P08NE-4S/70/7S, 
DXMC-1P04NE-7S, 
DXMC-1FA1RN-70F: 
DH1000000.0~DH1024575.7 

• DXMC-1FA2RN-70F: 
DH1000000.0~DH1049151.7 

- 

SDV_Coil SDVn.b SDV3000000.0~SDV3065535.7 - 

SDH_Coil SDHn.b 

• DXMC-1H08AD-70, 
DXMC-1H08CD-7S, 
DXMC-1H08ED-7S: 
SDH6000000.0~SDH6065535.7 

• DXMC-1P08NE-4S/70/7S, 
DXMC-1P04NE-7S, 
DXMC-1FA1RN-70F: 
SDH6000000.0~SDH6004095.7 

• DXMC-1FA2RN-70F: 
SDH6000000.0~SDH6008191.7 

- 

SM_Coil SMn.b SM0.0~SM8191.15 - 
MX_Coil MXn.b MX0.0~MX67108863.7 - 
MW_Coil MWn.b MW0.0~MW67108863.7 - 
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Internal Parameter 

The Internal Parameter can access the HMI internal state values, including system 

time value, external storage device status, X / Y coordinates when touching, touch 

status, remaining battery voltage in percentage, network parameters, firmware 

version, extended memory status, and so on. 

 

Note: Internal Parameter is available only for Word elements. You are unable to use 

this function if you create Bit elements. 

The following table lists each internal parameter with their descriptions. 

System Setting 

Parameter Definition Description 

BATTER_ 
VOLTAGE 

Remaining 
HMI battery 

The display unit is percentage. 
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Parameter Definition Description 

LANG_OF_ 
SYSMSG 

Display 
language of 

the HMI 
directory 

State Value Language 
0 English 
1 Tradition Chinese 
2 Simple Chinese 
3 Spanish 
4 French 
5 Russian 
6 Turkish 

Follow these steps to set the system menu 
language. 
1. Create an element such as Numeric Entry 

element. 
2. In the address input dialog of the element, 

select Link name as Internal Parameter, 
and the Device Type as 
LANG_OF_SYSMSG. 

 
3. Download the screen to the HMI and change 

the value of the element on the HMI. 
4. Press and hold the screen for 2 seconds, 

and the system menu button appears on the 
top left of the screen. 

 
After entering the system menu, you can 
see the display language changes. 
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Parameter Definition Description 

 

SP_BRIGHT 
Backlight 

brightness of 
HMI 

The display unit is percentage. 

SYS_BUZZER_
VOLUME 

Buzzer 
volume 

The display unit is percentage. The value range 
is 0–100. 

BTN_BUZZER_
VOLUME Touch-tone The display unit is percentage. The value range 

is 0–100. 

FW_VERSION1 

Major version 
number of HMI 

firmware 
version 

 
• When setting this parameter, set the Data 

Format to Hexadecimal. 

 

FW_VERSION2 

Minor version 
number of HMI 

firmware 
version 

Loaded 
CODESYSTags 

Total number 
of loaded 

CODESYS 
Tag 

Display the number of current loaded tags. HMI 
displays the progress bar when preloading the 
tags. After all tags are loaded, the total number of 
preloaded CODESYS tags can be known. 
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Parameter Definition Description 

BOOT_BUZZER 
_VOLUME 

Boot buzzer 
volume of 

HMI 

The display unit is percentage. The value range 
is 0–100. 

HardwareID 
HMI 

hardware 
code 

Read the HMI hardware code. 
This parameter is set using the Character 
Display element, and the string length is 32 to 
ensure that the complete hardware code is read. 

 

Account 

Note: This parameter only applies if the account is set to a non-simple password. 

Parameter Definition Description 

ACCOUNT 
Currently 
logged-in 
account 

• Account contains English letters and 
numbers, use the Character Display 
element. 

• Account contains non-ASCII characters, use 
the Multi-language Input element. 

SetUserAccount User account 

• It is used for user login / logout, adding / 
deleting an account, and changing a 
password. 

• Use the Character Entry element to set this 
parameter. 

AdminLogin 

Highest 
authority 
account 
number 

State Value Result 

0 Log in using a non-highest 
authority account. 

1 Log in with the highest authority 
account. 

 

SetUser 
Password 

User 
password 

• The password is displayed in ***. 
• It is used for user login / logout, adding / 

deleting an account, and changing a 
password. 

• Use the Character Entry element to set this 
parameter. 

SetUserLevel User level 

• It is used for user login / logout, adding / 
deleting an account, and changing a 
password. 

• The level range is 0–10. 
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Parameter Definition Description 

AccountStatus Account 
status 

Read the login status of the current account. 
The status includes the following: 
• Unexpired 
• Unlocked 
• Expired 
• Locked 
Use the Character Entry element to set this 
parameter. 

CurrentUser 
Level 

Currently 
logged in level 

Read the level (0~10) of the current login 
account. 

LoginResult Login status 

Read whether the last login / logout of the 
current account was successful. The status 
includes the following: 
• Success 
• Fail 
Use the Character Entry element to set this 
parameter. 

LogoutResult Logout status 

Login Login 
settings 

State Value Result 
0 The action is completed. 
1 Trigger login / logout 

 

Logout Logout 
settings 

DeleteUser 
Account 

Delete 
account 

State Value Result 

0 The action of deleting an 
account is completed. 

1 Trigger account deletion 
 

DeleteUser 
AccountResult 

Delete 
account 
result 

Read whether the deletion of the account is 
successful. The status includes the following: 
• Success 
• Fail 
Use the Character Entry element to set this 
parameter. 

AddUser 
Account Add account 

State Value Result 

0 The action of adding an account 
is completed. 

1 Trigger account adding 
 

AddUser 
AccountResult 

Add account 
result 

Read whether the adding of the account is 
successfully read. The status includes the 
following: 
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Parameter Definition Description 
• Success 
• Fail. 
Use the Character Entry element to set this 
parameter. 

ChangeUser 
Password 

Change 
password 

State Value Result 

0 The password change action is 
completed. 

1 Trigger password change 
 

Change 
PasswordResult 

Change 
password 

result 

Read whether the change of the password is 
successful. The status includes the following: 
• Success 
• Fail 
Use Character Entry element to read this 
parameter. 

UserDescription 

Get a 
description of 
the user who 
is currently 
logged in to 
the account 

The user description only supports English and 
numbers. Use the Character Display element 
to read this parameter. 

RFIDSerialNum
ber 

Get the RFID 
serial number 
of the current 
login account 

The RFID serial number uses the Character 
Display element to read this parameter. 

SetRFIDSerialN
umber 

Set the RFID 
serial number 

If is used for Add/Delete User Account 
Screen, only English and numbers are 
supported. Use the Character Entry element to 
set this parameter. SetUserDescript

ion 
Set a user 
description 

 

Alarm 

Parameter Definition Description 

ALARM_COUNT 

Alarm triggered 
The total 

number of 
transactions 

• Display the total number of alarms that are 
triggered and de-triggered. 

• The DOP-B, DOP-H, and HMC series 
models record the triggered and de-triggered 
alarms separately. As a result, Alarm_Count 
displays 20 when there are ten alarms. 
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Parameter Definition Description 

 
• The DOP-W and DOP-100 series models 

record the triggered and de-triggered alarms 
within one row of data. As a result, 
Alarm_Count displays 10 when there are ten 
alarms. 

 
• This function reminds you to export the 

alarm data in case the initial alarm data 
contents are removed when the data reach 
the set maximum. 
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BACNETIP Server 

Parameter Definition Description 

DEVICEID Device ID of 
BACnet 

The device ID can be changed dynamically on 
the HMI. 

 

Communication 

Parameter Definition Description 

NET_STATUS1 

Network 
connection 

status 

• NET_STATUS1 represents the 16 
connections of the first controller;  
NET_STATUS2 is the 16 connections of the 
second controller, and so forth for 
NET_STATUS2 and NET_STATUS4. 

• Set the Data Format as Binary when 
setting these internal parameters. 

 
• Sort according to the EtherLink device 

number added by the software. 

 

 
State 
Value Result 

0 Not connected 
1 Connected 

 

NET_STATUS2 

NET_STATUS3 

NET_STATUS4 
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Date&Time 

Parameter Definition Description 

TIME_YEAR 

HMI time 
value 

Time Value Result 

TIME_YEAR (yyyy) 

 

TIME_MONTH (mm) 

TIME_DAY (dd) 

TIME_HOUR (hr) 

TIME_MINUTE (min) 

TIME_SECOND (sec) 

 

TIME_MONTH 

TIME_DAY 

TIME_HOUR 

TIME_MINUTE 

TIME_SECOND 

 

Ethernet Setting 

Some DOP-100 series HMI models have two Ethernet ports, so the network 

parameters are named as: NET1_IP1~NET1_IP4, 

SUBMASK1_IP1~SUBMASK1_IP4, GWAY1_IP1~GWAY1_IP4 and 

NET2_IP1~NET2_IP4, SUBMASK2_IP1~SUBMASK2_IP4, 

GWAY2_IP1~GWAY2_IP4. 

For the DOP-100 models to be compatible with the DOP-B projects, the network 

parameters NET_IP1 to NET_IP4, SUBMASK_IP1 to SUBMASK_IP4, and 

GWAY_IP1 to GWAY_IP4 are added. 

Parameter Definition Description 
NET1_IP1 
NET2_IP1 

IP address of 
the HMI 

Take 192.168.1.88 as an example. 

 
NET1_IP2 
NET2_IP2 
NET1_IP3 
NET2_IP3 
NET1_IP4 
NET2_IP4 
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Parameter Definition Description 

SUBMASK_IP1 
SUBMASK1_IP1 

Submask IP 
address of the 

HMI 

Take 255.255.255.0 as an example. 

 SUBMASK_IP2 
SUBMASK1_IP2 
SUBMASK_IP3 

SUBMASK1_IP3 
SUBMASK_IP4 

SUBMASK1_IP4 

GWAY1_IP1 
GWAY2_IP1 

Gateway IP 
address of 

the HMI 

Take 192.168.1.254 as an example. 

 GWAY1_IP2 
GWAY2_IP2 

GWAY1_IP3 
GWAY2_IP3 

GWAY1_IP4 
GWAY2_IP4 

DNS1_IP1 
DNS2_IP1 

IP address of 
the HMI DNS 

Server 

Take 192.168.1.5 as an example. 

 
DNS1_IP2 
DNS2_IP2 
DNS1_IP3 
DNS2_IP3 
DNS1_IP4 
DNS2_IP4 

NET_MAC1 
NET2_MAC1 

MAC number 
of the HMI 

network port 

• When setting this parameter, set the Data 
Format to Hexadecimal. 

 
• The value is displayed with the high and 

low bits swapped. If the value is 1800, it is 
displayed as 00:18. 

NET_MAC2 
NET2_MAC2 

NET_MAC3 
NET2_MAC3 
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Ethernet Application 

Parameter Definition Description 

SMTP_STATUS 
SMTP 

connection 
status 

State Value State 
Description 

Corresponding 
Message in 
SMTP_INFO  

0 Status 
unknown Unknown 

1 Connection 
success Message Sent 

–100 Connection 
failed 

Unable to 
connect to Host 

–101 System 
disconnected 

The displayed 
message 
changes 
according to the 
system. 

–102 Authenticatio
n required 

530 SMTP 
Authentication 
is required. 

–103 Authenticatio
n failed 

Fail to send 
message due to 
Authentication 
Fail 

–999 SMTP error Fail to send 
message 

 

SMTP_INFO SMTP 
messages 

REMO_COUNT 

Number of 
remote 
devices 

connected to 
the HMI 

Remote devices include eServer, VNC, and 
LUA online debugging programs. 

VNC_ENABLE VNC start 
State Value Result 

0 Disable VNC 
1 Enable VNC 
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Parameter Definition Description 

VNC_STATUS_E
NABLE 

VNC 
status display 

State Value Result 

0 Turn off the VNC status 
display. 

1 

Turn on the VNC status 
display. 

 
 

VNC_ 
NOPASSWORD 

VNC 
Password 

Setting 

State Value Result 

0 No password is required for 
VNC connection. 

1 Password is required for VNC 
connection. 

 

VNC_ 
VIEWONLY 

VNC 
Read-only 

Setting 

State Value Result 

0 
After connecting to HMI, you 
can only view the screen and 
cannot operate it. 

1 Operation is possible after 
connecting to HMI. 

 

VNC_MULTI_ 
CONNECT 

VNC 
Multi-

connection 
Mode 

State Value Result 

0 Multiple VNC connections are 
allowed by HMI. 

1 Only one VNC connection is 
allowed by HMI. 

 

VNC_ 
PASSWORD 

VNC 
Password 

Setting 

Set the VNC connection password (up to 8 
characters) through the Character Input 
element. 

VNC_PORT 
VNC 

Connection 
Port 

Set the VNC connection port. 
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Parameter Definition Description 

InternetConn 
Status 

Internet 
Connection 

status 

State Value Result 
0 No Internet connection 
1 Internet connection exists 
2 Detecting 

 

 

Extended Memory 

Parameter Definition Description 

StatusEM0~15 
Extended 
memory 
status 

Displays the current processing status of each 
extended memory. 

 
State Value Result 

0 Writing is complete 
1 Writing 

2 The corresponding disk does 
not exist 

3 File write error 
4 File read error 

 

 



 

Address Settings 
 

 

382 DIAScreen V1.6.0 

Input Device 

HMI supports reading data from external input devices. The following parameters 

control external input devices and read the data. 

Parameter Definition Description 

InputDevID 
The 

interface of 
input device 

State Value Result 

1 COM1 

2 COM2 

3 COM3 

4 COM4 

10 USB (Default) 
 

InputDevConnStatus 

The 
connection 
status of 

input device 

State Value Result 

0 No keypad device detected 

1 Keypad device detected 
 

InputDevData Read data 
content 

• Displays the data in InputDevData and 
reads the data length in 
InputDevDataLen. 

• The read data displays the character 
before the Terminator. If the Terminator 
is not received, the reading stops when 
the timeout period expires. 

Note: Set the Terminator and Timeout in 
the Device page on the Device 
Communication dialog. 

 

InputDevDataLen Read data 
length 
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Parameter Definition Description 

InputDevClear 
Clear data 
and data 

length 

State Value Result 

0 Idle 

1 
Clear the data and data 
length. After clearing, the 
device status returns to 0. 

 

InputDevInProgress Progress of 
input device 

State Value Result 

0 Idle 

1 Receiving data 
 

InputDevStatus Status of 
input device 

• After clearing the read data, the device 
status returns to 0. 

State Value Result 

0 Idle 

1 Reading successful 

2 Reading failed 

3 The read data size exceeds 
the specified size. 

4 Open the port failed 
 

 

Installment 

Parameter Definition Description 

NEXT_INST_ 
REMAIN_TIME 

Current 
installment 

time left 

• Displays the remaining time until the next 
installment. 

• It is recommended to use Character 
Display elements. 
Note: The String Length must be set to 23 
to display the complete time. 

 

INST_LOCK_ 
STATUS 

Installment 
locked status 

State Value Result 
0 Connection failed 
1 Connection successful 
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IoT 

This parameter is only available for DOP-300 series HMI. 

Note: Tunnel related parameters are read-only. 

Parameter Definition Description 

IoTNotify Cloud 
notification 

State Value Result 

0 Cloud has no new version. 

2 New firmware updates on the 
cloud. 

3 

Cloud has new template 
updates, but the template ID 
remains unchanged and the 
data will not stop updating. 

5 

Cloud has new template 
updates and the template ID 
changes, and the data will 
stop updating. 

 

IoTDeviceStatus 
Connection 
state of HMI 
and Cloud 

State Value Result 
0 The device is turning on. 

1 The device account is 
unbinding. 

2 The device account is binding. 
3 Device online 
4 Device offline 

 

IoTEnable Enable Cloud 
service 

State Value Result 

0 Not enabled 
1 Enabled 

 

IoTPairingKey 

Cloud 
template 
binding 

verification 
code 

• Verification code (6 digits) entered when 
the HMI is bound to the cloud template. 

• Use the Numeric Input element to set this 
parameter. 

IoTBindingQRCo
de 

Bind HMI to 
DIACloud 

Set to 1, bind the HMI and DIACloud. 

IoTUnBinding 
QRCode 

Unbinding 
DIACloud 

Set to 1, unbinding the HMI and DIACloud. 
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Parameter Definition Description 

IoTShowQRCode 
Cloud 

template QR 
code 

Use the QR Code Display element to set this 
parameter. 

IoTTunnelStatus 

State value and 
description of 

the HMI 
connected to 
FUDA Tunnel 

State value Description 
0 Tunnel is not connected 

1 Tunnel is connected 

2 The tunnel data has reached 
the limit. 

4 Fail to load Tunnel 
configuration file 

9 Fail to open Tunnel interface 
–1 Connection timed out 
99 Establish a connection 

 

IoTTunnel 
StatusDesc 

IoTTunnelID 

The ID of the 
HMI 

connected to 
FUDA Tunnel 

• When not connected, display 0. 
• When connected, display the allocated 

value (1~65535) by the server. The ID is 
still displayed after disconnection. 

IoTTunnelIP 

The Tunnel IP 
set in the virtual 

network 
adapter of HMI 

• IP format is 0.0.0.0~255.255.255.255. 
• Use the Character Read element to set 

this parameter. 

IoTTunnelServer Tunnel server 
address 

Displays the server name when connected. 
The server name is still displayed after 
disconnection. 

IoTTunnelLatency 
Tunnel 

connection 
delay time 

• When not connected, display –1. 
• When connected, display the delay time. 

IOTDataSync 
Status 

Cloud 
Template 

Sync status 

Displays whether the current template is 
downloaded from DIACloud. The status 
includes the following: 
• Sync. 
• Not sync. 
Use the Character Entry element to set this 
parameter. 
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Keypad 

Parameter Definition Description 

KEY_CHAR Show 
keyboard text 

• When the HMI is connected to an external 
keypad, the characters can be directly 
input through the keypad and displayed 
through this parameter. 

• It is recommended to use Character Entry 
or Character Display elements. 

 

Lua Program 

Parameter Definition Description 

PROGRAM_ 
STATUS 

Current LUA 
running 
status 

State Value Description 
0 Stop 
1 Run 
2 Breakpoint 
3 Pause 

 

PROGRAM_ 
INFO 

LUA 
execution 

information 

If an error occurs during LUA operation, the 
current error message can be displayed 
through this parameter. 

 

MQTT 

Parameter Definition Description 

MQTTClientID Read Broker 
ClientID 

Set the Broker ID to read the corresponding 
Client ID.

 
Note: 
• MQTTClientID is read-only, and this 

parameter is read by the Character 
Display element. 

• BrokerNumber corresponds to the Broker 
List in MQTT Setting. 

BrokerNumber 
Assign 
Broker 

Number 
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MQTT Broker 

Parameter Definition Description 

BrokerInfo 

Read the 
execution 
status of 
Broker 

Displays the current execution status of MQTT 
Broker. The status includes the following: 
• Executing 
• Memory is full and rejects all published 

messages. 
• Stopped 
Use the Character Entry element to set this 
parameter. 

 

Storage 

Parameter Definition Description 

SD_STATUS 

State value of 
external 
storage 

device (SD 
card) 

State Value Result 
0 SD card is not inserted 
1 SD card is inserted 

 

USB_STATUS 

State value of 
external 

storage (USB 
disk) 

State Value Result 

0 USB disk is not inserted 
1 USB disk is inserted 

 

USB2_STATUS 

State value of 
external 

storage (USB 
disk) 

State Value Result 

0 USB disk is not inserted 
1 USB disk is inserted 

Note: This parameter is only available for 
DOP-300 series HMI. 

 

Touch 

Parameter Definition Description 

TP_STATUS State value of 
HMI panel 

State Value Result 

0 Panel is not touched 
1 Panel is touched 
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Parameter Definition Description 

TP_X 
Touch the X 
coordinate of 

HMI panel 
Coordinate Result 

X 
 Y 

 TP_Y 
Touch the Y 
coordinate of 

HMI panel 

TP_FORCE 
Pressing 

force applied 
to the HMI 

The display unit is percentage. 

TP_DELAY 
Delay time of 
pressing the 
HMI screen 

The display unit is percentage. 

 

Handheld HMI 

This parameter is only available for DOP-Handheld series HMI. 

Parameter Definition Description 

EMS_STATUS 
Current status 
of emergency 

stop switch 

State Value Result 

0 Emergency stop switch is not 
pressed 

1 Emergency stop switch is 
pressed 

 

LSWITCH_ 
STATUS 

Current 
status of 
enabling 
switch 

State Value Result 
0 Enabling switch is not pressed 
1 Enabling switch is pressed 

 

HANDWHEEL_ 
COUNTER 

Accumulated 
number of 
rotations of 
handwheel 

Rotate to the right, the value increases by 1; 
rotate to the left, the value decreases by 1. 

AUXKEY_ 
PRESSED1 

Auxiliary key 
press status 

• Displayed in power of 2, the leftmost button 
is the first row, and the value is displayed 
from top to bottom, with the value increasing 
by 1, 2, 4, and 8, as shown below. 

• If there are more than 24 auxiliary keys, it 
will be displayed with parameter 
AUXKEY_PRESSED2. 

AUXKEY_ 
PRESSED2 
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Parameter Definition Description 

 
 

WiFi 

Parameter Definition Description 

WiFi.Country Wi-Fi country 
codes 

Use the Character Input element to set this 
parameter. 

WiFi. 
DongleStatus 

Wi-Fi Dongle 
configuration 

status 

This parameter is read-only. 

State Value Result 

0 The Dongle is not inserted 
1 The Dongle is inserted 

 

WiFi.Connect 
Command 

Wi-Fi 
connection 

configuration  

When set to 1 or 2, this parameter will be 
automatically reset to 0. 

State Value Result 
0 No commands in progress 
1 Disconnected 
2 Connected 

 

WiFi. 
ErrorMessage 

Wi-Fi 
connection 

error message 

This parameter is read-only. 
Use the Character Display element to read this 
parameter. 

WiFi. 
ConnectStatus 

Wi-Fi 
connection 

status 

This parameter is read-only. 

State Value Result 
0 Not connected 
1 Connecting 
2 Connected 
3 Fail to connect 
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Parameter Definition Description 

WiFi. 
SignalLevel 

Wi-Fi 
signal level 

This parameter is read-only, the level 4 has the 
highest signal. 

Level Signal Strength 
0 –100 < signal < –88 
1 –88 <= signal < –78 
2 –78 <= signal < –67 
3 –67 <= signal < –55 
4 –55 <= signal < 0 

 

WiFi. 
SignalStrength 

Wi-Fi signal 
strength 

This parameter is read-only, the unit is dBm. 

WiFi.IPSetting 
Wi-Fi 

network mode 

State Value Result 
0 DHCP 
1 Static 

 

WiFi.IP1 

Wi-Fi 
IP address 

 

WiFi.IP2 

WiFi.IP3 

WiFi.IP4 

WiFi.Mask1 

Wi-Fi 
subnet mask 

 

WiFi.Mask2 

WiFi.Mask3 

WiFi.Mask4 
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Parameter Definition Description 

WiFi.DNS1 

Wi-Fi DNS 

 

WiFi.DNS2 

WiFi.DNS3 

WiFi.DNS4 

WiFi.MAC1 

Wi-Fi Dongle 
MAC 

 

WiFi.MAC2 

WiFi.MAC3 

WiFi.MAC4 

WiFi.MAC5 

WiFi.MAC6 

WiFi. 
NetworkName 

Name / 
password of 
connected 

AP 

 

WiFi.Password 
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Parameter Definition Description 

WiFi.Security Encryption 
method 

State Value Result 
0 WPA2 
1 WEP 
2 NONE 

 

WiFi. 
AutoConnect 

Whether to 
automatically 
connect Wi-Fi 

State Value Result 
0 Manual 
1 Auto 

 

WiFi.Enable 
Whether to 

enable 
Wi-Fi Dongle 

State Value Result 
0 Not enabled 
1 Enabled 

 

 

External Controller Address 

HMI monitors the parameters of the device after it is connected to the controller 

through COM Port or Ethernet. 

Follow these steps to set the external controller address. 

To set the external controller address 

1. Click General > Device Communication in the menu bar. 

2. In the Device Communication dialog, set the Link Name. 

The following shows an example of setting the COM Port and Ethernet link 

names. 
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3. In the address Input dialog of the element, select the Link name, and then set 

the controller address. 
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4. Unselect the Default checkbox, and then set the Station No. 

Some Ethernet controllers support variable import function, such as Allen Bradley, 

Beckoff, Simens, Omron, CODESYS, and so on. After importing the corresponding 

variable file in the Device Communication dialog, the HMI can communicate with 

the controller through variables (Tag). 

How to use Tag? 

1. In the Device Communication dialog, select Ethernet1. 

2. In the Device tab, click . 

3. Select EthernetIP (Micro820)(Use Tags) for Controller. 

 

4. Click Import. 

5. In the address Input dialog of the element, select the Link name with the 

imported variable file. 

The variables are listed in the dialog. 
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6. After selecting the variable, click OK. 

In the variable selection dialog, you can: 

• Use keywords to search for variables. 

In the Find field, enter a keyword and click . You can also click  to set 

whether the keyword is case-sensitive. 

The variables containing the keyword are listed in the dialog. 

• Use spaces to search for variables under a specific level. 

Enter the upper level keyword followed by a space, and then enter the lower 

level keyword. 

The matching variables are listed in the dialog. 

 

7. If array variables are imported, select the number of arrays in the drop-down 

menu of the Array after selecting the array variable. 

Note: If you need to read and write the Bit of a specific variable in the Bit 

element, select it through the drop-down menu of the Bit. 
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Variable Sharing 

The variables declared by DIADesigner and DIADesigner-AX can be synchronized 

through the DIA Tag function of DIAScreen, and can be assigned to the elements on 

the HMI for use. 

 

DIADesigner-AX Tag Automatic Synchronization 

Follow these steps to synchronize variables declared by DIADesigner-AX to 

DIAScreen. 

DIADesigner-AX operation (software version 1.6.0) 

1. Create global variables or POU variables. 
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2. Create a symbol table and select the variables to use. 
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3. Select the device and click  to compile. 

 

4. Click Build > Generate Code on the toolbar. 

DIAScreen operation 

1. Create a project, select the model that includes a network, and then open the 

variable import dialog. 

• If select DOP-100 series for series, select the CODESYS controller in the 

Ethernet setting page of the Device Communication dialog, and then click 

Import. 

The Tag List dialog displays. 

• If select AX-8 series for series, double-click Built-In PLC in the Project 
pane. 

2. Click  to select .xml or .project file. 

Note: To enable the tag automatic synchronization function, select .project file. 

3. After selecting .project file, click Open. 

4. In the Select device to import dialog, select the Device Name, and then click 

OK. 

5. Click . 

6. Perform the settings in the Tag synchronization settings dialog. 

 

The following table lists the settings in the Tag synchronization settings dialog with 

their descriptions. 
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 Enable Tag automatic synchronization 

Setting Description 

Enable Tag 
automatic synchronization 

Select Enable Tag automatic synchronization. 
Once the code is generated in DIADesigner-AX, 
DIAScreen automatically checks whether the symbol 
table has been updated according to the set Check 
Cycle. 

 

 Source Settings 

Setting Description 

Imported File Displays the synchronized project file path, and you 
can also change the file path here. 

Device Name You can select the device in the project file. 

Active Application Automatically imports the program name of the 
device after selecting the device. 

 

 Synchronization Settings 
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Setting Description 

Automatic Check Cycle 
Set the automatic check cycle. 
The value range is 3–60, and the default value is 3. 

When a change is 
detected, pop up a 

window to confirm whether 
it is synchronized 

If selected, a message dialog displays when a 
change is detected and asks you whether to 
synchronize automatically. 
• Select Yes to perform automatic synchronization 

and update the Tag List in DIAScreen. 
• Select No to not to update the Tag List in 

DIAScreen and turn off the automatic 
synchronization function. 

Note: If automatic synchronization is enabled and the project file path exists, when 

the dpa project file is opened, Tag automatic synchronization will be executed first. 

 

DIADesigner Tag Automatic Synchronization 

Follow these steps to synchronize variables declared by DIADesigner to DIAScreen. 

DIADesigner operation (software version 1.4.2) 

1. Create a project. 

2. In Project Explorer, add a controller device. 

3. Double-click Programming, right-click Global Variable, and then select Add 
Global Variable Table. 

4. In the Add Global Variable Table dialog, enter the Name and Comment, and 

then click OK. 

5. In the Global Variable table, add variables. 

Note: The variable address must be configured. If not configured, DIAScreen 

will not be able to use the Tag. 

6. Click Compile on the toolbar. 

DIAScreen operation 

1. Create a project. 
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2. In the COM setting page of the Device Communication dialog, select Delta for 

Manufacturers and select the type of controller created in DIADesigner for 

Series. 

3. In the Project pane, double-click DIA Tag. 

4. In the DIA Tag setting page, click . 

5. In the DIA Tag Import Settings dialog, select a DIADesigner project file 

(.diade). 

6. Select a Link Name. 

The communication parameters of the connection are listed in the dialog. 

7. Set the Station No. 

Note: 

• The Don’t specify station number checkbox is selected by default. The 

Station No. field is available only when the DIA Tag is used on the element. 

• If unselect the Don’t specify station number checkbox, the specified station 

number can be entered in the Station No. field. 

8. Click OK. 

9. In the DIA Tag setting page, click . 

10. In the DIA Tag Synchronization Settings dialog, select Enable automatic 
sync checkbox and set Automatic check cycle. 

11. Create an element on the screen, and then double-click it. 

12. In the address Input dialog of the element, select DIA Tag for Link. 

The variables are listed in the dialog. 
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DOP-300 Series HMI Special Features 
The following table lists the special features for DOP-300 series HMI. 

Category Function 

Element 
VNC Viewer 

Gantt Chart 

Protocol EIP Data Exchange Table 

IIoT 

OPC UA Server Safety Verification 

OPC UA Client Safety Verification 

MQTT JASON Custom 

Aliyun Server 

Internal 
Parameter 

IoT 

Storage - USB2_STATUS 
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